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Preface
The national curriculum Framework, 2005, recommends that children’s life at school must be
linked to their life outside the school. This principle makes a departure from the legacy of
bookish learning which continues to shape our systems and causes a gap between the school,
home, community and the workplace.
The student workbook on “Information Technology (IT)” is a part of the qualification package
developed for the implementation of National Vocational Education Qualification Framework
(NVEQF), an initiative of ministry of Human Resource Development (MHRD), Government of India
to set common principles and guidelines for a nationally recognized qualification system
covering the schools, vocational education and training institutions, technical education
institutions, college and universities. It is envisaged that the NVEQF will promote transparency
of qualifications, cross- sectoral learning, student qualifications, thus encouraging life long
learning.
This student workbook, which form a part of vocational qualification package for student’s who
have passed class VIII or equivalent examination, was created by group of experts. The IT-ITeS
skill development council approved by the national skill development corporation (NSDC) for the
IT/ITes industry developed the national occupation standards (NOS). The national occupation
standards are a set of competency standards and guidelines endorsed by the representatives of
IT industry for recognizing and assessing skills and knowledge needed to perform effectively in
the workplace.
The CBSE has developed learning materials (units) for the vocational qualification package in
IT/ITes sector for NVEQF levels 1 to 4 ; level 1 is equivalent to class IX. Based on NOS,
occupation related core competencies (knowledge, skills and abilities) were identified for
development of curriculum and learning modules (units).
This student workbook attempts to discourage rote learning and to bring about necessary
flexibility in offering of courses, necessary for breaking the sharp boundaries between different
subject areas. The workbook attempts to enhance this endeavor by giving higher priority and
space to opportunities for contemplation and wondering, discussion in small groups and
activities requiring hands on experience.
Any suggestions, feedback from the readers for improvement in the future editions of the
volume shall be heartily welcomed.

Sh. Vineet Joshi, IAS
Chairman (CBSE)
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BASIC COMPUTER SYSTEM OPERATIONS SKILL
Pre-requisite: NIL
Element
No.

Element Name

Hours

Total

Th

Pr

Hours
30

1

Basics of Computer System

6

0

2

Laying hands on computer system

2

2

3

Creation/customization of Files and Folders

2

2

4

Establishing Internet Connectivity and Internet
Browsing

4

4

5

Email and related Services

4

4

18

12

Total

30

Ignite Mind
"Computing is not about computers anymore, it is about Living"
Nicholas Negroponte

Learning Objectives
After studying this unit the students will attain competencies to:
·
·
·
·
·

Identify, describe and connect various parts of computer system
Start, work on and shut down a computer system
Manage and customize files and folders
Establish an internet connection and browse for information on internet
Use email and related services

Introduction
Just a few years back, people used to pick up paper and pen to do all their
calculations. A good knowledge of mathematics was required to solve complicated
problems related to calculations and yet the process was quite time consuming.
People used to fill in lot of pages in their diaries with the contact address and phone
numbers of their friends, relatives and clients. A great effort used to go in searching
for information from large number of pages of different books and notebooks. Big
companies used to invest a lot of amount in transportation of their experts to various
work locations to solve day to day problems. People used to communicate through
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traditional mails – which used to take 3 to 10 days time to reach destinations. Today,
Information Technology (IT) has a great influence on all aspects of our life. Almost all
work places and our lives are getting automated with the help of IT tools and its
applications. IT is acquiring, processing, storing and disseminating numerical, textual,
audio and video form of information with the help of electronic machine, computing
instructions and network applications. Moreover, knowledge of IT is an essential
component to prepare the current generation to work in these environments to equip
them with various aspects of it such as understanding the concept of IT and its scope,
operating a computer, using various office tools, using Internet etc. This chapter will
deals with the basics of IT.

Resource Requirements
Hardware
·

A computer system with Internet connectivity

Software
·
·

GUI Operating System
Internet Browser

Suggestions for Effective Teaching
·
·
·
·
·
·
·
·

Encourage peer learning in Computer Lab
Ensure that students follow standard procedures to logon/logoff a computer.
Ensure the proper connectivity of I/O devices
Encourage students to explore opportunities as IT Professionals
Introduce how to integrate IT Tools with traditional practices at various work
places
Encourage students to follow best practices such as taking backup of files, turning
off devices when not in use
Educate students to keep storage media virus free
Sensitize students on ethical and health related issues
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Element 1: Basics of Computer System
A computer system includes software and hardware together to make it perform the
required tasks. Software is a collection of instructions and related data that tells a
computer what to do and how to do. In other words, software is a conceptual entity,
which contains a set of instructions (computer programs) with associated
documentation related to the operations of a data processing system; whereas,
computer hardware is a collection of electronic and other peripheral units, which
enables software to perform desired operations. And, there is an important software,
known as Operating system (OS) specially designed to establish the communication
between various hardware devices and software loaded on a computer system.
“A computer system is a programmable machine designed to perform arithmetic and
logical operations to produce meaningful results in desired format”
A computer system is broadly divided into three units – Input Unit, Central Processing
Unit (CPU) and Output Unit. Input unit helps the user to enter raw data and
instructions into the computer system, central processing unit performs the required
operations as per given instructions and at the end output unit produces meaningful
results in the desired format for the user.
Let us understand this concept with the help of an example - What information will
you require to calculate the amount to be paid to shopkeeper for buying several
pieces of a branded pen? You will require its Unit Price and Quantity procured by you
– So Unit Price and Quantity will become the raw data to be entered by you through
the input unit. Now, you need to multiply both these values to know the Amount to be
paid to the shopkeeper – So Multiplication of these two values will become the
operation, which will be performed by the CPU and the Amount, which is the result
will be on the Output unit of a computer system.
The CPU is further divided into three parts (i) control unit (CU), (ii) arithmetic & logic
unit (ALU) and (iii) memory unit (MU). Inside CPU, Control unit acts as a receptionist
and a manager of a company. It receives each and every instruction from user and
coordinates between different parts to perform various operations. Arithmetic and
logic unit acts as an accountant of a company, which performs all the mathematical
and logical calculations. And memory unit acts as a temporary store of a company,
where small amount of data is stored while other operations are being performed. In
addition to these units, a computer system also has secondary storage device to hold
or store large amount of data for later use by various applications running on it.
Figure 1.1 illustrates the interconnection of these units and secondary storage device.
-3-
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Central Processing Unit
(CPU)
Control Unit (CU)
Output Unit
(Information – Result)

Input Unit
(Data & Instructions)
MU

ALU

Secondary Storage Devices

Flow of Data

Flow of Instructions

Figure 1.1: Block diagram of a Computer System

Now, you must be wondering how you can recognize these units in the form of real
devices in a personal computer system. You might have seen a device having several
buttons (known as keys) with alphabets and numbers, this device is known as
keyboard, which acts as an input device of the computer system. You might have also
seen another oval shaped device with two/three buttons in front, this device is known
as mouse, which is also an input device of the computer system. Further, you can see
a vertically standing/horizontally places box/case with an on/off/reset button – this
cabinet/case is known as CPU cabinet, which also contains place to hold secondary
storage devices such as hard disk to hold large amount of data and instructions and
Compact Disc (CD)/Digital Versatile Disc (DVD)/Blue Ray drive to keep data on
portable discs. One of the most common output devices is LCD/LED/Monitor, which is
used as output unit to display the results coming out from a computer. The computer
system may also have some more additional devices connected with it to act as input
and output devices as per the requirement of an individual work.
For example,
Input/Output Purpose
Sample Requirement
device
Mic/mike
Used to take the audio input
To record nursery rhymes in the
system
Scanner
Used to accept digital input from To scan a picture that is to be
a paper picture/image/document. included in an assignment
-4-
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Used to accept image/video To take pictures of students for
inputs
identity cards.
Used to read barcode
To read Barcodes present on
books being issued/returned in
the School library.
Used to print output on paper
To print an assignment on paper
Used for audio output
To listen to Nursery Rhymes from
the system

The memory unit of CPU is further divided into two components, one is known as
Random Access Memory (RAM) to take care of intermediate storage of data while
working on a computer system and another Read Only Memory (ROM) to keep the
essential instructions written and stored by the manufacturer to load operating
system and take care of basic input/output operations – also referred as BIOS i.e.
Basic Input Output System.
In the computer, the data is stored in the form of Bits and Bytes. Bit (Binary Digit
represented by 0 or 1) is the smallest storage unit, 8 Bits combined together form a
single byte, which in turn represent a single character. Let us see an example, if the
name “RAVI” is required to be stored in computer, it will need 4 bytes in the
computer’s memory. The following table represents other higher units of computer
memory.
Memory unit

Relationship with earlier memory unit

In equivalent Bytes

Kilo Byte (KB)

1 Kilo Byte = 1024 Bytes(or 210 Bytes)

Mega Byte (MB)

1 Mega Byte = 1024 Kilo Byte(or 210 KB)

1024x1024

Giga Byte (GB)

1 Giga Byte = 1024 Mega Byte(or 210 MB)

1024x1024x1024

Tera Byte (TB)

1 Tera Byte = 1024 Giga Byte(or 210 GB)

1024x1024x1024x1024

1024

RAM and ROM discussed in the above paragraph constitute Primary Memory. Now, let
us discuss in detail about the various Secondary Storage Devices. The secondary
storage devices are basically used to store large amount of data (with capacity in the
range of 20 GB to 2 TB) permanently on computer, i.e. the data is retained even when
the system is switched off. Hard Disc is one of the most important secondary storage
devices, which is used to hold (store) operating system, office applications, utility
-5-

NVEQ Level 1

ITCC 101

software and the user’s data, etc. It is usually fitted in the cabinet of CPU, so that it
cannot be easily removed from the computer system. Apart from hard disk, one can
always use additional (portable) secondary storage devices such as Compact Disk (CD
with a storage capacity of 750 MB), Digital Versatile Disk (DVD with a capacity of
around 4.5 GB), Blue-ray Disk (with a storage capacity of around 25 GB/50GB), Pen
Drives (with a storage capacity of 512 MB to 32 GB), Memory Stick (with a storage
capacity of 512 MB to 32 GB).

Figure 1.2: CPU Cabinet Back Panel

Now, let us connect/check the connections between various parts of a personal
computer. Try to locate all the sockets or ports, which are present behind the CPU
Cabinet as shown in Figure 1.2. Some of the common sockets/ports are power socket
for connecting power cable, PS2 ports for connecting Mouse & Keyboard, USB Port for
connecting USB devices such as mouse, keyboard, printer, pen drive etc., VGA port
for connecting Monitor/Screen. Connect Monitor with VGA cable, mouse & keyboard
with PS2/USB cable and power on the CPU after connecting power cable. Your
computer should display some message from the manufacturer and then it should
start the Operating System (boot up with the operating system). Once the booting
process is over, you will see the desktop – the first screen you see in the beginning, to
allow you to chose and start the application of your choice.
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Some of the common ports & cables along with their pictures are described in Figure
1.3:
USB
Port & Cables

Firewire
Port & Cables

A USB (Universal Serial Bus)
port is a standard cable
connection interface
available on personal
computers and some other
electronic devices for data
communication. USB ports
allow stand-alone electronic
devices to be connected
with the help of cables to a
computer (or to each other).
USB ports can also supply
electric power across the
cable to devices without
their own.

FireWire® ports are forms of a
serial port that make use of
FireWire® technology to transfer
data rapidly from one electronic
device to another. The FireWire®
port has the ability to interact
with a number of different
devices. A FireWire® port can
provide an ideal way to connect a
scanner and digital camera to a
computer system as the data
transfer is relatively faster than on
USB and also results in excellent
quality.

Pins: 4
Standard:
Industry Standard in 1990

Ethernet (RJ45)
Port & Cables

Ethernet Port is used to
connect computers and
other devices to form a
computer network. It uses
Ethernet cables to
establish efficient and
effective communication
between computers and
other peripheral devices
such as modem, router,
multimedia projector etc.

Pins: 8 Pins
Standard:

Pins: 4,6,9
Standard:

IEEE Std 802.1 to 802.10

IEEE 1394
Figure 1.3: Common Ports and Cables
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Apart from the above, let us now try to understand a little bit about the parallel port,
which is now phasing out and apparently missing in all the latest personal computers.
A parallel port is a type of interface found on computers for connecting various
peripherals as shown in Figure 1.4. It is also known as a printer port. The IEEE 1284
standard defines the bi-directional version of the port, which allows the transmission
and reception of data bits at the same time.
Know More!
“Institute of Electrical and Electronics Engineers” IEEE (read I-Triple-E) is the world’s largest
professional association dedicated to advancing technological innovation and excellence for
the benefit of humanity. IEEE and its members inspire a global community through IEEE's
highly cited publications, conferences, technology standards, and professional and
educational activities.

Parallel Port

Parallel Port Printer Cable
Printer Side

Computer Side

Pins: 25
Standard:
IEEE 1284
Figure 1.4: (Left) Parallel Port on Computer (Right) Cable Computer Side & Printer Side Sockets

Summary
·

A computer system comprises of Input, Processor, Primary/Secondary Memory
and Output
· Input unit helps in accepting data and instructions from the user
· Output unit helps in displaying/printing the results from the computer
· Central Processing Unit is the brain of a computer system
-8-
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Keyboard, Mouse, Mike, Scanner, Barcode reader, Retina Sensing Device,
Camera, Face recognition Device and joystick are some examples of input
devices
Screen (LCD/LED/Multimedia Projector/Monitor), Speaker, Printer and Plotter
are some examples of output devices.
RAM is temporary memory of the computer
ROM contains the instructions written and loaded by the manufacturer
Hard disc, Floppy Disk, CD, DVD, Blue Ray, Pen Drive and Memory Stick are
some examples of storage devices.
Bit (i.e. Binary Digit) is smallest unit of computer memory. 8 bits form a byte,
which is used to represent a character
1 Kilo Byte = 1024 Bytes, 1 Mega Byte =1024 Kilo Bytes, 1 Giga Byte = 1024
Mega Bytes, 1 Tera Byte=1024, 1 Giga Byte (Note: 1024=210)

Self Assessment
S.No. I am able to…

Yes

1

Identify Screen, CPU Cabinet, Keyboard, Mouse and Printer.

2

Distinguish between common i/o ports and connectors.

3

Classify given input and output devices.

No

_________________________________________Now I can answer …
1.
2.
3.
4.
5.

What is Input Unit of a computer system?
What is output unit of a computer system?
What is the job of Control Unit inside CPU?
What is the job of Arithmetic Logic Unit inside CPU?
Name four input devices and write the type of input that can be entered through them
into a computer system.
6. Name four output devices and write the type of output that can be exhibited through
them.
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Element 2: Laying hands on Computer System
As you are now, familiar with the basics of a computer system and you could now
switch on your computer system, you must be curious to work on the system. Look at
the screen – you will find some pictures and text present on the various parts of the
screen. A sample view of the desktop and its various components are illustrated in
Figure 1.5.
Desktop - A desktop is a computer display area of windows that contains the various
objects one might find in the computer. On the desktop of your computer, you may
find pictures with the following labels (i) My Computer or Computer – it contain all
the storage areas of your computer (Hard Disk, Floppy Disk, CD/DVD etc.), (ii)
Recycle Bin – it contains all the deleted content of your computer, (ii) My Network
Places or Network – it contains the information of interconnected computers (if any),
(iv) My Documents or Documents – it contains a common area to store various types
of files on the computer. You may find some more pictures on the desktop with selfexplanatory labels. All these pictures, which you see on screen, are known as “icons”.
At the bottom of desktop, you can see a bar (known as Taskbar), left side of which
may contain a Start button, right side may contain date time & active device/utility
information and the center of the taskbar may have some shortcuts & active
applications. Shortcuts are the direct links to help the user to start the application,
which may be stored anywhere on the computer.

-10-
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Default Icons with
shortcuts to default
applications

Desktop
Mouse Pointer

START Button

Shortcuts for
various
applications

Time and Active
Utilities

Active application

Taskbar
Figure 1.5: Desktop

It is also important for you to know, which area of desktop will perform an operation
on left click of a mouse button. You can click on any shortcut or buttons, to start an
application or to perform the desired task. Now, just look at the figure 1.7 to view a
sample menu and sub-menu display, which you will see after clicking the Start Menu.
Here, you will see various options you can choose from. The common ones are: (i)
Help & Support to provide documented form of basic help information to work on the
computer, (ii) Search to help you searching for an applications or a file, (iii) Settings
to customize various settings (Display, Hardware, Software etc.) of the computer, (iv)
Documents to provide you quick links to all recent documents, which were
opened/modified recently on the computer, (v) Programs to display a submenu with
list of various applications available on the computer to work on. The Start menu also
gives you an option to Log Off/Shut Down/Turn Off the computer. These options may
vary from version to version and OS to OS. You can easily identify them, as you will
find similar names for them.
-11-
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Let us now, discuss about some common applications, which come along with the
operating system. Notepad is one such application, which allows you to type in the
content in a text file, save it on the hard disk and print the same, if required.

Figure 1.6: Start Menu and Program Menu

In My Computer or Computer, you will find a list of all the Secondary Storage
device(s) available on your computer. These drives are represented in the form of
alphabets (from A: to Z:). For example C: Drive normally represents the first hard disk
present in your system, D: Drive may represent the second hard disk or CD/DVD Drive.
A: and B: Drives normally represent Floppy Drives, last alphabets are normally used to
represent Network Drives (i.e., the hard disk or DVD drive of another computer). A
sample content is shown below in Figure 1.7:

-12-
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Figure 1.7: Drives

The data on computer can be organized in files and folders. Files are the immediate
container of the content created by you using a particular tool/application. Like using
Notepad, you create a Text file “REPORT.TXT” containing report of a particular
program organized in your school, you might create another text file “LESSON1.TXT”
containing a list of assignments to be given in a class and using paint tool, you might
create a file “MYCREATION.BMP”. All these are known as “files”. When you have many
files loaded or stored on the computer, you would like them to be organized in
separate groups to manage your files easily. You can create Folders on computer to
represent these groups, where each folder can hold any number of file(s) or subfolder(s). For example, you can create a folder as Movies with sub-folders as Hindi
and English to contain Hindi Movie Files and English Movies Files respectively, and you
may create a Folder with name Academics with sub-folders as School Work,
Homework and Downloaded resources to hold related files. Figure 1.8 illustrates a
Folder as “CBSE VOCATIONAL 2012” with its content as Files “ITBookReference.txt,
Logo.JPG, Excercise1.odt, Expenses.ods, Class9Lesson1.odp, RESUME.pdf”.
Folder

Various Files

Figure 1.8: Files and Folders
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Creating a Text file using Notepad
Open Notepad by
Clicking Start -> Programs -> Accessories -> Notepad
OR
Click Start -> Run and type in NOTEPAD and click on open
Once the notepad is loaded, type the content required by you in the text file.

Figure 1.9: Notepad Content Typing

Saving the File: After typing in the desired content, you may like to save the content
permanently on the hard disk of the computer or any other secondary storage device.
To do this, you need to follow the instructions given below:
[1] Click File -> [2] Click Save -> [3] Chose the correct location -> [4] Type in the
name of the file -> [5] Click Save button

Printing File: Follow the following steps to print the content of the text file
[1] Click File -> [2] Click Print -> [3] Select Printer -> [4] Click Print Button

-14-
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1
2

3
4

5

Figure 1.10: Saving a TEXT file in Notepad

Creating a picture using Paint tool
Open Paint tool by
Clicking Start->Programs->Accessories->Paint
OR
Click Start -> Run and type in MSPAINT and click on open
Paint tool is the most basic software to draw pictures with the help of various tools
such as Pencil Tool, Brush Tool, Air Brush Tool, Text Tool, Line tool, Curve Tool,
Rectangle Tool, Polygon Tool, Ellipse Tool and Rounded Rectangle tool (as shown in
Figure 1.11).
-15-
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Tools

Tool Description

Tool Description

Free Form Select helps in Selection of any shape

Select tools helps in rectangular selection

Eraser tool erases a portion of picture

Fill Color tool fills color in the closed boundary

Pick color picks color from one place and fill in
the other place

Magnifier tool magnifies the picture

Pencil tool to draw continuous thin free hand line

Brush tool for drawing thick free hand line

Air brush tool is for spreading colors

Text tool is for writing text in the picture

Line tool to draw straight line

Curve tool to draw symmetrical curves

Ractangle tool to draw rectangular shape

Polygon tool to draw a figure with multiple corners

Ellipse tool to draw circles and ellipse

Rounded Rectangle tool to draw a figure with
multiple corners

Figure 1.11: Paint Tool Bar

At the time of using any of these tools, you can select the colors of your choice to be
used in the drawing (picture) from Basic Colors usually found at the bottom of the
drawing area (as shown in Figure 1.12a) or can use customized colors clicking Color ->
EditColors and creating a color of choice from the color palette (as shown in Figure
1.12b).
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Figure 1.12a: Basic Color Palette

Figure 1.12b: Edit Color Palette

Saving the File:
After drawing picture, you can save the file permanently in hard disk or any other
storages device in various file formats such as BMP (Bit Map File – this is a large
picture file format, can also be used to be inserted in a document), JPG (here JPG is
the short form of Joint Picture Expert Group – this small/large picture file format is
most common picture file format, also used on the website or can be inserted in the
documents) and GIF (Graphic Image File - this small/large picture file format is also a
common picture file format, can be used on the website or can be inserted in the
documents). A sample screen shot is shown in the Figure 1.14 to save the file in the
desired format.

To do this, you need to follow the instructions given below:
[1] Click File -> [2] Click Save -> [3] Chose the correct location -> [4] Select the
required picture file format [5] Type in the name of the file -> [6] Click Save button

-17-
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3

4

5

6

Figure 1.13: Edit Color Palette

Let us see the use of different tools, to decide which tool to be opted for a particular
shape or design. You will use the pencil tool to freely draw any shape using requiring
a thin tip. The Figure 1.14 illustrates some of the drawing made with the help of
pencil tool. Before drawing any shape or design, you can choose the color of pencil
accordingly.

-18-
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Figure 1.14: Drawings using Pencil tool

You will use the Brush or Air Brush tool to freely draw any shape using requiring a
thick tip. The brush tool will have the solid color tip, where as the Air Brush will have
dotted tip for drawing. The Figure 1.15a and Figure 1.15b illustrate the drawings
made with the help of Brush and Air Brush tools respectively. Here also, you can
choose the color for your Brushes accordingly.

Figure 1.15a: Drawings using Brush tool

Figure 1.15b: Drawings using Air Brush tool
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In the adjacent Figure 1.16, you can see
square and rectangles drawn with the
help of rectangle tool, a shape with many
corners is made with the help of polydon
tool, circle and ellipse made with the
help of Ellipse tool, straight lines made
with the help of Line tool and the bottom
right of it, the curved lines are made with
the help of Curve Tool. Here also, you can
choose the color before selecting the tool
accordingly. You can also note that, while
using any of these tools, you chose the
thickness of the line required in the
drawing.
Figure 1.16: Drawings using various
tools
Any of the drawing, which is closed with a
boundary, such as rectangle, circle or any
other shape, in which starting point of
line and end point of line meet to form a
closed figure, can be filled with a color
with the help of Fill With Color tool. The
same can be seen in the adjacent Figure
1.17. Just note all the closed figures such
as Square, Rectangle, Polygon, Circle,
Ellipse and Rounded Rectangle are filled
with different colors with the help of Fill
With Color.
Figure 1.17: Fill with Color
While drawing any picture, if you wish to select and move/copy any portion of the
drawing to any other part of the drawing, you can do so by Select tools – Free Form
Select tool or (Rectangular) Select Tool. Figures 1.18a and Figure 1.18b illustrate the
example of selecting and moving the portion of a picture using Free Form Select and
Rectangle Select tools respectively
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Figure 1.18a: Select Tool (Rectangle Select)

Figure 1.18b: Free Form Select

There are few more interesting options available in Paint software such as
Flip/Rotate. (1) Select any portion of your drawing/picture as shown in Figure 1.19a
(2) Click Image option of menu as shown in Figure 1.19b (3) Click Flip/Rotate option
(4) In the popup select Flip Horizontal and click OK button as shown in Figure 19c (5)
Look at the flipped portion of the picture as shown in Figure 1.19d.

Figure 1.19a: Select Tool (Rectangle Select)
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Figure 1.19c: Flip horizontal option

Figure 1.19d: Flipped portion

In the same way you can try other options such as Strech/Skew. Stretch option will
help you to stretch/squeeze the portion selected by you, where as skew will help you
to tilt the selected portion at an angle horizontally or vertically. The following Figures
1.20a to 1.20 illustrate the Stretch and Skew options.

Figure 1.20a: Stretch (60% of original)

Figure 1.20b: Stretch (120% of original)
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Figure 1.21c: Skew (45% Horizontal)

Figure 1.20d: Skew (45% Vertical)

Practice Time
Draw the following in Paint Tool and save the pictures as JPG files in a folder with the
your name:
1.

Draw all basic Geometric Figures – Triangle, Square, Rectangle and Circle, color
them with different colors and label them accordingly. Save the file as
“SHAPES.JPG”

Triangle
2.

Square

Rectangle

Circle

Draw a Tree and add a slogan “SAVE TREES”. Save the file as “SAVETREE.JPG”

SAVE
TREES
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Draw a picture of hut and write My House. Save the file as “MYHOUSE.BMP”

Figure 1.21: Paint

Summary
· Operating System is the main software essentially required to make a personal
computer work.
· MS Windows, LINUX, UNIX and MAC OS are operating systems.
· Folders are used to contain files in organized manner, which can be categorized
under the same domain.
· A desktop is a computer display area of windows that contains the various
objects one might find in the computer.
· My Computer contains a list of all the Secondary Storage device(s) available on
your computer.
· TXT is the file extension for Text Files created in Notepad.
· BMP, JPG, GIF and TIFF are the various file formats for storing images and
pictures.
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Self Assessment
S.No. I am able to…

Yes

1

Identify common desktop icons

2

Name two operating systems

3

Create a text file in Notepad and save it in desired location

4

Draw a picture in Paint and save it in desired location

5

Explain the functionality of different Paint tools

No

_________________________________________Now I can answer …
1.
2.
3.
4.

How folders help in organsing files in a computer system?
Name any three operating systems.
Name three different file formats, which can be used for saving a picture file.
Identify the software [out of notepad or paint] to be used for performing the following
tasks.
(a)
To make a simple drawing with the help of geometrical shapes
(b)
To type a textual information
5. Write name of four tools which are part of paint software.
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Element 3: Creation/Customizing of Files and Folders
A file in computer terminology can be considered as the modern counterpart of paper
documents which traditionally were kept in offices and libraries. The term file is used
in computers for a block of arbitrary information, or resource for storing information.
In element 2, you have already seen two types of files – Text File or Picture File.
Some more text and picture files icons are shown below for your reference with
filenames Bill_Gates.jpg, Thoughtsofpranav.txt, Steve.jpg, pranav_mistry.jpg,
AmoutSteveJobs.txt and Microsoft.jpg.

Figure 1.22: Files
Here are some of the ways to rename, copy, cut and paste files.
To rename a particular file:
Close the file to be renamed, if opened. Locate and Select the file [1] click the right
button of mouse [2] Select Rename [3] The filename will become editable – type the
new name and press ENTER Key on the keyboard
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Figure 1.23: Renaming a File
OR
Locate and Select the file [1] Click F2 button of mouse [2] The filename will become
editable – type the new name and press ENTER Key on the keyboard
To delete a particular file:
Close the file to be deleted, if opened. Locate and Select the file [1] Click the right
button of mouse [2] Select Delete [3] Pop up will ask to confirm File Delete – Click on
YES
OR
Locate and Select the file [1] Press Delete key on keyboard [2] Pop up will ask to
confirm File Delete – Click on YES
To COPY-PASTE a particular file:
Locate and Select the file [1] Click the right button of mouse [2] Select Copy [3]
Change the Drive and Folder to target location [4] Click the right button [5] Select
Paste
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OR
Locate and Select the file [1] Press CTR & C Keys together [2] Change the Drive and
Folder to target location [3] Press CTR & V Keys together
Note: In Copy-Paste, the file will remain there in the original location and a copy of
the same will be saved on the new location
To CUT-PASTE a particular file:
Close the file to be moved, if opened. Locate and Select the file [1] Click the right
button of mouse [2] Select Cut [3] Change the Drive and Folder to target location [4]
Click the right button [5] Select Paste
OR
Locate and Select the file [1] Press CTR & X Keys together [2] Change the Drive and
Folder to target location [3] Press CTR & V Keys together
Note: In Cut-Paste, the file will be removed from the original location and will be
copied in the new location
A folder is basically a container, in which the files can be organized in the computer’s
storage devices. We create folders to keep different kind of information separately
for later use. You already have seen some icons of some files above and you can very
well put those files in the appropriate folders.

Figure 1.24: Folders
To rename a particular folder:
Close all the applications, which are using the folder to be renamed.
Locate and Select the folder [1] click the right button of mouse [2] Select Rename
[3] The folder name will become editable – type the new name and press ENTER Key
on the keyboard
OR
Locate and Select the folder [1] Click F2 button of mouse [2] The folder name will
become editable – type the new name and press ENTER Key on the keyboard
To delete a particular folder:
Close all the applications, which are using the folder to be deleted.
Locate and Select the folder [1] Click the right button of mouse [2] Select Delete [3]
Pop up will ask to confirm Folder delete – Click on YES
OR
-28-

NVEQ Level 1

ITCC 101

Locate and Select the folder [1] Press Delete key on keyboard [2] Pop up will ask to
confirm File Delete – Click on YES
To COPY-PASTE a particular folder:
Locate and Select the folder [1] Click the right button of mouse [2] Select Copy [3]
Change the Drive and Folder to target location [4] Click the right button [5] Select
Paste
OR
Locate and Select the folder [1] Press CTR & C Keys together [2] Change the Drive
and Folder to target location [3] Press CTR & V Keys together
Note: In Copy-Paste, the folder will remain there in the original location and a copy
of the same will be saved on the new location
To CUT-PASTE a particular folder:
Close all the applications, which are using the folder to be deleted.
Locate and Select the folder [1] Click the right button of mouse [2] Select Cut [3]
Change the Drive and Folder to target location [4] Click the right button [5] Select
Paste
OR
Locate and Select the folder [1] Press CTR & X Keys together [2] Change the Drive
and Folder to target location [3] Press CTR & V Keys together
Note: In Cut-Paste, the folder will be removed from the original location and will be
copied in the new location.
If we wish to select all the files with in a folder in one go, we can simply go in that
folder and select them by pressing CTR & A together as shown in the following picture
– all the files in the folder are selected. After selecting the files, we can Copy or Cut
these files with the help of CTR & C or CTR & X.

Figure 1.25: Selecting all files in a folder
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We can select some of the files, which are one next to each other in a particular
folder with the help of Shift and direction keys (Left, Right, Up and Down Keys) as
shown in the following picture – the first four files in a sequence are selected.

Figure 1.26: Selecting files in sequence
We can also select some of the files, which are not in a sequence by holding CTR key
and using Left button of Mouse one by one as shown in the following picture – three
files selected, which are not in sequence.

Figure 1.27: Selecting file (not in sequence)

Summary
·
·
·
·
·
·
·
·
·
·

Files help us to store information in it
Folders help us to organize files properly
We can rename files/folders
We can Copy file/folders from one storage location by using CTR+C Keys
together
We can Cut file/folders from one storage location by using CTR+X Keys together
We can Paste file/folders to any location by using CTR+C Keys together
We can select all files in a folder by using Ctr+A Keys together
We can select files in a sequence with the help of combination of
Shift+Direction Keys together
We can select some files (which are not in sequence in folder), by pressing Ctr
and pressing Left mouse button one by one
Meaningful names of files/folders help us to find the information quickly from
storage devices.
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Self Assessment
S.No. I am able to…

Yes

1

Identify text and picture files in folder.

2

distinguish between files and folders.

3

Copy, Cut and Paste files and folders.

No

_________________________________________Now I can answer …
1.
2.
3.
4.
5.
6.

What is a computer file?
Write names of two types of files, which you can make yourself on computer.
Which two keys help you copy a file/folder?
What combination of keys help you to select all the files in a folder?
There are alternative methods to rename a particular file or folder – State True/False.
Which combination of keys help you to paste a file on the current location?
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Element 4: Establishing Internet connectivity and Internet
Browser
To start with Internet, you should first know, whether you have the Internet account
provided by any of the Internet Service Provider or not. VSNL, BSNL, Airtel and
Reliance are some major services providers in India, who help you to get connected
on World Wide Web.
Type of Internet connections: Cable operator’s Internet connection, Broadband
connection, Leased Line.
The home users normally take internet connection from Cable operators or they
subscribe broadband connections from major internet service providers. The speed of
such connections varies from 256 kbps to 2 mbps. Such connections are shared with
many users at the same time and so its speed varies depending on various users’
internet activity at that point of time.
The corporate users prefer subscribing a leased line internet connection for faster,
effective and reliable connectivity. The speed of such connections varies from 1 mbps
to 100 mbps. These connections are provided with the help of dedicated connectivity
with service provider’s internet server.
Internet Browser – It is the software, which helps you to access web pages from
various websites. There are various Internet browsers available such as Google
Chrome, Mozilla Firefox, Safari, Opera and Internet Explorer. Internet Explorer comes
by default alongwith Microsoft Windows operating system and other browsers can be
downloaded freely from their relevant websites.
Searching for information with the help of browser – there are a number of search
engines such as google.com, yahoo.com, bing.com etc. Any of these search engines
can be loaded on the browser to search for specific information from world wide web.
Basic tips to search or information using search engines:
Search is simple: just type whatever comes to mind in the search box, hit Enter or
click the [Search] button, and the search engines such as Google will search the web
for content that's relevant to your search. Most of the time, you will be able to find
exactly what you are looking for just by typing the words in search box.
However, the following tips can help you make the most of your searches.
1. If you type the words [India and America] will give different results than when
you type only [India] or only [America]
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2. Every word, what you type as ‘search word’ matters. Generally, all the words
you put in the query are used by the search engines.
3. Search is always case insensitive. A search for [Delhi CAPITAL of India] is the
same as a search for [delhi capital of india ].
4. Generally, punctuation symbols are ignored, such as @#$%^&*()=+[]\.
5. To make sure that your search engine returns the most relevant results, there
are some exceptions to the rules above, which are as follows.
Specific tips for better searches
Keep the searching text (word or words) simple. If you are looking for a
particular school, just enter its name, or as much of its name as you can recall.
If you're looking for a particular product, place, or concept - start with its name.
Think how the page you are looking for will be written.
Remember, a search engine a computer program, and it is not a human. It is a
program that matches the words you give to pages on the world wide web. Use
the words that are most likely to appear on the web page. For example, instead
of saying [pain in my head], you should say [headache ], because that's the term
a medical page will use. The query [which five countries produce maximum
coconuts in the world] is very clear to us, but the document that gives the
answer may not have those words. Instead, use the query [Top 5 coconut
producing countries], because that is probably what the right page will say.
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Figure 1.28: Search Enginess

Summary
·

·
·
·
·

VSNL, BSNL, Airtel and Reliance are some of the Internet Service providers in
India
Google Chrome, Mozilla Firefox, Opera and Internet Explorer are some of the
commonly used internet browsers
Various search engines help us to obtain/search various information from world
wide web
In search engines, search words are case insensitive.
In search engines, we should use simple words

Self Assessment
S.No. I am able to…

Yes

1

Know about type of internet connections.

2

distinguish between leased line and broadband connections.

3

Search for information using search engines.

No

_________________________________________Now I can answer …
1.
2.
3.
4.

Name any three internet service providers in India?
Name any three internet browsers?
Name any two internet search engines?
Which of two sets of words should be typed in search engines to get more appropriate
results?
(a)
[What is the capital of India?] OR [Capital of India]
(b)
[Fastest Train] OR [Which train has the highest speed?]
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Element 5: Email and Related Services
Email is the best way to communicate with anyone anywhere with the help of Internet
connection. There are a number of free email service providers, you can create an
email account and can start sending, receiving and forwarding messages in the form
of Email. Gmail (gmail.com), Yahoo Mail (mail.yahoo.com), Rediffmail
(rediffmail.com) and Hotmail (hotmail.com) are few examples of free email account
providers. The email addresses contain the username@serviceproders website
address. If abc.com is the service provider and you created an account using name
kamransiddu, the email address will become “kamransiddu@abc.com”. Remember,
the email address cannot contain a space in it. It means and address “gagan
chhabra@abc.com” will not be a valid email address.
To send or receive email, you need to first create an email account by providing some
of your personal information, login name and password. Sample sets of steps are as
follows in Figure 1.29a to Figure 1.29d
Step 1: Click Create an account

Click here to create a New
Gmail Account

Figure 1.29a
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Step 2: Enter First Name, Last Name and Desired Login Name (Click Check availability
to see if the desired login name is available or not), Password (at least with 8
characters preferably a combination of alphabets, digits and some special characters
such as * & # $ to make it a strong password – at the same time make sure that it
memorable)

Figure 1.29b

Step 3: Enter a security question & answer alongwith a recovery mail (you may write
your parent’s email address as your recovery mail) – all this information will help you
to regain access to your email in case you forget your password. Alongwith this, you
need to provide your location, date of birth and word verification (you need to type
exactly the same characters, which you see on screen.
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Figure 1.29c

Step 4: Finally, you need to read and accept the terms and conditions to create the
account.

Click here to
create the
account

Figure 1.29d

Step 5: If all the information and password is correctly entered, your account will get
created, else you need to go through the process of Step 1 to Step 4 once again.
-38-

NVEQ Level 1

ITCC 101

Once the account is created, you can login (Sign in) to your account any time later.
To Sign in your account, you just type in the address of your email service provider
such as www.gmail.com in the address bar of your browser. Type in the your
Username & Password and Sign in to your account. A sample Sign in screen is shown in
Figure 1.30 for your reference.

1. Type in your Email Address here

2. Type in your Password here

3. Click Sign In

Figure 1.30: Email Login Screen

After signing into your account, you will see the email account desktop as shown in
the Figure 1.31
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Contains all the received mails

Contains all the mails, which are sent by you

Contains all the mails, which you typed and want to send later

Figure 1.31: Email Account Desktop
On the email account desktop, you can see some of the options as shown in Figure
1.31. You can observe some of the basic options as:
Inbox – it is link to a folder that contains all the emails received by you.
Sent Mail – it is link to a folder that keeps all the mails sent by you from your email
account.
Compose mail – it is a link, which opens the option for you to type in the Receiver’s
Email/Target Email address(es), Subject of the Email, content of the email and gives
you the option to send this mail to all the people whose address(es) is/are mentioned.
In compose mail, Target Email address(es) can be typed in To( or/and cc or/and bcc)
option. Here, cc means carbon copy, if you want to add more addresses of receivers,
who are supposed to receive this email. In this case, all the receivers will be able to
see all the email addresses to which this email is sent, whereas bcc means blind
carbon copy, here also you can write the more email addresses of receivers, but these
email addresses will not be visible in the receivers’ emails. If you enter more than
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one addresses in any one of these options, you can separate address(es) with the help
of comma (,).
Writing one address in any
Examples:
one of these options is must
abc@abc.com
To
sarvodayavidyalaya@cbse.nic.in, info@xyz.com
Cc
personal@xyz.com
Bcc

1. Click
Compose
mail

2. Type in the
email address

3. Type in the
Subject of email

4. Type in the
content of the email

5. Click Send to
finally send the
email

Figure 1.32 Composing an Email
In most of the modern Email Services, a formatting toolbar is also available to set the text in
Bold, Italics, Underlined etc. Figure 1.33 illustrates the Format Toolbar available in Gmail.

Figure 1.33 Formatting Toolbar in Gmail
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You can see the Figure 1.34, which illustrates email content in Hindi.

Click here to start or stop
phonetic Hindi
In this mail, we have
actually typed
“Priy mitra jeevan,
main yahan kushal mangal
hun | …”
which automatically got
converted into hindi.

Figure 1.34: Composing an Email in HINDI

Practice time
Write an email to your computer teacher sharing with him your result of an InterSchool Event.
Alternate Internet Related Services
Chat – It is the simplest way to informal way to communicate or exchange message
online in real time with another person over the internet.
Video Conferencing – It is another way to communicate with one or more number of
people over the internet with the help of video camera, screen, mic and speaker,
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which allow people to see and talk to each other in real time. It requires faster
internet connectivity.
IP Telephony - It is an alternative way to have telephonic conversation using internet.
It allows people to have audio communication between people who are miles away
from each other. It is a cost effective solution as compared normal ISD or STD calls.

Summary
·
·
·
·
·
·
·
·

Email is one of the ways to communicate digitally with the help of Internet.
Every email id is unique on the world wide web i.e., no two people can have
the same email id.
Email id will always contain @ symbol
You can type in different languages in while composing a message in Gmail.
Inbox contains the mail received in the individual email id
Chat is instant text message exchange between people over the internet
Video Conferencing allows video and audio communication over the internet
IP Telephony helps in cost effective audio communication

Self Assessment
S.No. I am able to…

Yes

1

Create an email account.

2

Send an email to my friend.

3

Distinguish between chat and video conferencing.

No

_________________________________________Now I can answer …
1.
2.
3.
4.
5.

Name two free email service providers?
What is the difference between INBOX and SENTMAIL BOX?
Write one advantage of chat over email?
Write one advantage and one disadvantage of Video Conferencing?
Identify invalid email ids from the following:
(a)
Free from stress @gmail.com
(b)
geekswish@abc.com
(c)
erpsolutions@xyz@abc
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You can rise upto…
Explore contributions of "John Von Neumann" & "Charles Babbage"

Assessment
Multiple Choice Questions

1. Computer system has a unit, which displays the results from it.
A. Central Processing Unit
B. Memory Unit
C. Input Unit
D. Output unit
2. A computer system can accept textual input with the help of
A. Mouse
B. Video Camera
C. Keyboard
D. Barcode Reader
3. We can enter the audio form of data into a computer system with the help of
A. Mike
B. Scanner
C. Keyboard
D. Barcode Reader
4. One of the Internet Service provider in India
A. CBSE
B. BSNL
C. Microsoft
D. Infosys
5. Files can be organized in
A. Printer
B. Keyboard
C. Folder
D. Mouse
6. Which of the following is not an Internet Browser?
A. Google Chrome
B. Internet Explorer
C. Mozilla Firefox
D. Notepad
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7. Which of the following can be used for Audio-Video communication?
A. Video Conferencing
B. Chat
C. Email
D. IP Telephony
8. Which of the following is not an Internet Browser?
A. Google Chrome
B. Internet Explorer
C. Mozilla Firefox
D. Notepad
9. Identify a valid email id out of the following.
A. jamesmartin@james.in
B. james_martin.james.in
C. james@martin@in
D. james martin@james.in
10. Which of the following combination of keys are used for copying a particular
file in a folder?
A. CTR+V
B. CTR+X
C. CTR+C
D. CTR+A

Fill in the blanks
1.
2.
3.
4.
5.
6.
7.
8.

Computer system has a unit, which displays _____________
A computer system can accept textual input with the help of ____________
_________ can help us enter the audio form of data into a computer system.
_____________ has all the emails, which were received on an email id.
_____________ helps in searching for information from the internet.
In an email id ________ symbol is must.
Printer is an ______________ device.
___________________ is the combination of keys, which selects the entire
content with in a folder.
9. We should use __________________ names for files/folders.
10. __________________________ provides dedicated connectivity with internet service
provider’s server.
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Questions with short answers
1. While working on school computer, Suraj found a beautiful picture and he
wants carry this picture to be saved in his home computer. Suggest him two
devices, through which, he can transfer this file to his home computer.
2. Tanya Madan is first time user on a computer. She has drawn a picture using
paint tool, suggest her the steps to create her own folder on the hard disk and
save the file in that folder. Write down all the steps suggested by you in order.
3. Jiya Sen wants to move one of the file “RESUME.TXT” from her Pen Drive to a
folder “C:\PERSONAL” and she does not want the file to remain in the Pen
Drive. What minimum set of operations, you will suggest to perform this task?

Case based problems
1. Type in your today’s activities in a Text File, save it with the name as “MYDAY.TXT” in
one of the folders “MYFOLDER” created by you on the hard disk.
2. Draw colorful pictures of Fruits with labels using basic drawing tools, save it as
“MYPIC.BMP” in the folder “MYFOLDER”.
3. Search for all the pictures on the hard disk, change the view to see the thumbnails of
these pictures, open one of the existing picture, save the picture in different formats
BMP, JPG and GIF in “MYFOLDER”
4. Now, rename your folder with your admission number to make it unique.
5. Send a mail to one of your friend and tell about your first experience on computer.
Enclose your own created picture with this mail to be viewed by him/her.
6. Open the Google search and type in your name, start search and see how many links
you get in result, talk to your friends and compare the number of links they received
while searching there name. Note: Remember, these links may or may not be related
to you because many people might have same name as you.

Suggested Reading
Reference books
·

Peter Norton's Introduction To Computers Fifth Edition Student Edition, Peter
Norton,

Websites
·
·

http://www.gcflearnfree.org
http://www.grassrootsdesign.com
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DIGITAL DOCUMENTATION – WORD PROCESSING
Pre-requisite: ITCC-101 Basics of IT
Unit Code

ITCC-102

Unit Title (Skills)

Hours

Digital Documentation and Word Processing
Skill
Basics of Word Processing
Page style and templates
Editing and Advanced format options
Working on multiple documents
Creating and Working with tables
Working with Images, Drawing and Gallery
objects

Th

Pr

12

24

2

2

2

2

2

8

2

4

2

4

2

4

Total
Hours
36

Ignite Mind
"Design is a funny word, some people think design means how it looks. But of course, if you
dig deeper, its really how it works"

Steve Jobs

Learning objectives
After
·
·
·
·
·
·

studying this unit the students will attain competency to:
Create, Save, and Print simple documents using a Word Processor.
Use page Style and templates.
Edit document and use advanced formatting features.
Work on multiple documents simultaneously.
Create and work with tables in a document.
Work with images, drawings, and gallery objects.

Introduction
Everyday we come across many documents like notices, letters, circulars, question papers,
notes and assignments, admission forms, bio-data etc. Imagine the preparation of such
documents using a typewriter. For every correction in a page the whole page is to be retyped.
After the final version is typed, it is to be kept safe very carefully because recreation will again
take the same amount of time and efforts. More care has to be taken if the document is to be
preserved for a longer time (may be a few years). It used to happen until the development of
word processors. Now a day, almost all the documents are prepared on computer using word
processor. Using a word processor we can create any kind of document. Word processors allow
us to preserve digital copy of our documents for practically infinite time. When correction is to
be made, it is to be made only at the relevant word or sentence. Insertion and deletion of text
is very easy using a word processor. There are many more advantages of using word processors.
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Word processors are the most widely used application software. In this lesson we will learn the
use of word processor for preparing documents.

Resource requirement
Hardware
·

A working computer system

Software
·

A word processor (Preferably OpenOffice Writer, which is downloadable from
OpenOffice.org).

Suggestions for Effective Teaching
·
·
·
·
·

Encourage peer learning in Computer Lab
Ensure that students follow standard procedures to logon/logoff a computer.
Ensure the proper connectivity of I/O devices
Encourage students to explore opportunities as IT Professionals
Introduce how to integrate Digital Documentation with traditional practices at various
work places
· Encourage students to follow best practices such as taking backup of files, turning off
devices when not in use
· Educate students to keep storage media virus free
· Sensitize students on ethical and health related issues
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A word processor is a software used for creating, editing, formatting, and printing any type of
printable material. Any material created using a word processor is called a document and the
process of using a word processor is called word processing. A document may contain any
combination of plain text, images, and shapes. A word processor allows us to save our
documents in the computer and use them whenever required. It means that if we create some
documents using a word processor and save these documents in the computer, then at any time
– the same day, the next day, next week, after a month, or even after years we can use these
documents. A document once created and saved can be used later and it can also be modified
later.
There are many word processors available in the market. These include MS Word, OpenOffice
Writer, Kingsoft Writer, QuickSilver etc. OpenOffice Writer is an open source software and is
available free of cost. It can be easily downloaded from the Internet from the site:
www.OpenOffice.org.
Know More!
OpenOffice Writer is a part of OpenOffice.org. OpenOffice.org is a collection of software which
includes OpenOffice.org Base (a DBMS), OpenOffice.org Calc (A spreadsheet package), OpenOffice.org
Draw (a vector graphics editor), OpenOffice.org Impress (A presentation package), OpenOffice.org
Math (for creating and editing mathematical formulae), and OpenOffice.org Writer (A word
processor). This way OpenOffice.org contains all the software which are used for any kind of
work inwe
almost
the offices.
That is why
is also
called
an Office
Incomputer
this chapter
shallalllearn
the concepts
of OpenOffice.org
word processing
using
Writer.
TheSuite.
concepts

covered in this chapter are applicable to any other word processor as well. Therefore, if you do
not have Writer but some other word processor, there is nothing to worry – you can still practice
all the concepts covered here.
Let us now start the practical learning.
To start Writer, follow the following steps:
Click at [1]Start à[2]All Programs à[3]OpenOffice.org à[4]OpenOffice.org Writer
as shown in Figure 1.1.

Figure 1.1: Opening Writer

OR
There may be an icon for Writer on the Desktop. If it is there Double Click it to start Writer.
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OR
There may be an icon for Writer on the Start menu. If it is there Click it to start Writer.
Writer window looks as follows (Figure 1.2). Here the Writer window is shown with labeling of
some major components.

Title Bar

Menu Bar

Standard Toolbar

Formatting Toolbar

Main Content Area
Status Bar

Figure 1.2: Writer window

Let us understand this window first.
Different types of bars and toolbars are there so that we can conveniently create our documents
in whatever way it is required. Work area is the area where the actual document is created. Let
us create a simple document to begin with. Before creating the document, create a folder
“D:\IT Class IX\WP_Practice” where you shall store all the documents that you create during this
chapter. After creating the folder start Writer and type the following text in the Work area:
Everyday we come across many documents like question papers, students list,
study material in the form of notes and assignments, admission forms, bio-data
etc. Almost all of these documents are prepared using word processors. Word
processors are the most widely used application software. Using a word processor
we can create any kind of document. In this lesson we will to learn how to use a
word processor to create desired documents.
To save this text in the above mentioned folder, choose the option [1]File à[2]Save from the
Menu Bar.
Then another window (Save As window) opens as shown in Figure 1.3. In this window select the
desired folder from the Save in combo box. Then give the file name, let us say Document1, in
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the File name box. Then click at the Save button to save this document. Writer automatically
gives the extension .odt to the document.

Figure 1.3: Save As window

Now if you check the folder, you will find this document saved in it with the name
Document1.odt.
If you want to work with this document again, you can open it in three ways
(i) By selecting the option [1]File à[2]Open from the Menu Bar.
(ii) By selecting the document name from the option [1]File à[2]Recent Documents from
the Menu Bar.
(iii) By Double Click at the document icon in the folder where the document is stored.
Let us now create another document and learn a few more things in Writer. For this we shall
create the following document. Note that the
symbol in this text represents the Enter key
on the keyboard. While entering text Enter key has to be pressed only after a paragraph ends. It
means that while typing this text you have to press Enter key at five places only and not after
every line of text.
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So, now you should start Writer and enter the above text. Do not worry about the colour or any
other feature of the text. We shall learn it all. You just type the given text.
After typing the text you find that it is not in the given format. In the given text observe the
following characteristics:
(i) In the first line, the word Circles is Blue in colour, it is underlined, is bigger than the
remaining text, appears exactly in the centre of the line, and has style different from the
remaining text.
(ii) The words circle, centre, Radius, Diameter, Chord, and Circumference are bolder than
the remaining text.
(iii) All the lines of the first paragraph start from the same position.
(iv) All the lines in the second paragraph end at the same position.
(v) All the lines in the third paragraph start as well as end at the same position.
(vi) All the lines in the fourth paragraph appear exactly in the centre (horizontally).
We shall achieve these effects in our document using the following features of Writer:
(i) Font Name, Font Size, Font color: Font refers to the look of characters in the
document. Look of characters can be changed using the Font Name, Font Size, and Font
Color from the format toolbar.
(ii) Alignment: Alignment of text refers to start and end position of the text in the
document. Text can have Left alignment, Right alignment, Centre alignment, or Justified
alignment. Different paragraphs in a document can have different alignments. Alignment
of a paragraph can be changed by choosing the appropriate option from the format
toolbar.
(iii) Bold, Italics, Underline: Text or parts of text in a document can be Bold, Italicised
(Tilted), and/or underlined. This can be done by choosing the appropriate options from
the format toolbar.

Figure 1.4: Format toolbar

Now we shall apply these features on our document to achieve the desired effects. For this we
have to follow the following steps:
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(i) Select the text in the first line (Circles). Click at the down arrow in Font Name combo
box, and select the Font Name “Times New Roman”. Similarly select Font Size 16, and
Font Color Blue. Click at the Centre alignment.
(ii) Select the word ‘circle’ in the second line and click the Bold button in the format menu.
The word circle will become bold. Similarly set all the desired words Bold in the given
text.
(iii) Now click anywhere in the second paragraph and then click at the right alignment button.
Second paragraph gets right aligned. Similarly click in third paragraph and click at
justified alignment button. Click in the fourth paragraph and click at Centre alignment
button. There is no need to align the first paragraph because it is already left justified by
default.
Keyboard Shortcuts: The buttons Bold, Italic, and Underline have their corresponding keyboard
shortcuts also. After selecting the text, instead of clicking at these buttons, we can use
corresponding keyboard shortcuts for the desired effects. These shortcuts are listed in the table
below:
SNo Operation Keyboard Shortcut
1.
Bold
Ctrl+B
2.
Italicize
Ctrl+I
3.
Underline Ctrl+U
Here Ctrl+B means that we have to press Ctrl button on the keyboard and while keeping it
pressed immediately we have to press character B and release both the buttons. Keyboard
shortcuts are available for many other functions also.
Now we have the document as required. Similarly, you can create any other document and
format it as required.
After creating a document we usually want to print it for later reference. Writer gives us option
to print our documents. Writer also gives us option to check the look of our printed document
even before it is printed. This option is called Page Preview and is available through the File
option in Menu Bar.
By using this option we can check whether the printout will be exactly like we expect. If it is so
then we can print the document through the Print option in File option of Menu Bar. Otherwise,
we can edit the document in the way we want before printing it.
When we choose the print option, Writer shows a Print Window as follows:
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Figure 1.5: Print window

Through this Print window we can set some basic print settings as:
(i) Printer: If there are multiple printers attached to our computer or if our computer is a
part of a network of computers which contains more than one printers, then we can
select the printer on which we want to take the printout.
(ii) Print Range: We can select whether we want to print (i) the whole document, (ii) some
pages of the document, or (iii) Selected text from the document.
(iii) Number of Copies: We can select how many copies of the document we want to print.
After selecting the desired options if we click at OK, the document gets printed.

Summary
·
·
·

·
·

A word processor is software used for creating, editing, formatting, and printing any type
of printable material.
Some of the popular word processors are MS Word, OpenOffice Writer, Kingsoft Writer,
QuickSilver.
OpenOffice Writer is a part of software package “OpenOffice.org”.

OpenOffice Writer saves the documents in Open Document format with extension “odt”.
Documents can be formatted by setting Fonts (Font Name, Font Size, Font Color) and
Alignment (Left, Right, Center, Justify).
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· Documents can be formatted by setting some text Bold, Italics, and Underline.
· Writer provides keyboard shortcuts for many operations.
· Writer gives us option to print our documents.
· Using Print Preview we can view how the printout of our document will look before
actually taking the printout.

Self Assessment
S.No.
1.
2.
3.
4.
5.
6.
7.
8.

I am able to…
Yes No
Open Writer
Identify various toolbars
Save files with specified names at specified locations
Open specified files from specified locations
Apply specified font (Name, Size, Color)
Align text (Left, Right, Centre, Justify)
Apply Bold/Underline/Italics
Print a document

_________________________________________Now I can answer …
1.
2.
3.
4.
5.

What is a word processor? Name some popular word processors.
Name any five parts of Writer window.
Write the keyboard shortcuts for Bold, Italics, Underline operations.
List any five options of format toolbar.
What is “Print Range”?
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ELEMENT 2 - PAGE STYLE AND TEMPLATES
In Writer we have some control over the way our document is printed. We can set the space
which is left blank around the printed material on the page. We can also control the starting
and ending position of different lines in a paragraph. We can also decide the orientation, i.e.,
Portrait (length wise) or Landscape (Width wise) of printing on the page. All these concepts
come under the topic Page Style. To understand the concept of page style let us first learn a
few terms:
(i)
(ii)

(iii)
(iv)

Margins: Page margins are the blank space around the edges of the page.
Indents: Indents are the spaces between the beginning / end of a line and the left /
right margin as. The space between beginning of a line and left margin is called the Left
Indent. The space between end of a line and right margin is called the Right Indent.
Notice that Margins are along the border of the page while Indents are in the Main
Content Area.
Format: Refers to the paper size. We can select any predefined paper size (A3, A4,
Letter etc.) or we can create a custom format by entering the dimensions (Height and
width) of the paper.
Orientation: Orientation refers to Portrait (length wise) or Landscape (width wise)
printing. Default orientation of a page is portrait. If the orientation is changed to
Landscape, its height and width will interchange as illustrated in Figure 1.7 below.

The Indents and Margins are illustrated in below in the Figure 1.6.
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Figure 1.6: Indents and Margins

The Orientation of a page is illustrated in below in the Figure 1.7.

Figure 1.7: Page Orientation

Setting Page Style
The margins, Format, and Orientation of a page can be set by choosing the option
[1]Format à[2]Page from the Menu Bar. This opens the Page Style window as shown below:
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Figure 1.8: Setting Page Style

Using the Page tab of Page Style window (above) we can set the page format, Orientation, and
Margins as desired.
Page Margins can also be set using the rulers. Rulers are the bars that we see at the top and left
of the document as marked in Figure 1.9 below:
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Figure 1.9: Rulers

The blocked portion at the ends of rulers represents margins. Margins can be set by dragging
the end lines of the margins as shown in the diagram.
Now let us see how can we set the indents of paragraphs in a document. Let us observe the
horizontal ruler again. On this ruler we see three small triangles called Indent Markers (Figure
1.10).

Figure 1.10: Indent Markers
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To change the left paragraph indent, select the paragraph or click anywhere in the
paragraph and drag the paragraph marker (lower left triangle) to the desired location.
To change the right paragraph indent, select the paragraph or click anywhere in the
paragraph and drag the right indent marker (lower right triangle) to the desired location.
To change the first line indent of a selected paragraph, drag the top left triangle on the
horizontal ruler to a new location.

Line and Paragraph Spacing
Line spacing is the space between two consecutive lines of text. Paragraph spacing is the space
between two consecutive paragraphs. Writer allows us to adjust line spacing and paragraph
spacing in the documents. To adjust line spacing and paragraph spacing choose the option
[1]Formatà [2]Paragraph from Menu Bar. This opens the following window:

Figure 1.11: Indents and Spacing

Through this window we can adjust the paragraph and line spacing. Just click at the down arrow
in the Line spacing combo box to find out what different options for Line spacing are available.
An example of a text with different spacing is given below:
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Figure 1.12: Line and Paragraph spacing

Templates:
Creating a simple document is the basic requirement, but it is not sufficient. One should also
know how to create formal and official documents like letters, circulars, memos, fax etc.
Templates are really handy for standardization of such documents. A template is a document
which defines a standard layout and look and feel of a document. For example, a template for
an official letter defines the positions on the page where different parts of the letter appear,
and also the font name, size, and color of each part. Once a template is created, it can be
saved and used to create any business letter following the same pattern. Using Wizards feature
of Writer we can create templates and then we can create documents based on these
templates. We shall learn this concept with the help of an example.
Creating Letter Template
Suppose we have to frequently create personal letters. For this we want to keep the look and
feel (Color scheme, font, font size, placement of contents etc.) same in every letter. To
achieve this we can create a template by choosing the option [1]File à[2]Wizard from the
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Menu bar. It opens another menu which shows different kinds of templates that can be created.
Click at Letter (as we want to create template for letter). It opens Letter Wizard window.

Figure 1.13: Creating Letter template

In this window we can choose from three kinds of letter: (i) Business Letter, (ii) Formal Personal
Letter, and (iii) Personal Letter. For our purpose select Personal Letter and click the Next
button. It opens the next window as shown below.

Figure 1.14: Printed Items options on letter wizard window

Notice that in this window only three steps(steps 1, 3 and, 6) are enabled. The number of steps
enabled depends on the kind of template we choose. Depending on the kind of template, Writer
decides the number of steps in which the template can be created and then only the relevant
steps are enabled. The current template (Personal Letter) can be created in just two more steps
and therefore, only two more steps (3 and 6) are enabled.
We choose the relevant options and fill in the desired places in this window and click Next
button. After this another window opens in which we have to specify a suitable name for the
template and the location where we want to save the template. In this window we are also
asked if we want to create a letter from this template. If we want to create the letter we
choose this option.
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Figure 1.15: Name and Location option on letter wizard window

Then Writer saves our template and opens a document which is based on this template. We can
make any changes in this document (letter based on our template) and save it with a suitable
name.
After this whenever we want to create a letter based on this template, we have to choose the
option [1]File à[2]New à[3]Templates and Documents. It open Templates and Documents
window. In this window by clicking at Templates icon on the left hand side we can choose the
desired template and create a document based on it. This is illustrated in the following figure.

Figure 1.16: Using a template to create documents
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Summary
·
·
·
·
·
·

Page style includes Margins, Indents, Format (Paper Size), and Page Orientation
Margins are set for the whole document whereas Indents may be set for individual
paragraphs or for the whole document.
Orientation of a page can be Portrait or Landscape.
Margins and Indents can be set using Rulers.
A template defines the setting of a document. Any number of similar documents can be
created based on the same template.
In Writer we can use predefined standard templates as well as create our own templates.

Self Assessment
S.No.
1.
2.
3.
4.
5.
6.

I am able to…
Yes No
Use rulers for margin and indent settings.
Set page orientation as per the requirements.
Set page style using [1]Format à[2]Page option.
Set line and paragraph spacing as per the requirements.
Create templates.
Use templates to create documents.

_________________________________________Now I can answer …
1.
2.
3.
4.

Define (i) Margins, (ii) Indents, (iii) Page Orientation.
What is line spacing? Can it vary from paragraph to paragraph in a document?
What is paragraph spacing? Can it vary from paragraph to paragraph in a document?
What is a template? What is its use? How many documents can be created using one template?
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So far we have learnt how to create, save, open, and print documents. In real situations, many
times it happens that we have to make changes to an existing document. We can see many
examples of this: there may be some circular in which there is need to change the date, there
may be some notes in which some spellings are to be corrected, there may be some incomplete
assignments which need to be completed and so on. This process of making changes in a
document is called editing. Now we shall see what are different features of a word processor
which make editing an easy job.

Cut, Copy, Paste:
These are the basic editing functions which are used in almost all the GUI (Graphical User
Interface) applications. When some portion of a document is cut or copied, it gets copied to a
separate invisible location called Clipboard. When we apply paste, the contents of clipboard get
copied to the current location.
The difference between Cut and Copy is that when some portion of a document is Cut, it gets
removed from its original location and goes to clipboard, whereas when some portion of a
document is Copied, it remains at its original location and also goes to clipboard. Therefore, we
use the combination of Cut and Paste to move text from one place to another. The combination
of Copy and Paste is used to copy text from one place to another. The options to Cut, Copy, and
Paste are available through corresponding icons in the standard tool bar as shown below in
figure:

Figure 1.17: Cut, Copy, and Paste buttons

Let us understand this practically.
Open Writer and start a new document. Type the following text (Without the line numbers. Line
numbers are for further reference only):
Space activities in the started country during early 1960s with the scientific
investigation of upper atmosphere and ionosphere over the magnetic
equator that passes over Thiruvananthapuram near Thumba using small
sounding rockets. Realising the immense potential of space technology for
national development, Dr. Vikram Sarabhai, the visionary leader envisioned
that this powerful technology could play a meaningful role in national
development and solving the common problems of man. Thus, Indian
Space programme born in the church beginning, space activities in the
country, concentrated on achieving self reliance and developing capability
to build and launch communication satellites for broadcast television,
telecommunications and meteorological applications; sensing remote

satellites for management of natural resources.
Now let us make the following changes in the document:
(i)
In the first line, the word country should appear before the word started.
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(ii)
In the third line it should be Thumba near Thiruvananthapuram instead of
Thiruvananthapuram near Thumba
(iii)
In the 7th line it should be problems of common man instead of common problems of
man.
(iv)
In the 10th line it should be television broadcast instead of broadcast television.
(v)
In the 11th line it should be remote sensing instead of sensing remote.
To make these changes do the following steps:
(i)
In the first line select the word country by double clicking at it. The selected word is
marked by a translucent box as shown below in figure :

Figure 1.18: Selecting a word

(ii)
(iii)

Now click at the cut icon in the format bar. Alternatively, you can use corresponding
keyboard shortcut Ctrl+X. You will observe that the selected word country get deleted.
Actually this word has been removed from here and has been copied to the clipboard.
Now click at the beginning of the word started (where you want to put the word country)
and click at paste icon (or use the keyboard shortcut Ctrl+V). You will observe that the
word country appears before the word started.

So, you have made the desired change in the first line using cut and paste options.
Similarly, you can make the other changes in this document.
Cut and paste work not only with single words but with any part (multiple consecutive words,
sentences, paragraphs) of the document.
There are two other methods to select a part of the text. These methods are given below:
(i) Drag the mouse over the part which you want to select. That part gets selected.
(ii) Click at the beginning of the text from where you want to start the selection. Then take
the mouse pointer to the end of the portion of the text to be selected. Now press Shift
key on the keyboard and click the mouse while keeping the Shift key pressed. The
desired portion gets selected.
Now try copying the text instead of cutting it. For this select any part of the text and click at
Copy icon or press the corresponding keyboard shortcut Ctrl+C. Nothing noticeable happens
when we copy the text, but the copied part gets copied to the Clipboard. Now if we take the
cursor to any other part of the document and click at paste (or press Ctrl+V) the copied part
gets pasted at the current position. Observe the difference between Cut-Paste and Copy-Paste.
Find and Replace:
The documents that we create in a word processor are not always small paragraphs of a few
sentences. Most of the times these are multi-page documents. Study notes are a good example
of such documents. Suppose we have created Social Science notes using Writer. We take printout of these notes for studying. When we go through these notes we find that at some places in
the document the word Delhi has been misspelled as Dlehi. Now to correct it we have to go
each specific location in the document where correction is to be made. For this, Find and
Replace feature of Writer is very easy to use. This feature is available through the Find and
Replace option in Edit menu of Menu Bar (the corresponding keyboard shortcut is Ctrl+F). When
you click it, Writer opens a Find and Replace dialog box as shown below in figure:
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Figure 1.19: Find and Replace

In the Find and Replace dialog box we observe the following components:
(i)
Search For – Here we enter the text that is to be searched for or replaced. For example,
in our case we shall enter Dlehi.
(ii)
Replace with: Here we enter the new text that will replace the existing text. For
example, in our case we shall enter Delhi.
(iii)
Match case: We select this checkbox if we want Writer to differentiate between Capital
and Small letters of alphabet while searching for the word. In our case, we can check it
or leave it unchecked, it will not make any difference.
(iv)
Whole words only: We select this checkbox if we want Writer to treat the text to be
searched for as a single word only and not as the part of a word.
(v)
Find button: We click this button after entering the search string when we want Writer
to search for the word. When we click this button, Writer searches the document for the
first occurrence of the Search for text. If the text is found, Writer selects that text in
the document, otherwise it shows a dialog box displaying the message “Search key not
found”.
(vi)
Find All button: We click this button if we want Writer to simultaneously find all the
occurrences of the Search for text. When this button is clicked, all the occurrences of
the given text are selected at once.
(vii)
Replace: We click this button if we not only want to search for the text in the document
but we also want to replace it with the text given in Replace with box. When we click
this button, first occurrence of the Search for text is replace with the Replace with text.
(viii)
Replace All: We click this button if we want to replace all the occurrences of the Search
for text with Replace with text as in our case where we want to replace all the
occurrences of Dlehi with Delhi.
Spell Check
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While typing in Writer you must have noticed that some of the words are automatically
underlined with a red wavy line. These are the misspelled words in our document. Writer has an
inbuilt dictionary. While we type in text, Writer checks each word whether it exists in
dictionary or not. If it does not appear in its dictionary, it is considered a misspelled word and
Writer marks it by underlining it with a red wavy line. That is why, almost all the names that we
type in our documents are marked as misspelled words.
Once we have typed the text, we can take the help of Writer to correct the spellings of
misspelled words. There are two ways to do it:
(i)

Right click at the misspelled word. It opens a pop-up menu that shows a list of words that
are close to the misspelled word. We can select the desired word from this menu.
Misspelled word will be automatically replaced by the correct word that we chose from
the list.

Figure 1.20: Pop-up menu for spelling correction

If we find that the word that we typed is correct and Writer should ignore it (this may be
in the case of persons’ names), we can click at Ignore option in this menu. If you want
Writer to ignore all the occurrences of that specific word, click at the option Ignore All.
For example, if we misspell the word Computer as Compter in a document, we can right
click it to correct it as shown in the figure:
(ii)

We can click at the Spelling and Grammar button, to open the Spelling window as shown
in the following figure. In this window we are shown all the misspelled words in the
document one-by-one and a list of corresponding suggested words for each word. By
clicking at the suitable options and buttons we can correct all the spelling mistakes.
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Figure 1.21: Spelling and Grammar window

Adding words to dictionary
It is also possible to add words in the Writer’s dictionary. Writer’s dictionary checks the
spellings according to American English, but in India we follow British English. For example,
according to British English, the word colour is correct but according to American English, the
correct spellings are color. When Writer suggests color as the correct word where we have
typed colour, we can click at the Add button so that the word colour gets added to Writer’s
dictionary and next time it is not reported as the misspelled word. This can be done for persons’
names also.
Turning off Auto Spellcheck
If we do not want Writer to keep checking the spellings of each word, we can turn the spellcheck option off by deselecting the AutoSpellcheck button on the standard tool bar as shown
below. But it is always recommended that we keep AutoSpellcheck option on.

Figure 1.22: Spelling and Grammar and Auto Spellcheck buttons

Using AutoCorrect
Try typing the sentence “ thsi shcool is similiar ot taht colege ” as it is. We observe that
Writer automatically converts it to “ this school is similar ot that colege “. Writer has
automatically corrected the spelling mistakes in many words. But a few words have not been
corrected. ot has not been corrected to to and colege has not been corrected to college.
Writer has a list of most commonly misspelled words and corresponding correct words.
Whenever it find a misspelled word, it checks it in its list of misspelled words. If the misspelled
word is found there, it is replaced by the correct word in the document. We can add more
words to this list. Suppose we want Writer to automatically correct colege to college, we can
add this word to the AutoCorrect list of Writer. After that whenever we type colege in any
document, Writer will automatically correct it to college. This can be done for any number of
words. To make an entry into the AutoCorrect list select the option Tools à AutoCorrect
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options. This opens the Autocorrect window. In the Replace box we enter the misspelled word
(colege in our example) and in the With box we enter the correctly spelled word (college in our
example). After this we click at the New button and the word gets entered into the list.

Figure 1.23: AutoCorrect window

Undo and Redo
Editing a document involves a lot of operations like changing font (name, size, colour), making
text bold, italic, or underlined, correcting spellings, changing margins and indents etc. Many
times after making a change we realize that the change should have not been made. Writer
provides us facility to cancel a sequence of previous changes made to the document. Many times
it also happens that after cancelling the change we realize that the change should have not
been cancelled. Writer provides us facility to again make the changes that we just cancelled.
Cancelling a change in a document is called Undo (Un-do) and making a change again after
cancelling it is called Redo (Re-do). Any time we feel like cancelling a change we can click at
the Undo button on the standard toolbar. Alternatively we can press the corresponding
keyboard shortcut Ctrl+Z.

Figure 1.24: Undo and Redo buttons

To again do the cancelled operations we can click at the Redo button.
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SNo
1.
2.
3.
4.
5.
6.
7.

Opearion
Cut
Copy
Paste
Find and Replace
Spelling and Grammar
Undo
Redo

Keyboard Shortcut
Ctrl+X
Ctrl+C
Ctrl+V
Ctrl+F
F7
Ctrl+Z
Ctrl+Y

Summary
·
·
·
·
·
·
·
·
·

Editing a document means to make desired changes in the document.
Cut-Paste and Copy-Paste are two powerful tools to move/copy a portion of document
from one location to another.
When we cut or copy a portion of a document, that portion gets copied to Clipboard.
Using Spellcheck feature writer can automatically find misspelled words in a document.
A word processor has an inbuilt dictionary using which we can correct the spelling
mistakes in our documents.
We can add more words to the word processor’s dictionary.
AutoCorrect feature of a word processor automatically corrects the misspelled words.
Using Undo we can cancel the recent operations.
Using Redo we can again do the cancelled operations.

Self Assessment
S.No.
1.
2.
3.
4.
5.
6.

I am able to…
Use cut/copy and paste features of a word processor.
Use the find and replace option of a word processor.
Correct the misspelled words using the Spellcheck features of a word
processor.
Add more words to dictionary.
Turn off the Auto Spellcheck.
Use keyboard shortcuts for cut, copy, paste, unto, redo.

Yes

No

_________________________________________Now I can answer …
1.
2.
3.
4.
5.

Define Editing.
Differentiate between cut and copy features of a word processor.
Which feature of a word processor is used to replace a word with another word in the whole
document?
How can we add more words to a word processor’s dictionary?
Describe AutoCorrect feature of a word processor.
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So far we have learnt some very useful formatting and editing features of a word processor. Let
us now learn about some more advanced formatting options.
Bullets and Numbering:
Many times we need to create some lists in our documents. Some examples can be seen in this
chapter itself. In the beginning of this chapter there is a list of Learning Objectives. In this list
each item is preceded by a bullet symbol ( )Such a list is called a bulleted list. Writer provides
many alternate shapes of the bullets like , , , , ,
and many more.
There are many lists in which each item is preceded by a number. In this chapter there are
many such lists in which some procedure is explained through steps and each step is preceded
by a serial number in small roman numbers. Such a list is called a numbered list. Writer provides
many alternate styles of numbering the items of a numbered list like 1), 1., (1), A), a), (a), i),
(i) and many more.
It is very easy to create a list in Writer. To create a list, simply keep on entering the list items.
After entering the items select all these items and click at Numbering on/off button to create a
numbered list. To create a bulleted list click at bullets on/off button. An example is shown in
the following figure. In this example we see two lists – first is the numbered list of four
elements (numbered 1, 2, 3, 4) and the second is a bulleted list with same elements as in the
numbered list. You can also try the same:

Figure 1.25: Numbered and Bulleted lists

Header and Footer:
When a multi-page document is created, it is generally required that each page of the
document is numbered and the page number should appear at a fixed place at the top or
bottom of the page. Many times it is also required to add some more text like chapter number
or name, name of the organization to which the document belongs etc. This type of text should
also be placed at the beginning or at the end of each page and at the same location of each
page. This type of text can be put in Header (above the top margin of the page) and/or in the
footer (below the bottom margin of the page). To add a header to a page, choose [1]Insert
à[2]Header à[3]default from the menu bar.
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Figure 1.26: Insert Header

Doing this inserts Header in the current page and places the cursor in the header. Header is
marked by a boundary above the top margin of the page. Size of header can be changed using
the Rulers. We can type any text in the header. Whatever we enter in the header area of a page
appears as the header of every page of the document.
Adding Page Number, Date, and Time:
Writer also provides facility to automatically enter certain fields like Page Number, Total
Number of pages etc. This facility is available through the option [1]Insert à[2]Fields option
from Menu Bar. Choosing the option [1]Insert à[2]Fields opens another menu from which we
can choose the relevant fields to insert.

Figure 1.27: Insert Fields in Header/Footer

As we insert header and put text and fields in it, similarly we can insert footer and insert fields
in it. There is no difference between header and footer except that header appears at the top
and footer appears at the bottom of the page.
Page and Paragraph border:
In Writer we can put border around each page or around some paragraph of the document. Page
Border is around the whole page whereas paragraph border is around a specific part of the
document. Borders are usually put for two reasons:
(i)
(ii)

To improve the general look of the document.
To emphasise some part of the document.
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To insert page borders we select the option [1]Format à[2]Page from the Menu Bar. This opens
the Page Style window that we have already seen. In the Page Style Window, we open the
Borders tab and get the following window:

Figure 1.28: Setting Page Style

Let us understand functions of different parts of this window:
1. Default (Line arrangement): By default there are no page borders. The five small
buttons in this option allow us to select the type of page border:
a. The first button is for default page border (i.e. no page border)
b. Second button is for page borders along all the four sides of the page
c. Third button is for page borders along the page length only (left and right)
d. Fourth button is for page borders along width of the page only (top and bottom)
e. Fifth button is for page border along the left side of the page only.
2. Style: Here we can choose the thickness of the border.
3. Spacing to contents: Here we can set the space to be left blank between the border and
the contents of the page.
4. Color: Here we can choose the color of the border.
5. Position: Here we can choose the style of border shadow. By default there is no border
shadow.
6. Distance: Here we set the distance between the border and its shadow.
7. Color: Here we can choose the color of the border shadow.
Similar to page border, we can insert paragraph border also. To insert a paragraph border, click
anywhere inside the paragraph and select the option [1]Format à[2]Paragraph from the Menu
Bar. This opens the Paragraph window that we have already seen. In the Paragraph window, we
open the Borders tab to get the paragraph border options exactly same as page border options
that we saw above. Through this window we can set the paragraph border.
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Figure 1.28: Page and Paragraph borders

Inserting Page Breaks:
In Writer, every document is segmented into pages. At the end of every page Writer
automatically inserts an invisible marker called the page break. Sometimes it also happens that
a page is not filled but we want to start a new page. An example of such a case is that when a
chapter ends we wish to start new chapter from the new page. This is irrespective of whether
the current chapter finishes at the end of a page or at the middle of a page. Writer allows us to
put a page break anywhere in a page and a new page starts after the page break. The breaks
that we put manually are called manual breaks. To insert a manual page break select the
option [1]Insert à[2]Manual Break from the Menu Bar. It opens Insert Break window as shown
below:

Figure 1.29: Insert Page break

In the Insert Break window select Page Break option and click OK button. Alternately, we can
press the corresponding keyboard shortcut Ctrl+Enter. Manual page breaks have been entered at
the end of each element while creating this unit also.
Columns:
You must have seen columns in newspapers and magazines. Columns are vertical blocks of text
that are separated by blank spaces or lines as shown in the following figure:
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Figure 1.30: Columns

In the first image the text on the page has been divided into two columns and in the second
image it is divided into three columns. In Writer we can divide our documents into columns. This
may be needed to prepare some assignments or notes.
To divide a page into columns we select the option [1]Format à[2]Columns from the main
menu. This opens the Columns window as shown below:

Figure 1.31: Dividing a page into columns

Now page columns can be set by choosing the suitable options from Columns window. The
options which are available are:
(i)
Number of columns
(ii)
Spacing (distance between consecutive columns)
(iii)
Autowidth (Whether we want Writer to set width of each column or we want to specify
the width of each column)
(iv)
Separator Line (If we want a separator line between consecutive columns)
Entering text in columns:
When a page is divided into columns, text is entered in the left most column. When the left
most column is filled, the cursor automatically moves to the next column. Writer does not allow
us to leave a column half-filled and start entering text in the next column. But sometimes we
need to do so. In such cases we can insert column break in a column and can move to the next
column without completely filling the current column. Column breaks are entered in the same
way as we entered page breaks. The only difference is that we have to choose the option
Column break instead of Page break from the Insert Breaks window.
Keyboard Shorcuts:
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SNo Operation
Keyboard Shortcut
1.
Insert Page break Ctrl+Enter

Summary
·
·
·
·
·
·
·

We can create bulleted and/or numbered lists in our documents.
Header and Footer, if inserted, appear on every page of the document.
Header/Footer may include some fixed text and/or variable fields which include Page
Number, Date, and Time.
Borders can be put around pages and/or paragraphs in a document.
The word processor inserts a page break at the end of each page. Page breaks can be
inserted manually also at the desired locations in a document.
Pages of a document can be divided in columns also.
In a word processor we can simultaneously work on multiple documents.

Self Assessment
S.No.
1.
2.
3.
4.
5.
6.

I am able to…
Create bulleted and numbered lists in my documents.
Insert header and footer in my documents.
Insert fields like page number, date, time in my documents.
Insert manual page breaks.
Divide my document into columns wherever suitable/required.
Simultaneously use multiple documents wherever required.

Yes

_________________________________________Now I can answer …
1.
2.
3.
4.
5.

What is the difference between bulleted list and numbered list?
What is the difference between header and footer?
What is the difference between page border and paragraph border?
Where do we insert manual page breaks in a document?
How are multiple columns separated from each other in a document?
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ELEMENT 4 –WORKING ON MULTIPLE DOCUMENTS
In practical situations there are many occasions when working on a document we want to refer
to another document. Sometimes we also want to copy the text from one document into
another. For example while creating this document I am working with the following documents
simultaneously:
(i)

The current document

(ii)

The document in which I store all the figures used in this lesson

(iii)

The document containing the guidelines for lesson development

Writer allows us to simultaneously open multiple documents and work on them. We can very
easily navigate from one document into another, cut/copy text from a document and paste it in
some other document and so on.
Let us assume that we are working on a document “Careers in Indian Armed Forces”. While
working on this document we have to refer to some other documents “Indian Air Force”, “Indian
Army”, and “Indian Navy” which we have already created. Now, while keeping “Careers in
Indian Armed Forces” open we choose the option [1]File à[2]Open from the Menu Bar. This
opens the Open window and we can select the files which we want to open. The names of all
the open Documents are displayed in the Taskbar as shown below:

Figure 1.32: Multiple document icons on the task bar

Now whichever filename we click in the taskbar, the corresponding documents becomes the
active document. Clipboard is common to all the open documents. Therefore, we can cut/copy
from one document and paste it in another document.
There is another way of switching between several documents. If we click at the Window option
of Manu Bar, we find a list of all the open documents. The currently active document’s name is
marked by the symbol
document.

. If we click at any other file name, that document becomes the active

Figure 1.33: Navigating between multiple documents

Summary
·
·
·

Writer allows us to simultaneously open and work on multiple documents.
We can cut/copy parts of one document and paste in the other.
We can navigate among the documents using taskbar or the window option of Menu bar.
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Self Assessment
S.No.
1.
2.
3.

I am able to…
Yes No
Simultaneously open multiple documents in Writer?
Cut/Copy parts of one document and paste in the other?
Navigate among various open documents?

_________________________________________Now I can answer …
1.

How to navigate among various open documents in Writer?

ELEMENT 5 – CREATE AND WORK WITH TABLES
In Writer we can create tables in our documents. A table is a grid of rows and columns. There
are many documents in which information is represented in tabular form. Following are two
such examples:
Schedule for Extra Classes
8-9
Tue

9-10

10:30–11:30 11:30-12:30

Maths

Science

Hindi

Hindi

-

Science

Science

Maths

Hindi

Wed Maths Science
Thu

Maths

Hindi

Fri

Maths Science

Table 2.1

Students’ Activity List
Name of the Student House Activity
Tushar

Kirti

Dance

Upasana

Kirti

Dance

Anirudh

Shakti Debate
Table 2.2

In both these examples, text appears in tabular form. There are many other examples where we
prefer to organize the data in tabular form. Writer provides facility to work with tables.

Inserting a table:
Writer offers following two ways to insert tables in a documents:
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(i)
from Menu bar: Choose the option [1]Insert à[2]Table from the Menu Bar. This opens
Insert Table window. In this window we can select the name of the table, size (number
of rows and number of columns) of the table and a few more options. After this when we
click at OK button, Writer inserts a table according to our specifications.

Figure 1.34: Inserting Table

(i)

from Standard toolbar: On the Standard toolbar, click the arrow next to the Table icon
and in the table grid, drag to select the numbers of rows and columns that you want, and
then release.

Figure 1.35: Inserting Table from Standard toolbar

Work on a table:
Entering data in a table is just one work that we do on tables. There are many other works that
can be performed on a table. The most common of these works are: (i) to set the borders of
entire table or individual cells, (ii) to merge or split cells, and (iii) to insert/delete
columns/rows in the table. To perform these works Writer provides a Table tool bar which
appears as soon as we click in any cell of a table.
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Figure 1.36: Table toolbar

Through this tool bar we can do any work on the table. Different tools available on this tool bar
are:
1) Insert Table: To insert a table within a cell of current table.
2) Line: To set the line thickness of the cell border or table border.
3) Line Colour: To set the line colour of the border of current cell or entire table.
4) Borders: To set the borders around the cells or the whole table.
5) Backgound Colour: To set the background colour of the current cell or the whole table.
6) Merge Cells: To combine multiple consecutive cells into a single cell.
7) Split Cell: To split a cell into multiple cells.
8) Optimize:
9) Top Alignment: For vertically aligning the contents of a cell or the whole table to the top
of cell(s).
10) Centre Alignment: For vertically aligning the contents of a cell or the whole table to the
centre of cell(s).
11) Bottom Alignment: For vertically aligning the contents of a cell or the whole table to the
bottom of cell(s).
12) Insert Row: To insert a new row below the current row
13) Insert Column: To insert a new column to the right of current column.
14) Delete Row: To delete the current row
15) Delete Column: To delete the current column
16) Auto Format: Writer has a set of predefined formats for tables. Using AutoFormat we can
format our table according to any of these predefined formats.
17) Table Properties: To set the general properties of current table.
18) Sort: To arrange the table items in ascending or descending order.
19) Sum: To find the sum of items in a row/column.
Let us now learn these concepts by creating the two tables given above.
To create Tabel 2.1, perform the following steps:
(i)
Insert a table with 5 rows and 6 columns using either of the two ways mentioned above.
Writer places an empty table in the document as shown below:

(ii)

Now start entering the text in different cells of the table. To move from one cell to the
next press the tab key. We can also use mouse to move to any cell of the table. After the
text is entered in all the cells, the table should look as follows:
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We observe that the table is not in the desired format of table 2.1. Observe the following
differences:
a. The first row should have only one long column and not five columns as shown in
this table. Also the text in the first row should be center aligned and should be
bold.
b. In the third row the subject name Maths should spread over two consecutive
columns.
c. The text in all the cells of the table should be center aligned.
d. Column widths should be smaller. Each column should be wide enough just to
accommodate the text in it.
To make the above changes we perform the following steps:
a. Select the first row by drag the mouse over all the columns (first to last OR last to
first) of this row. Then click the Merge cells button of the Table toolbar.
b. Click at the Centre Align button of Format toolbar. Then click at Bold button. Now
the first row looks as follows:
c. Similarly we can merge and centre aligns column numbers 3 and 4 of the 3rd row.
d. Now take the mouse pointer to the left of first column of first row. The mouse
pointer changes to and we see a message Select Table Row. When this happened,
click the mouse pointer and drag it down so that all the rows get selected. Now
click at Center Align button of of Format toolbar. This aligns all the contents of the
entire table to center.
e. Take the mouse pointer over the column dividing line until the pointer becomes a
separator icon
. Now we can drag the mouse pointer to the Left or Right to
adjust column width of two adjacent columns. This process can be repeated to
adjust the width of all the columns to finally obtain the table as given.

(iv)

Keyboard shortcuts for resizing table:
SNo
1.
2.
3.
4.

Operation
Increase column width
Decrease column width
Increase row height
Decrease row height

Keyboard Shortcut
Alt+Right Arrow
Alt+Left Arrow
Alt+Down Arrow
Alt+Up Arrow

Now we can create the Table 2.2 also. This can be done as a practice exercise. You should also
try to create other tables like time table, list of students also.

Summary
·
·

Writer allows us to create and manage tables so that text, numbers, images, etc. can be
presented in a more organized manner in a document.
We can insert a table in your document by choosing the option [1]Insertà [2] Table from
the Menu Bar.
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· We can also insert the table in your document by clicking the arrow next to the Table
icon and in the table grid dragging the icon to select the numbers of rows and columns
and then releasing it.
· Various operations which can be performed on tables are available through Table toolbar.
· A table’s row and column sizes can be changed as per the requirements.

Self Assessment
S.No.
4.
5.
6.
7.
8.
9.

I am able to…
Yes No
Insert a table with specified number of rows and columns?
Merge different cells of a table?
Apply different formatting to different cell elements?
Apply specified border settings for cells / table?
Add rows / columns in a table?
Delete rows / columns from a table?

_________________________________________Now I can answer …
2.
3.
4.
5.

What is a table?
What are the two ways of inserting a table in a document?
Name and explain any five options available on Table toolbar.
What are the keyboard shortcuts to adjust row and column sizes of a table?

-37-

NVEQ Level 1

ITCC-102

ELEMENT 6 – WORKING WITH IMAGES, DRAWINGS, AND GALLERY OBJECTS
Have you ever noticed that most of
the real life documents contain not
only the text but some pictures /
images / photographs / diagrams
also. Writer allows us to do all that.
We shall learn this concept with the
help of a few examples.

Terms to know
Image: Any picture (scanned, taken with a camera,
downloaded from the internet) is called an image.
Diagram: Any geometric figure created with the help of
basic geometric shapes like point, line, curve etc. is called a
diagram.
Gallery Object: Writer has a vast collection of predefined
images and diagrams. This collection is called Gallery and an
object is this gallery is called a Gallery Object.

Inserting an Image: Suppose we want to create the following document

Figure 1.37: A document with an Image

This document contains a picture and some text. To create this document we should first have
the picture stored in some specific folder. This can be done by scanning the picture, copying the
picture from the camera, or by downloading it from the internet. After this we start a new
document in Writer and go to the option [1]Insert à[2]Picture à[3]From File in the Menu Bar.
This opens the Insert picture window as shown in the following figure:
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Figure 1.38: Inserting an Image

From this window we select the desired image from the folder where we stored it. This inserts
the image in the document. Now we click below the picture and start typing the text. Now our
document is ready. We can save it.
It may happen (and it generally happens) that the image is not of the desired size and not at the
desired position in the document. If it is so, we have to resize the image and place it at the
desired location.
Resizing an Image:
1. To resize an image, first select it by clicking on it. We then see eight handles around the
image. Using any of these handles we can resize the image. When you drag one of the
four corner handles, the opposite corner remains fixed while the other three corners
move. When we drag one of the side handles, the opposite side remains fixed.
2. To resize an object using the keyboard, first select the object, then press Ctrl+Tab
repeatedly to highlight one of the handles. Now image can be resized using the arrow
keys. Then resize the image use the arrow keys. To resize in smaller steps, hold down the
Alt key while pressing an arrow key.
Relocating an Image:
To change the position of an image in the document, first select it by clicking on it. Then by
using the mouse we can drag it and drop it at the desired location in the document. But doing so
may create another problem. The image may not be in symmetry with the text. To solve this
problem we have to choose correct option to wrap the text around the image.
Wrapping Text around Images
To wrap text around an object, you need to first select the object. Then choose [1]Format
à[2]Wrap, and then choose the wrapping style (square, tight, through, top and bottom, behind
-39-

NVEQ Level 1
ITCC-102
text, in front of text, in line with text) that you want to apply. The current wrapping style is
indicated by a bullet.
Writer offers many other options which can be applied on images. The most convenient way to
know and work with these options is the Picture tool bar.

Figure 1.39: Picture toolbar

This tool bar is visible whenever an image is selected. We can apply all the options mentioned
here one by one on any picture.

Inserting a Diagram:
We can also insert geometric shapes in our documents. For this Writer provides facility to insert
shapes like line, circle, rectangle etc. in our documents. This facility is available through
Drawing toolbar. This toolbar is activated by selecting [1]View à[2]Toolbars à[3]Drawing
from Menu Bar.

Figure 1.40: Drawing toolbar

From this toolbar we can pick any shape and draw it in the document. For example, the following figure has
been created using line, circle, and rectangle tools.

Figure 1.41: Drawing created from basic shapes

Inserting Objects from the Gallery
Writer also has a Gallery of predefined objects. These objects can be directly inserted into
documents in the following ways:
1. Open the Gallery by clicking the Gallery icon on the Standard bar, OR by selecting
[1]Tools à[2]Gallery from the Manu bar.
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2. Select a theme (From the left hand side menu of the gallery).
3. Select an object using a single click.
4. The selected object can now be used in the following ways:
a) Copy the object into the document: Drag the object into the document, or rightclick to open the context menu and select Insert and Copy.
b) Insert the object as a background graphic: Open the context menu and choose
[1]Insert à[2]Background à[3]Page or Paragraph.
c) Insert the object as a texture (pattern) for another object: Drag the object on to
the other object in the document while pressing Ctrl.

Layers for text and graphics
Each object that we place in our document is successively placed on the preceding object. We
can use the arrange commands to change the stacking order of objects in your document.
Stacking order of text cannot be changed. Stacking order of an object is changed by right
clicking at the object and choosing Arrange option from the pop-up menu. This gives us the
following options:
1. Bring to Front: Moves the selected object to the top of the stacking order, so that it is in
front of other objects.
2. Bring Forward: Moves the selected object up one level, so that it is closer to top of the
stacking order.
3. Send Backward: Moves the selected object down one level, so that it is closer to the
bottom of the stacking order.
4. Send to Back: Moves the selected object to the bottom of the stacking order, so that it is
behind the other objects.
5. To Foreground: Moves the selected object in front of text.
6. To Background: Moves the selected object behind text.

Summary
·
·
·
·
·
·
·

Writer allows us to insert images in a document.
Writer provides various Geometric and other commonly used shapes through the Drawing
tool bar.
Writer also allows us to create diagrams using basic geometric shapes.
Writer provides many images through its gallery. These images can be directly inserted
into a document.
Images, diagrams, and gallery objects can be placed anywhere in a document.
Images, diagrams, and gallery objects can be resized and layered one above the other as
per the requirements.
Various operations which can be performed on images, diagrams, and gallery objects are
available through Picture tool bar.

Self Assessment
S.No.
1.
2.
3.
4.
5.

I am able to…
Yes No
Insert an image in a document.
Resize images.
Apply specified text wrap.
Set the colour and transparency of an image.
Open Drawings tool bar.
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6.
7.
8.

Insert objects from Drawing tool bar.
Relocate an image.
Insert objects from Gallery.

_________________________________________Now I can answer …
1.
2.
3.
4.
5.

Define (i) image, (ii) diagram.
How do we resize an image in a document?
Explain any 4 options available in Picture toolbar.
Name any 5 shapes available in Drawing toolbar.
What is the difference between Bring to Front and Bring Forward?
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You can rise upto
Explore contributions of "Richard Stallman" & "Bill Gates"

Assessment
Multiple Choice Questions
1.

A word processor is used to
A. Create Documents
B. Play Games
C. Remove Virus
D. Set the printer

2.

Writer documents are saved with the extension
A. .doc
B. .odt
C. .jpg
D. .exe

3.

Font color option is available in
A. Standard tool bar
B. Format tool bar
C. Picture tool bar
D. Font tool bar

4.

Keyboard shortcut to underline the selected text is
A. Ctrl + N
B. Alt + N
C. Alt + U
D. Ctrl + U

5.

Keyboard shortcut to italicise the selected text is
A. Ctrl + I
B. Alt + I
C. Alt + E
D. Ctrl + E

6.

When we double click on a word,
A. The word gets copied
B. The word gets deleted
C. The word gets selected
D. None of the above

7.

Rajmeet works as an office assistant and he has to frequently draft letters to be sent to
government offices. Such letters follow the same text patterns with minor changes like
name, address, and designation. To make his job easy, Rajmeet should
A. Write the exact pattern of the letters and should follow this pattern everytime he
needs.
B. Ignore the pattern and everytime he should create the letters in a new pattern.
C. Create a template and use it.
D. None of the above

8.

In Writer, new templates are created using
A. Wizard
B. Font Size
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9.

When some text is Cut or Copied, it goes to
A. A new document
B. The end of the document
C. The clipboard
D. The top of the document

10.

Writer marks the misspelled words by
A. Underlining them with a red wavy line
B. Underlining them with green wavy lines
C. Encircling them
D. Selecting them.

11.

Poonam has created a document and now she wants to perform spelling checking and
correction on the whole document, she should use
A. Auto SpellCheck option
B. Spelling and Grammar option
C. Find and Replace option
D. None of these

12.

Which of the following words can be added to Writer’s dictionary?
A. Only the correctly spelled words.
B. Only incorrectly spelled words
C. Only those words which exist in a standard dictionary
D. Any word.

13.

Header and Footer are
A. Compulsory in every document
B. Can be placed anywhere in a document
C. Can contain page number only
D. None of these

14.

Border colour of a page
A. Can be black only
B. Cannot be changed
C. Can be changed
D. Is same as the text colour

15.

Inserting a Page Break
A. Breaks the page into two parts
B. Starts a new paragraph
C. Starts a new page
D. Marks the end of the document

16.

Text in a document
A. Cannot be divided into columns
B. Can be divided into two columns only
C. Must be divided into two columns only
D. Can be divided into any number of columns

17.

Different cells of a table
A. Can have different background colours
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B. Must have the same background colour
C. Cannot have any background colour
D. Must have different background colours
18.

In a table only those cells can be merged which are
A. Consecutive
B. Not consecutive
C. Placed diagonally
D. Of the same size

19.

Which of the following images can be inserted in a document?
A. Image of a specific size only
B. Images of politicians only
C. Photographs only
D. Any image

20.

An image in a document
A. Can be resized
B. Cannot be resized
C. Should be resized
D. Should not be resized

ITCC-102

Fill in the blanks
1.

A __________ is a software used for creating, editing, formatting, and printing any type
of printable material.

2.
3.
4.

OpenOffice Writer is a part of software package ___________.

5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.

OpenOffice Writer saves the documents in Open Document format with extension _____.
Using ___________ we can view how the printout of our document will look before
actually taking the printout
Margins are set for the _________ whereas _________ may be set for individual
paragraphs or for the whole document
Page orientation can be _________ or ___________.
Any number of similar documents can be created based on the same _________.
Distance between two consecutive lines is called ___________.
___________ is the distance between two consecutive paragraphs.
Making changes in documents is called ___________.
When we cut or copy a portion of a document, that portion gets copied to ________.
____________ feature writer can automatically find misspelled words in a document.
____________ feature of a word processor automatically corrects the misspelled words.
Using _________ we can cancel the recent operations.
Using _________ we can again do the cancelled operations.
In a ___________ list, each list item is preceded by a bullet.
____________ appears at the top of every page of a document.
The word processor inserts a _________ at the end of each page.
A table is a grid of _______ and ___________.
Various operations which can be performed on tables are available through ______
toolbar.
We can create ________ using basic geometric shapes.
Various operations which can be performed on images, diagrams, and gallery objects are
available through _______ tool bar.
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Questions with short answers
1. Ms. Neetika is a school teacher and she prepares her hand-written notes and question
papers. Now she wants to prepare these notes and question papers on the computer.
What kind of software should she use?
2. Bala Thakur is a student of class IX and she wants to download latest version of the
software OpenOffice.Org. From which site can she download this?
3. Rajneesh is your friend and he does not remember the keyboard shortcuts for Bold,
Italics, and Underline. Tell him a simple way to remember these shortcuts.
4. Ramesh is an office assistant in an office. He often has to type some official letters.
These letters have to be written following the same pattern every time. But Ramesh does
not exactly remember the format and every time he gets scolded by his boss for this. Can
you suggest him a method so that he does not have to remember the format but every
time the letters are prepared with correct format?
5. Madhur has practical exam in word processing today. He does not remember the
difference between Margins and Indents. Please help him by telling him the difference.
6. Sonali has prepared a document which is to be printed. What should she do so that the
document is printed widthwise?
7. Ravish has prepared a document in which some words are underlined by red wavy lines.
He does not understand why it is so and therefore he is not able to remove these wavy
lines. Explain him the reason and solution of this problem.
8. Suppose you have prepared a document of a few pages and now you want to increase the
gap between lines of this document. How can you achieve this?
9. Raveena has prepared a document in which the name of an officer appears as Rajesh at
many places. Now she wants to change this name to Mr. Rajesh Madaan every where in
the document. Suggest her an easy way to do this.
10. Utkarsh, a script writer, has prepared a script using Writer. All the names of this script
are marked as misspelled words by Writer. Utkarsh wants to add all these names to the
dictionary so that next time these names are not marked as misspelled words. How can
he do so?
11. Richa Bhardwaj, a school teacher, has prepared study notes for her students. Now she
wants to put page number at the bottom of each page. How ca she do so?
12. You are given the job of preparing a list of books to be purchased. For each book the
details to be included are S.No., Title, and Cost of the book. Which feature(s) of word
processor will you use to prepare this list? Justify your answer.
13. Raj Kumar Pal, head of an IT company, has 3 reports submitted by his subordinates. He
wants to prepare a summary which combines information from all the three reports. Is it
possible to open all these three documents and another document (summary)
simultaneously? Is it possible to copy information from any of these three documents into
summary?
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14. Ramesh inserted a picture of a tiger in his document. The picture is very large in size and
Ramesh does not know how to reduce the picture size. Tell him the method to do so.
15. Renu wants to draw a diagram using basic geometric shapes into her document. How can
she do so?

Case based problems
1. Create the following document according to the given specifications:

S.No. Segment
1.
General
2.
Line 1
3.
4.
5.

Format Specifications
Margin – All 1”
Font – Name: Arial, Colour: Blue, Size: 18
Alignment – Center
Para 1
Font – Name: Arial, Colour: Black, Size: 12
Alignment – Left
Line spacing: 1.5
Para 2
Font – Name: Arial, Colour: Black, Size: 12
Alignment – Left
Line spacing: 1.5
Para 3, Para 4, Para 5 Font – Name: Arial, Colour: Black, Size: 12
Alignment – Justify
Line spacing: Single
Indents – Left 0.5”, Right 0.5”
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2. Create the following document by using suitable formatting options:

3. Create the following document by using suitable formatting options:

Suggested Reading
Reference books (3-5)
·

OpenOffice.org Writer, (Book/CD-Rom)
by Jean Hollis Weber
Shroff/O'Reilly (Reduced Price)

Websites
·
·

·

http://www.tutorialsforopenoffice.org/tutorial/First_Time_User_OpenOffice_Writer.html
http://www.openoffice.org/documentation/manuals/userguide3/0200WG3-WriterGuide.pdf
http://linux.about.com/od/linux101/a/desktop10b.htm
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EMAIL MESSAGING
Pre-requisite: Unit I Level I
Element
No.

Element Name

Total
Hours

1

Composing Email and Attaching Files

30

2

Sending, Forwarding and Receiving Emails

3

Organizing Emails and Managing Contacts

4

Scheduling Appointments Using Online Calendar Services

5

Email Etiquettes and Best Practices

Ignite Mind
"The real art of conversation is not only to say the right thing in the right place
but to leave unsaid the wrong thing at the tempting moment"

Dorothy Nevill

Learning Objectives
After studying this unit the students will attain competencies to:
·
·
·
·
·

Compose an email and attach Files
Send, Forward and Receive Emails
Organize emails and manage contacts
Schedule appointments using online calendar services
Adopt best practices and etiquettes for emails

Introduction
Information and Technology (IT) tools, such as Email, Gchat, Facebook, etc., have
created new online communities, reduced the geographic barriers, and brought
people closer to each other. Electronic mail, commonly called as Email is a method of
exchanging digital messages from an author to one or more recipients. It has distinct
advantages over postal services and phones. Email is cheaper and faster than a letter,
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less interfering than a phone call and less hassle than a FAX. It can be easily
forwarded and sent to numerous people simultaneously without the consideration of
geographical locations and enables the recipients to respond at their convenience.
Because of these advantages, email use is increasing. However, emails do not convey
emotions that we communicate through face-to-face conversations or telephone
conversations. It lacks vocal intonation and gestures. When e-mail is used skillfully, it
enables effective communication. When not used effectively, email can become a
huge drain on time and efforts. Etiquettes of emailing are therefore fundamental to
effective communication.
There are many free email service providers such as Google (Gmail), Yahoo (Yahoo!
Mail) and Rediff (RediffMail). To access an email service on the Internet, you must
have an email address with at least one of these providers. Each of these companies
offer free email accounts and have different interfaces.
An email can be easily sent and forwarded to numerous people at once. Today, the
email system is based on a store and forward model of messaging and it is carried by
the Simple Mail Transfer Protocol (SMTP), first published as Internet Standard 10
(RFC821) in 1982. The email service providers accept, forward, deliver and store
messages.
In this Unit, we will learn about the effective use of emailing for communicating with
other people and organizing email contacts and account for efficient use of resources
and time.

Resource Requirements
Hardware
·
·

A working computer system
A modem to connect to the internet

Software
·

A Web Browser (Preferably Google Chrome or Mozilla Firefox)
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Suggestions for Effective Teaching
·
·
·
·
·
·
·
·
·

Encourage peer learning in Computer Lab
Ensure that students follow standard procedures to logon/logoff a computer.
Ensure the proper connectivity of I/O devices
Encourage students to explore opportunities as IT Professionals
Introduce how to integrate IT Tools with traditional practices at various work
places
Encourage students to follow best practices such as taking backup of files, turning
off devices when not in use
Educate students about the effective use of Emails with live examples.
Educate students to keep storage media virus free
Sensitize students on ethical and health related issues

-3-

NVEQ Level I

ITCC-103

Element 1: Composing Emails and Attaching Files
For sending and receiving emails, you should first create an email account. If you
already have an account you just have to sign in. Once you have created an account,
you get an online mailbox to send, receive and store contacts. A mailbox is identified
by an email address. The email address is similar to a postal address or a phone
number. An email address is a character string that identifies an email user. An email
address consists of two parts, separated by @ symbol. The first part is the username
and the second part is the email service provider’s domain name. The username may
be up to 64 characters long, is generally case-sensitive and cannot contain any spaces.
The domain part cannot be longer than 255 characters and is case insensitive. There
are many free email service providers such as Google (Gmail), Yahoo (Yahoo! Mail)
and Rediff (RediffMail). Each of these companies offer free email accounts and have
different layouts.
It is always helpful to get to know a program's layout and elements before you start
using it. When using email, you will interact with several windows, including the
Inbox window, the Email Message window and the Compose Message window.
Depending on the email provider, these windows may look and feel different, but the
way they function is essentially the same. For ease of understanding, the steps
presented in this unit will focus on one of the most popular services - Gmail.
Gmail (also called Google Mail) is a
free, advertising supported email
service provided by Google. In many
ways it is like any other email service:
you can send and receive emails,
block spam, create an address book,
and do other basic email tasks. But it
also has some more unique features
such as Priority Inbox, Conversation
View, and the ability to call any
phone in the world, that help to
make it one of the most popular email
services on the web.
Figure 1.1 Gmail Sign in Section
Useful Features of Gmail
A few of the useful features offered by Gmail worth exploring are as follows:
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Spam Filtering: Spam is another name for junk email. Advanced technologies are
now being used by Gmail to keep spam out of your inbox. Emails marked as Spam
by you or recognized by Gmail are automatically sent to a separate Spam folder.
The mails in Spam folder are automatically deleted after 30 days.
Priority Inbox: This feature identifies the most important emails (by number of
times you correspond with that email id) and places them at the top in the
inbox. This feature is particularly useful if you get many emails every day, as it
saves you from the effort of manually sorting through received mails to find the
important ones.
Conversation View: A conversation occurs when you send emails back and forth
to another person (or a group of people), often about a specific topic or event.
Gmail groups these emails together by default, which helps to keep your Inbox
more organized.
Built-in Chat: Instead of sending an email, you can send someone an instant
message chat or use the voice and video chat feature if your computer has a
microphone and/or webcam.
Call Phone: The call phone feature is similar to voice chat, except it allows you
to dial a phone number to call any phone in the world. It’s a free service for calls
made to people in United States of America or Canada, but for other countries
calls can be made at relatively low prices.
Different Inbox View Styles: It is possible to view your inbox in different styles
like Classic, Unread first, Important first, Starred first and Priority Inbox. These
styles help you decide which emails will be displayed at the top of the inbox. To
change the inbox view simply click on the small arrow link next to the inbox in
the left menu pane and choose the appropriate style from the drop down list.
Autoresponders: You can use Autoresponders to handle the most frequently
requested information people ask from you. This feature is very useful to
respond to your mails automatically when you are out of station for a long
vacation or official purpose.

Sign in
To send or receive emails, the first step is to log on to the email account by providing
the correct username and password on the login page of the email service provider.
Enter your username and password and click on Sign in button (Figure 1.1). Once you
log in to your Gmail account, you will see the inbox, as shown in Figure 1.2.
Inbox
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The inbox is the folder that contains all the incoming emails. The Gmail inbox has
some key features which you can easily notice in Figure 1.2:
Ø Unread messages appear in bold
Ø Names of the email senders are listed on the left
Ø Gmail displays snippets, small lines of text next to each recent message to
reveal a bit of the content
Ø In Gmail, messages are grouped into 'conversations' so that all follow-ups and
responses appear as a single line in your inbox.
Ø The time or date of the most recent message is displayed on the far right of
the conversation line
Ø Check boxes appear next to the sender’s name to perform actions like deleting
individual emails
Ø It is possible to view your inbox in different styles. A few popular ones are:
· Classic - Classic is the default style in which messages are ordered
chronologically in the order of the date.
· Unread First - Unread mail stays at the top; everything else is at the
bottom.
· Important First - Displays mail from the contacts you email most often
and other important mail at the top. All other mails are displayed in a
different section at the bottom.
Snippets
Grouped
messages

Figure 1.2 Inbox

Composing mail
The first step towards composing effective email is to define the purpose for the
email. Email can range from the formal to the informal.
Formal emails should begin appropriate Greeting and end with
"Regards". Don't use an informal style unless you know the
person very well. After defining the purpose, begin drafting
the message. Begin the message by addressing the recipient in
the way the contact prefers. Keep in mind that the more
concise your message is, the more likely it is that the
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recipient will read it and take action. If the message requires some details and
explanation, be sure to break up the information using bullet points.
Let us now compose a new email. Click on the Compose Mail button in the left menu
pane (Figure 1.3).
Figure 1.3 Compose Mail Link

Email Actions
Email Recipient Area
Email Subject Area

Main Message Area

Figure 1.4 Components of Compose Window
The user-friendly Compose Mail interface displayed in Figure 1.4 has the following
major elements:
· The To textbox: Enter the email address of the recipients here. This can
contain multiple addresses separated by a comma
· The Cc/Bcc link: Click on this to display a textbox where the email
addresses of recipients who have to receive the carbon copy/blind carbon
copy can be entered. The CC and BCC are used to send multiple copies of a
message. The CC field allows you to send a copy of the message to multiple
people. In this case all the recipients will be able to see all the other
recipient addresses. BCC field allows you to send a copy of the message to
multiple people without the recipients knowing about the others addresses.
· The Subject textbox: Enter the Subject line here. The subject line should
be short and give a clear indication of the content of the message. It
should also indicate whether an action is required.
· The Message Area: Type the message in this area. While typing a message
remember that an email has 3 major parts(Figure 1.5):
(i) Header: The header has information about the sender like the
address of the sender, those that the email was sent to
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and/or CCed, date and time of the message and the Subject
Line. Some part of the header is hidden by Gmail as it is only
relevant while troubleshooting.
(ii) Body: The body contains the text of the email
(iii) Signature Line: Line used by the sender to give the recipient
some relevant information about the sender.
The Attach a file link: Click on this to open up the file browser to select
the files to be sent as attachments. Attachments can be digital files for
documents, images, videos, presentations or more. These attachments can
be opened and downloaded by the recipient.
Header

Signature
Line

Body

Figure 1.5 Parts of an Email
Formatting text
Gmail allows you to format text while composing an email. The "formatting bar" tool
is available right below the subject field (Fig.1.6). If it is not visible, click Rich
formatting link. The formatting bar has several buttons and you can understand what
each one does if you move the cursor over it.
Caution
Some of the rich-text formatting that you may use
include:
Email is neither private nor
secure. Do not use emails to
discuss confidential or sensitive
information. An email is a
-8permanent record and can be
easily forwarded to others or
intercepted. Double check all
addresses and content before
you send.
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Typing in 20 different languages including Hindi
·
Making text bold, italic or underlined
·
Changing font size and font type
·
Adding color to selected text
·
Highlighting text
·
Including Emoticons and a web links (URL)
·
Adding formatted lists (numbered, bulleted)
·
Indenting
·
Aligning text
·
Removing Text Formatting
·
Checking spelling
For official emails, such as job applications, you should be careful not to add
formatting that would seem too informal, such as bright colors or emoticons.
·

Adding Signatures
A signature is an optional block of text that appears below every email you send. By
default, Gmail does not include a signature, but it's easy to create one. A typical
signature includes name and some contact information, like phone number or email
address. If you're using Gmail at work, you may want to include your title and your
company's address or web site. To add a signature follow the steps
given below (Figure 1.7):
Step 1 Click the gear icon in the top-right corner of the page and
select Mail settings.
Step 2 Scroll down until you see the Signature section.
Step 3 Type your desired signature in the box. You can also change the font, add
other formatting, or insert an image if you want.
Step 4 Scroll down to the bottom of the page and click Save
Changes.
In Gmail, signatures are separated from the rest of your
message by two hyphens. If you don't want your signature to appear on a specific
message, you can delete it by highlighting the text (move the cursor over the text)
and deleting it (press the delete key) before sending the message.
Adding Attachments
The next step is to add any
attachments if required. An
attachment is simply a file
(such as an image or
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document) that is sent along with your email. For example, if you are applying for a
job, you might send your resume as an attachment, with the body of the email being
the cover letter. It's a good idea to include a message in the body of your email
explaining what the attachment is, especially if the recipient isn't expecting an
attachment.
To add an attachment follow the given steps:
Step 1 While composing an email, click Attach a file.
Step 2 Choose the file you want to attach and click Open.
Step 3 The attachment will begin to upload. Most attachments will upload within a
few seconds, but larger ones can take longer.
When you're ready to send
your email, click Send. Note
that you can click Send before
Me Singing.jpg 27 K
the
attachment
finishes
uploading. It will continue to
upload,
and
Gmail
will
automatically send the email once it's done. Never send attachments to email lists or
to large groups of people until necessary. Instead of sending an attachment, consider
putting the text you wish to send in the body of your email.
Note that Google wants to keep its Gmail service clean and neat. Executable files, the
ones with a .exe file extension are not allowed as attachments - ever! Moreover you
can only send and receive files up to 25MB through your Gmail account to other Gmail
account. The only thing that you need to keep in mind is that the limit is only
applicable to Gmail to Gmail sending and receiving email.
Lets quickly review the steps involved in composing an email [1]Sign in to Gmail
account [2] Click the Compose button in the left menu pane [3] Fill in the To: and
Subject: [4] Click on the CC (copy) or BCC (blind carbon copy) buttons and enter
additional addresses of the persons you wish to send the email to(if required) [5]Type
your message inside the message screen, [6] Use the formatting toolbar to add font
styles (bold, italic, underline) and other formatting features (if required) [7] Click
Save Now button on the top to save the mail in the Drafts folder.
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Know More!
It is possible to attach files larger than 25MB by splitting the files. Split very large files into
manageable chunks that are less than 25MB. Further you can also use a compression program (also
known as a zipping program) to decrease the file size especially when the file is only a little above
25MB. Generally word processor documents, spreadsheets and PDFs become considerable lighter when
compressed. Zipping a file that's a little more than 25MB would probably bring the file size under the
maximum value. However, zip programs are not very effective on images, music or video files.

Saving Draft
After composing your message, you might decide to review it thoroughly at a later
date before actually sending it. To save the draft message till you are ready to send
it, click on Save Now button or use the keyboard shortcut ‘Ctrl+S’. The message will
be saved in the Drafts folder and can be retrieved later for editing. The Drafts folder
contains email messages that have been composed but have not been sent. Gmail
automatically saves a copy of the message being composed in the Drafts folder
periodically to avoid loss of data in case of a browser crash, power failure or other
errors.

Summary
·
·
·
·
·
·

·
·
·
·
·

To send and receive emails on the Internet, one must have an email address
An email address consists of two parts, separated by @ symbol
There are many free email service providers such as Google (Gmail), Yahoo
(Yahoo! Mail) and Rediff (Rediffmail)
The various features of a mailbox include inbox, Drafts box, Spam box, Sent
box, Trash box, etc
The Drafts box contains email messages that have been composed but have not
been sent
Spam is another name for junk email and the Spam box contains the mails that
have been marked as Spam. Suspicious emails can be flagged as 'spam' and they
would be placed in the Spam folder
A signature is an optional block of text that appears below every message that
you send
The CC and BCC features are used to send multiple copies of a message
An attachment is a digital file that is sent along with your email
To compose an email Click the Compose button
To save a draft simply Click on the Save Now button after composing your mail
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Self Assessment
S.No. I am able to…

Yes

1

Log into an email account

2

Can identify and state usage of the To, Subject and message
Area interface elements

3

Open and close Inbox

4

Create a signature

5

Make use of rich text features while creating mails

6

Attach different types of digital files to an email

7

Save mails in the Drafts folder

8

Can change the Inbox view

No

_________________________________________Now I can answer …
1.
2.
3.
4.

Expand the term Gmail.
Which tool of Gmail allows you to add formatting to an email message?
Define the term signature.
Which added feature of Gmail avoids loss of data in case of a browser crash or other
errors?
5. Is it possible to attach different types of files (one spreadsheet and one image) in the
same email?
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Element 2: Sending, Forwarding and Receiving Emails
Sending emails
After composing an email, click the Send button on the
toolbar to deliver the email to the specified recipient(s). To
retrieve a message saved in the Drafts, open the Drafts
folder and click on the relevant mail. After reviewing, click
“Mashir Shah”
on the Send button. When you send an email, a copy is
placed in the Sent Mail folder for your future reference.
This is really helpful when sometimes you want to resend or
forward the sent message.
Figure 1.9: Send button
Receiving Email
All the received emails are stored in the inbox. The received emails are generally
displayed chronologically on the basis of the time when they are received. To open
emails simply click on them in the inbox. As soon as you select any email by placing a
checkmark in the checkbox next to an email in the inbox, Gmail activates the toolbar
that displays different options of actions that can be performed on the selected email
as explained in Figure 1.10.

Email Select
Button with
option to
select:
· All
· None
· Read
· Unread
· Starred
· Unstarred

Archive
Button to
clear the
inbox
and send
selected
emails to
the All
Mail
folder

Report
Scam
button to
mark
selected
emails
as
Spam

Delete
button to
send the
selected
emails to
the Trash
folder

Move To
button to
send the
selected
emails to
desired
folders

Labels
button to
mark the
selected
emails
with
desired
labels

More
button
with
misscell-aneous
options
like Add
Satr,
Mute etc

Figure 1.10 Toolbar Displaying Actions to be Performed on an Email
When you open an email for reading, a separate window containing the email is
displayed in place of the inbox. The received emails may contain attachments.
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Viewing Email Attachments in Gmail
In Gmail, image attachments are
displayed as thumbnails with two
links beside each - View and
Download. Clicking on View
displays the full size image in a
new browser window or a new
browser tab. Microsoft Word
documents (including .docx files)
can be converted by Gmail to
HTML format so that you can read
these
online
(without
downloading) and other kinds of
email attachments like PDFs and
text files can be viewed through
Google Docs.
Figure 1.11 Handling Different Gmail Attachments
Downloading Gmail attachments
You can download Gmail attachments either one by one or all together. Clicking on
the Download link beside an email attachment will download only that file. The
Download all attachments link is found right under the actual email message and just
before the email attachments list. Clicking on this link downloads all the attachments
as zip file.
Depending on which web browser you are working on, email attachments will either
be downloaded to a specified directory (the download directory set in the browser) or
the program will let you choose the storage location. Never open an attachment
unless you know what it is and you are expecting it. Even then it is wise to be
cautious as many email viruses try to encourage you to open them. Always have
update your Antivirus on your computer.
Replying to emails
The received mails are displayed in the Inbox. Emails are listed with the name of the
sender, the subject of the message and the date received with the most recent at the
top. Unread emails usually appear in bold text. Select an email in the Inbox by
clicking on it and it will open in the Email
Message window. Read the message and
determine how to respond to it with a variety
-14-

NVEQ Level I

ITCC-103

of commands:
1. Reply: To respond to the sender of the email chooses the reply option. A new
compose window will appear just below the original email with the original
message in the body. Compose your response and then click on Send button.
2. Reply to all: Sometimes emails may be sent to multiple recipients. To
respond to such emails, first decide whether the reply is to be sent just to the
sender or to all the original recipients. If the message is to be sent to all
original recipients as well as the original sender then choose the Reply All
option.
3. Forward: Forwarding means to share a received email message with others.
To forward an email click the Forward link and then enter the email addresses
of the person(s) to whom the mail is to be sent.
Forwarding Email
As explained above to forward an email, simply click on the Forward link to open a
new compose message window. Note that Gmail automatically fills in the Subject
textbox with the prefix Fwd: followed by the original Subject line of the message
being forwarded. The prefix Fwd: is used to indicate to the recipient that this email
contains a forwarded message. Be careful while forwarding any chain mail message. It
is always better to first check the mail for authenticity before forwarding chain mails.
Deleting Emails
To delete a message, simply click the Delete icon (a trash bin symbol) displayed at
the top. Deleted emails are stored in the Trash folder. Deleted emails can be
retrieved from the Trash within 30 days of deletion after which they are permanently
deleted.
Archiving Emails
Archiving is one of the original and unique feature of Gmail. This feature has allowed
the email users to get past the "I have to delete everything because I don't have
enough storage space" mindset. Archiving a message simply tells Gmail to remove the
message from your Inbox folder and keep it in your "All Mail" folder. When you receive
an email, it first goes into your inbox. You can read it, reply to it, forward it, trash it,
or you can report it as Spam. All emails will remain in your inbox until you specifically
"Archive" them. Archiving simply cleans up your inbox. All archived messages are
always accessible through the "All Mail" folder and may be easily moved back to the
inbox when required. To archive an email simply select the mails to be archived by
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clicking on the checkbox before them and click on the archive button.
Flagging email as Spam
You can flag your emails as Spam by [1] Highlight the email message from the list [2]
Click the Spam button
on the toolbar [3] The conversation is now moved from the
Inbox folder to the Spam folder of the relevant mailbox [4] A confirmation message
displays at the top of the screen.
Recover Email from Spam folder
If you receive email in your Spam folder that wasn't spam then you recover them by
the following the steps as follows: [1] Click on the email to select it from the list [2]
Click on the More actions button on the toolbar above the message list [3] Click on
Not Spam. The email will be marked as Not Spam and it will be sent to the Inbox.
Searching for mails
Because of the large storage space in your inbox, you can keep emails forever and
hence there is no need to delete messages frequently. This means you can potentially
store tens of thousands of emails. But this could be a cause of a major problem of
searching for an email lying in your Gmail account. It's like trying to locate a needle in
a haystack.
This is where Google's search algorithms come into play! The search field on your
Gmail account is located at the top on the right of the logo. It allows you to perform
searches on both email messages in your Gmail account and the world wide web
(www).
To search for an email message follow the given steps:
Step 1:
Step 2:

Step 3:

Step 4:

Type in your query in the search field and click the Search Mail button. If
the search is complex then proceed to step 2.
However, you can perform specific searches through the different search
options. Click on the "Show search options" link, which opens up the options
window.
You can use one or more fields to enter your search options. For instance, if
you want to list all emails with attachments from a friend Puneet, you
would type in Puneet's email address or name in the From: field and check
the Has attachment checkbox.
Click on the Search Mail button.
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Using the Search Mail button you can search for:
· Emails from specified senders or recipients using the From: and To: fields
· messages containing or not containing specified words using the Has the words
and Doesn't have: fields
· email subject lines for keywords using the Subject: field
· emails that have attachments using the Has attachment checkbox
· within a specified date range using the Date within textboxes
· email messages that are lying in your inbox, trash, chats, spam, drafts, send
folder or those that have been read or unread using the Search drop down list

Summary
·
·
·

·
·

The received mails are displayed in the Inbox
Emails are listed with the name of the sender, the subject of the message and
the date received with the most recent at the top
The Reply option is used to send a reply to the sender of the message whereas
the Reply to all option is used to send a reply to all the original senders of the
mail
The Forward feature of the mailbox allows you to forward a mail that you have
received to another person
To edit and send a draft [1] Click the Drafts folder in the left pane [2] Existing
message drafts will appear in the list [3] Click to select the draft you wish to
edit [4] Make any desired changes in the message [5]Enter email address and
subject [6] Click Send on the message toolbar to send the edited draft

Self Assessment
S.No. I am able to…

Yes

1

Retrieve emails saved in the Drafts box and edit them before
sending

2

Send freshly composed emails

3

Forward received messages

4

Open and read received emails

5

View attachments in Gmail

6

Download attachments and view them
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7

Delete messages permanently from the Inbox

8

Decide when to use Reply / Reply to All options

_________________________________________Now I can answer …
1.
2.
3.
4.
5.

Where are all the received mails displayed?
Is it possible to edit emails saved in the Drafts before finally sending them?
Which button will you use to finally dispatch mail?
What is the role of the Sent Mail folder?
Which of the following options is the most appropriate to share a received message
with multiple people: Reply, Reply to All or Forward
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Element 3: Organizing Emails and Managing Contacts
Gmail Labels
Gmail provides the facility to categorize and organize emails into different folders,
known as labels. Each label may be "opened" and it is possible to see all the messages
in it. This feature has an obvious advantage. It is possible to put any message in any
number of folders. An email can belong to the "Most Urgent" messages as well as to a
particular project at work, for example. It can carry the "To-follow-up" and
"Professional" labels at the same time, and it can be found under both labels.
Creating a label in Gmail
Step 1

Step 1: While viewing the message in your mailbox, click the
Labels button
Step 2: Select Create new (Fig.1.12).
Step 3: Type the desired label name.
Step 4: If this label is to be nested under another label then
select the name of the parent label from the drop-down
list.
Step 5: Click Create.

Step 2

Step 3

Step 4

Step 5

Figure 1.12: Creating a label
Applying label to a message
Step 1: While viewing the message, click the Labels button. A drop-down menu will
appear with a list of labels. Alternatively check the message in the message list and
then click on Labels button.
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Step 2: Place a check mark next to all of the labels you want, and then click Apply.
Now, when you view your Inbox, you'll be able to see the label next to the message
subject as shown in fig. 1.13.

Figure 1.13: Applying label to a message
Viewing labeled messages
Once you've added labels to some of your messages, you can easily view all of the
messages contained in a particular label. To view the messages with a particular
label, click the desired label name in the left panel of the mailbox. If the label is not
visible then click more drop-down arrow below the list of labels and then click the
desired label. From there you can also click Manage labels to control the ones to be
hidden.
Choosing a label color
Step 1: In the left menu pane, locate the label for changing the color (e.g., Work, as
shown in Fig.1.14).
Step 2: Click the drop-down arrow next to the label name.
Step 3: From the menu, select the desired color.
Step 4: The label will be updated with the color chosen by you.
Step 3

Step 2

Step 1

Figure 1.14: Choosing label color
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Customizing color for labels
You can customize the color of the labels by following the steps given below:
Step 1: When picking a label's color, select Add custom color.
Step 2: Select the desired colors for text and background.
Step 3: Click Apply.
Removing a label from a message
Step 1: Check on the labeled message in the message list or open it.
Step 2: Click the Labels button.
Step 3: Click on the desired checked label to be removed. Alternatively deselect the
check box in front of the label name and click Apply.
Using filters for organizing mails
You can also set up filters and sieve rules for incoming mail. It is useful for organising
mail from mailing lists and deleting spam straight away. The filters let you
automatically segregate email messages based on the criteria you specify. Filters for
email messages are probably the most useful and overlooked feature of the free email
service. Once the emails have been segregated, you then indicate an action to be
applied such as deletion, forwarding, archiving, etc. Filters can be applied to both
new incoming messages and to older ones. Let us now look at usefulness of filters and
how you can create these to manage your messages and save time.
Creating filters
Filters are created by specifying search criteria that automatically sort email
messages in your account. Filter in Gmail can be created in two steps. In the first
step, you choose search criteria, which segregate the email message. In the second
step, you select an action to be applied to the search results.
Gmail filters are found under Settings, which is located at the
right.

link near the top

To create your first Gmail filter, follow the steps given below:
Step 1: Click on the gear
icon to open the Settings window.
Step 2: Select the Filters
tab.
Step 3: Click on the Create a new filter link.
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Step 4: Specify your search criteria based on which the emails are to be searched
and segregated.
Step 5: Click on the Test Search button to check your specified search criteria.
Step 6: Click on Next Step button.
Step 7: Choose an action to be implemented on the segregated emails from the
available list.
Step 8: Click on the Create Filter button.
Let us now try and understand the options available under the Specify Search Criteria
and Specify Action steps of creating a filter.
Specifying search criteria
As mentioned above, the most
important step in creating a
Gmail filter is to indicate a
search criteria based upon
which the emails will be
searched and segregated and
you'll find a total of six (five
text fields and a checkbox)
options to specify the search
criteria as explained below:
· From (text field): enter the

name of the sender or their
email address (Fig.1.15).
· To (text field): specify the
email account to which the
email comes to - especially
helpful if you have added
multiple accounts on Gmail.

Figure 1.15: Specifying search criteria

· Subject (text field): Enter keywords to search the email subject line.
· Has the words and Doesn't have (text fields): specify keywords to search the email

message body.
· Has attachment (checkbox): results in segregating emails that have attached files.
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The Test Search button is a convenient way to check your specified search criteria.
Using the test search button, you can check if the specified criteria work properly,
else modify the search criteria. Note that the messages in the Spam and Trash folders
are not checked.
Choosing action for search results
Once you've specified the search criteria (and don't forget to check it using the "Test
Search" button) you need to indicate an action to be implemented on the results.
Gmail offers you the following seven different actions that you can apply.
Skip the Inbox: The message will straight be archived and will not be displayed in
the Inbox.
·
Mark as read: Marks the email message as read. The message in your Inbox will
not appear in bold.
·
Star it: Marks the email with a star. Star lets you give messages a special status to
make them easier to find.
·
Apply the label: Select and apply a label to the email message.
·
Forward it to: Forwards the email message to another account that you specify.
·
Delete it: Deletes the email message.
·
Never send it to Spam: Never send the filtered messages to Spam box.
Since these are checkboxes, you can have one or more actions applied to the
searched results. Furthermore, the actions are executed not only on new incoming
messages but also older ones residing in your inbox. You can have as many email
filters as you want in Gmail.
·

Editing and deleting filters
You can edit or delete filters by following the steps given below:
Step 1: In the top-right corner of the page, click the gear icon and go to Mail
settings.
Step 2: Click on the Filters tab to view a list of filters that are currently active.
Step 3: You can then click on the edit or delete links to edit or delete the desired
filters.
Using contact feature
Contact is like an address book. It contains the names and email addresses of the
people with whom you have communicated. It allows you to include other contact
information like home address and phone number if desired. Apart from saving the
hassle of remembering everyone's email address, Email also has the provision to
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create Contact Groups i.e., Family, Friends, Work, etc. The most important benefit of
having groups of Contacts is the ease with which you would be able to send messages
to multiple recipients i.e., all the contacts in a group.
Creating a contact
Step 1: Click on the Contacts button in the left-hand column.
Step 2: Hit the New Contact button in the top left corner of the Contacts box.
Step 3: Fill in all of your contacts information in the appropriate fields (Fig.1.16).
Step 4: Any information added will save automatically otherwise you may click Save
Now when you are ready to add the contact.
Step 5: You can enter additional contact information by clicking the Add drop-down
menu.
Step 3

Step 1

Step 2

Step 5

Figure 1.16: Creating a contact
Email addresses are automatically added to your Contacts list each time you use the
Reply, Reply to all or Forward button to send messages to addresses not previously
stored in your Contact list. If you don't want contacts to be automatically added,
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choose I'll create contacts myself setting. To do this, visit the 'Create contacts'
section of the General tab in your Settings.
Editing a Contact
Step 1: Click on the Contacts button in the left-hand column.
Step 2: Select All Contacts and scroll through the list until you find the contact you
want to edit.
Step 3: Click on the name of the contact you want to edit.
Step 4: Make necessary changes.
Step 5: Exit the editing field to save automatically or click on the Save Now button.
Creating a Contact Group
Step 1: Click on the Contacts button in the left-hand column.
Step 2: Click on the Groups drop-down menu or Click on the New Group button in the
top-left corner of the Contacts box
Step 3: Select Create New (Fig. 1.17).
Step 4: Type in the name of the group you want to create.
Step 5: Click on the OK button.
Step 2

Step 3

Step 4
Step 5

Figure 1.17: Creating contact group
Adding contacts to contact group
-25-

NVEQ Level I

ITCC-103

Step 1: To add contacts to a group, check the box next to the contacts you want to
add.
Step 2: Open the Groups drop down menu
Step 3: Choose the group you want to add the contacts to or select Create New to
create a new group
Removing contacts from contact group
Step 1: Select the contact in the Contacts list.
Step 2: Open the Groups drop-down menu.
Step 3: Deselect the checkbox of any groups you'd like to remove these contacts
from.
Managing contact groups
To edit the contact group name:
Step 1: Click Contacts on the side of any page.
Step 2: Select the group you'd like to edit.
Step 3: Click More actions and select Rename group.
Step 4: Enter the new name and click OK.
Deleting contact group
Step 1: Click Contacts on the left side of any page.
Step 2: Select the contact group from the groups list.
Step 3: Select Delete group from the More actions drop-down menu at the top of the
page.
Step 4: Click OK.
This will delete the group but not the individual contacts. They will remain in your
Contacts list.
Searching for contacts
To search for a contact:
Step 1: Click Contacts along the side of inbox page.
Step 2: Enter the name or email address of the person you're searching for in the
contacts search box.
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Step 3: Click on Search Contacts button
Step 2

Step 3

Mahesh Kumar
Step 1

Figure 1.18: Searching for contact
Tips for searching contacts:
·
·
·
·

You can use prefixes.
You can search by a person's first and/or last name.
You can search for contacts by phone number, or notes you've entered about
them.
You can search by domain1 or username. For example, searching for 'gmail.com'
will return all contacts with a Gmail address.

You can see all of the details about your contacts by printing them. Here's how can do
it:
1.
2.
3.
4.

Click Contacts on the side of any Gmail page.
Click the More actions drop-down menu and select Print....
Select the details you'd like to display.
Click Print. A new browser2 window or tab will open with the details you've
chosen.
5. Perform a search in your browser for the contact information you're looking for.

Summary
·
·

You can create labels for organizing your mails. Each label operates like a
folder and can contain multiple messages
It is possible to select different colors for different labels for easy
identification
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The filters let you automatically segregate email messages based on the
criteria you specify.
Filters can be applied to both new incoming messages and to older ones
Contact Feature is like an address book that contains the names and email
addresses of the people with whom you have communicated
Create Contact groups to easily send messages to multiple recipients
simultaneously.
You can search for specific email or Contact within your mailbox using the
inbuilt Search option.

Self Assessment
S.No. I am able to…

Yes

1

Create new labels and apply it to selected messages

2

View all messages with a particular label

3

Give different colors to different labels for easy identification
of mails.

4

Create filters to automatically sort email messages.

5

Edit and delete already created filters.

6

Add new contacts and save appropriate information about
them.

7

Create Contact Groups to group similar kind of contacts.

8

Manage contacts and contact groups.

9

Search for a contact

10

Search for specific emails using different search criteria

No

_________________________________________Now I can answer …
1.
2.
3.
4.
5.

Name the feature that facilitates the categorization of emails into folders.
Which feature allows you to delete spam messages directly when they are received?
Filters can be applied to both new incoming messages and to older ones.(True/False)
State the difference between a label and a filter.
Why is it important to create Contact Groups of related people?
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6. State any 3 tips to search for contacts within a Gmail account.
7. What will you do to remove a message from the inbox without getting rid of it?
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Element 4: Scheduling Appointments Using Online Calendar
Services
We all at some point of our life and time attend meetings, parties, work schedules,
etc. We have to stick to the timelines attached to them and accordingly plan our
day’s, week’s or month’s schedule or calendar of activities. Scheduling such events
using Online Calendars is also possible. Online Calendars offer a great deal of
features and conveniences that can go a long way in helping you to stay on track and
get things done timely. The most appealing thing about online calendars is their
flexible interface that allows you to view and manage events with ease. Using an
online calendar, you can:
·
·
·
·
·
·
·

Add, move or delete events on your calendar.
Easily switch back and forth between day, week, and month and customize the
view your calendar.
Use color coding to help you focus on specific events or calendars
Block out multi-day events.
Conveniently search for events.
Set email or pop-up reminders that won’t let you forget an event.
Display repeating events to avoid conflicts.

Online calendars also allow you to create and view multiple calendars for various
tasks in the same interface. You can also show or hide any of your calendars. In
addition, you can share a calendar with other people and even give them access to
add and edit events.
One of the best features of online calendars is their on-the-go access. You can
synchronize calendars between your computer and mobile devices. In this way you
can view and update events no matter where you are.
There are many popular online calendars like 30Boxes, Yahoo Calendar, Google
Calendar, Cozi etc. We will use Google Calendar as an example to learn about the use
of Online calendar.
Accessing Online Calendar
The first step is to Sign Up to Google Calendar. If you have a Google Account, just
visit the Google Calendar homepage, enter your Google Account email and password,
and click Sign in.
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If you don't yet have an account with Google, just visit the Google Calendar homepage
and click Create a new Google Account. Once you've completed the process, Sign in
to Google Calendar using your new account. If you are already logged in to your Gmail
account then simply click on the Calendar link on the navigation bar located at the
top (Figure 1.19).

Figure 1.19: Calendar button on Google
Creating a New Calendar
Once you are on the Google Calendar screen, the first thing you would now like to do
is to create a calendar. To create a calendar, follow the given steps:
Step 1: Click on the drop down arrow next to My Calendars link
Step 1
Step 2

Step 4
Step 3

Figure 1.20: Creating a new calendar
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Step 2: Select Create new Calendar
Step 3: In the Create New Calendar dialog box, add the Calendar Name, description
and other relevant information in the appropriate text boxes
Step 4: Click on the Create Calendar button
The Calendar will be displayed below the My Calendars link in the main window. It is
also possible to share your calendar with your friends or colleagues. To share a
calendar with another person, while creating a new calendar, follow the given steps:
Step 1: Enter the email address of the person you want to share your calendar with,
in the Person column under Share with specific people section.
Step 2: In the Permission Settings drop-down menu, select the level of permission
you would like to give to the person.
Step 3: Click on the Create Calendar button.
Step 2

Step 1

Figure 1.21: Sharing calendar with specific people
Now that you've created a calendar, you can add events in your calendar. For each of
the calendars, you can add, delete,
and edit events any time you like. To
create an event, follow the steps given
Ste
below:
Step 1: Click the Create button in the
Ste
left-hand column.
Ste
Step 2: Enter a name for the event in
the Click to add a title field.
Step 3: Choose a date and time for the
event, and fill in a location
and other details.
Step 4: Click on Save button to save
this event.
Figure 1.22: Entering event details in a calendar
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The event creation screen gives you several options like setting a reminder, changing
calendars, adding guests who will receive a notification and setting up details of the
event like time, date, and repetition. You can also set up events to repeat on a
regular basis. For example, you have a departmental meeting every fortnight on a
Sunday, then you can set up to repeat this event by clicking on the Repeat checkbox
in the New Event dialog box. A new Repeat dialog box opens which allows you to set
the repetition properties of the event as shown in the figure below. To set repetition,
follow the given steps:
Step 1: Click the checkbox next to Repeat (Figure 1.23).
Step 2: In the popup, choose the following
options:
· Repeats: Weekly
· Repeat every: 2 Weeks
· Repeat on: Check the first S
checkbox if the meeting is
scheduled for every Sunday
· Since this meeting date is to be
kept indefinitely, do not indicate
an end date.
Step 3: Click Done

Figure 1.23: Repeat window
Make sure to check the Summary field to see if the settings you’ve selected match the
recurrence of your event.
Setting Reminders
You can also set up reminders for the events added to your calendar. In the
Reminders section of the Create Event dialog box, select Email from the first dropdown, enter 3 (fig. 1.24), and select hours
from the last drop-down. This means you'll
be sent an email reminder three hours
before the event begins.
Figure 1.24: Reminders window
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Inviting people
To invite your friends to the event, send an
invitation to your friends by entering their email
address in the Add Guests box (Figure 1.25) of the
mukki@gmail.com
Create Event dialog box. Your guest doesn't need
to be Google Calendar or Gmail user to receive and
respond to Google Calendar invitations. Once you
have added the email addresses click on Save to
add all the event properties.
Figure 1.25: Add guests box
To view certain calendars or hide others from view, just click the calendar names to
select or deselect them. The events of the hidden calendar will not be shown in the
view area.
Changing calendar’s view
If you’ve created multiple calendars or you have other people sharing calendars with
you, you might be seeing a lot of them showing up in the My calendars and Other
calendars sections on the left. To help distinguish among them, you can assign each a
different color by clicking the down arrow next to the calendar and choosing the
desired color (Figure 1.26) and
checking on the colored box.

Figure 1.26: Choosing color
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You can easily switch between the different
view by simply clicking on the relevant view
tab (Figure 1.27). There are 5 different View
options as given below:
1. Day View: It gives you a view of only a
day’s event.
2. Week View: It gives you a glimpse into the
next week’s events.
3. Month View: It gives you a glimpse into
the month’s events.
4. 4 Days View: It gives you a glimpse into
the next four days events.
5. Agenda View: It gives you a view of
events for the next few days on time
basis.
Figure 1.27: View options on calendar

Searching for events
Using the search function in Google Calendar is similar to searching on Google.com.
To search for events on your calendars, use the search box at the top of the page. For
example, if you're looking for an event that contains the word 'swimming,' type
[swimming ] in the search field and click Search My Calendars. The search results will
contain only those events from calendars that are selected for viewing in your
calendar list (Calendars that are selected for viewing are highlighted by a colored
bar). To select a calendar, simply click on the title in the calendar list.)
You can expand or refine your searches using Google Calendar search options. Click
Show Search Options (at the top of the page, next to the 'Search My Calendars' box),
complete the appropriate fields, and press Enter.

Deleting a calendar
To permanently delete a calendar from your calendar list, just follow these steps:
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Step 1: Click the drop-down arrow next to My calendars or Other calendars and
choose Settings. Alternatively, click the gear icon at the top of any Calendar
page, click Calendar settings and then choose Calendars.
Step 2: Click the Unsubscribe or Delete link next to the calendar you want to remove.
· Delete will permanently erase the calendar. No one, including those who
are sharing or subscribing to the calendar will be able to access it anymore.
· Unsubscribe will only remove your access to the calendar. Others will still
be able to use it normally.
Step 3: Click OK.

Summary
·
·

·
·

Online Calendars can be used to quickly add, move, delete events and schedule
appointments.
You can set email or mobile reminders about events created on the online
calendar.
You can share a calendar with other people and even give them access to add
and edit events.
You can search for specific events on an Online Calendar

Self Assessment
S.No. I am able to…

Yes

1

State the need for online calendars?

2

Create multiple calendars for various tasks?

3

Add, move, and delete events on a calendar?

4

Switch between different views of a calendar?

5

Use color coding to focus on specific events in the calendar?

6

Search for events in a calendar?

7

Set email reminders for an event?

8

Show or hide any of the created calendars?

9

Share a calendar with other people?
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_________________________________________Now I can answer …
1.
2.
3.
4.
5.

Is it necessary to have an account with Google to access the online Google calendar?
Which feature allows you to send SMS alarms for events added to a calendar?
Which view is best suited to get a glimpse into a complete week’s events?
What is the use of the Repeat feature while creating an event?
Is it essential for your guest to be Google Calendar or Gmail user to receive and
respond to Google Calendar invitations?
6. State 3 key features of Google Calendar.
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Element 5: Email Etiquettes and Best Practices
The usage of email, instant messaging, texting, and various other digital
communicative tools has been increasing rapidly. Majority of people today are
comfortable enough to use these communicative tools on a daily basis, particularly
among younger generations. As these tools are cost effective and quick, they are the
new preferred means of communication as compared to older ways of
communications like phones. But the popularity of these tools compels us to deal with
its main problem: How do these communicators express their thoughts and ideas
both clearly and concisely without being misunderstood?
Firstly these communicators have to understand that electronic communication,
because of its speed and broadcasting ability, is fundamentally different from paperbased communication and other communication media like telephones. Due to the
fast response time, email is more conversational than traditional letters or even
faxes. In a paper document, it is absolutely essential to make everything completely
clear and unambiguous because the audience may not have a chance to ask for
clarification. But with email documents, the recipient can ask questions immediately.
Another major problem with email is that the software and hardware that is used for
composing, sending, storing, downloading, and reading may be completely different
from what the receiver uses. Email also does not convey emotions nearly as well as
face-to-face or even telephone conversations. It lacks vocal intonation and gestures.
Thus the email compositions should be different from both paper compositions and
speech. Following is a list of few basic email etiquettes and best practices that should
be incorporated into personal and corporate email usage:
1. Useful Subject Lines: Use meaningful subject in not more than 5-6 words, which
convey the content of the message. Avoid using special characters, symbols,
website address and email address in the subject line. In the fast paced life of
this century, no one has the time to open each email so make the subject line
catch the eye of the reader. At the same time you have to avoid usage of words
like “Help” in the subject line as some email providers treat such mails as Spam.
Look at the examples of good subject
lines shown in Figure 1.28. Notice that
each of these subject lines are precise
and compact. Now let us look at some
other subject lines shown in Figure 1.29
and try to point out the problems in each
of them.
Figure 1.28: Useful Subject Lines
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Figure 1.29: Unpleasant Subject Lines
Each of these subject lines has a common problem – They are too long and hence
inconvenient and unpleasant for the reader. In addition the top subject uses a
website address and special characters which is very tiresome to read. Just like a
long subject line is unpleasant, not including a subject at all is equally irritating
as is the case with the last subject line. Remember the subject line should be
indicative of the content of the mail so need not contain all the information to be
included in the mail as has been done in the first three subject lines of Figure 1.2.
Remember that most email providers recognize only 25-30 characters in the
subject line and truncate long subject lines
2. Use appropriate prefixes in Subject Lines: Apart from the rule of keeping the
subject line short and precise, it is good practice to prefix the subject line with
appropriate abbreviations. You must have noticed that if the message is in
response to another piece of email, some email software preface the subject line
with Re: or RE:. If your email composition software doesn't do this, it would be
polite to put in RE: by hand. Similarly prefixes can be used for other situations,
some of which are enumerated below:
Ø For time-critical messages, starting with URGENT: is a good idea
Ø For requests, starting with REQ: can signal that action is needed
Ø If you are offering non-urgent information that requires no response from
the other person, preface the subject line with FYI: (For Your Information)
Ø Use of FWD: while forwarding emails is polite and ethical.
3. Greet your recipients: Emails are generally informal so the use of Hi or Hello is
satisfactory, especially if you are senior than your correspondent. On the other
hand, if you are sending a cover letter for a job application it will be better to
use the traditional way of greeting i.e. Respected Sir/Madam. When sending out
information to a junior, like in the case of Team leader sending Project
information to his manager, use of first name along with the greeting, is polite.
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Juniors and customers respond better when their name is used. Personalization
helps build the relationship with the reader. Given below are some examples of
proper greetings:
·
·
·
·
·

Hello Shiny – appropriate for a junior
Dear Shiny – appropriate for a friend
Respected Sir/Madam – appropriate for official emails
Hi – appropriate for a colleague
Good Day Sir – appropriate for a senior

4. Keep the messages short: It is always suggested to keep the content of the
message as precise & to the point as possible as most of the internet users and
readers are busy and prefer doing many activities at the same time while being
online. Remember, people are busy and don't have the time to try to figure out
complex messages. Moreover, it is always possible to follow up with people that
need more information.

Figure 1.30(a) A Clear and Concise Message
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Figure 1.30(b) A Long and Complex Message
Figure 1.30(a) displays a clear and concise message which is easy to understand in
one look and Figure 1.30(b) displays a long and a complex message which is hard
to comprehend.
There is another valid reason to keep the messages small i.e. nowadays most of
the people check their emails on mobile devices and it is inconvenient to scroll
up and down in small screens to make sense out of a long and complex message.
5. Watch the spelling: It's easy to make mistakes and ignore them, but sending out
messages with misspelled words is a bad sign to the recipient. Therefore it is good
practice it
6. Be careful using abbreviations and emoticons: Emoticons such as :] and
abbreviations such as lol(Laugh Out Loud) may be acceptable in informal emails
sent to friends. However, in formal communication, it is considered inappropriate
and frivolous to use such features to display emotions.
7. Use proper Intonations: An email is not capable of conveying emotions nearly as
well as face-to-face or even telephone conversations. It lacks vocal modulations
and gestures. For the receiver, it is therefore difficult to judge whether the
sender is serious or kidding, happy or sad. Therefore, you have to be very careful
while composing an email message. While you cannot make your voice louder or
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softer, it is possible to convey certain emotions through text manipulation. It is
considered rude to use all capital letters as it conveys the emotion of yelling or
shouting. So it will totally be inappropriate to use all capital letters in a situation
when you are calm. Similarly writing in all small case letters can be used to
denote lowering of voice. Some of the text tricks to express emotion in a short
message are demonstrated below:
Ø Use asterisks for mild emphasis
Message: I said that the project has to be finished by this Tuesday
Alternative: I *said* that the project has to be finished by *Tuesday*

Ø Use a combination of capital letters and exclamation marks for strong
emphasis
Message: No it is not proper to put all the load of finishing the project on one person
Alternative: NO!!!! It is not proper to put all the load of finishing the project on one
person

Ø Use combination of capital letters and special characters for extreme
emphasis but this should be used only when absolutely required.
Message: If the project is not finished by Tuesday, Sir will never give us another chance.
Alternative: If the project is not finished by Tuesday, Sir will *never*, >>**NEVER**<<
give us another chance

Ø Use all capital letters to convey the emotion of shouting or yelling to show
your anger or displeasure.
Message: As team leader I want everyone to meet their deadlines.
Alternative: AS TEAM LEADER I WANT EVERYONE TO MEET THEIR DEADLINES

Ø Use all small case letters and whitespaces to denote lowering of voice.
Message: Hi Dear,
Guess what? I was selected for the team.
Alternative: hi dear,
guess what?

I WAS SELECTED FOR THE TEAM!!!

8. Use the recipient field correctly: Kindly note that there are three different
textboxes for typing in the senders address:
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Ø To field: If you are sending the email to a single person, type their email
address in the “To” field.
Ø Cc: fieId: If you want to send the same email to others for their information,
add their addresses in the “Cc:” field. Remember that Cc is abbreviation of
carbon copy so each recipient gets a copy of the email and note that in this
case all the recipients will be able to see all the other recipients’ addresses.
Ø Bcc: field: When sending a message to multiple recipients whose privacy is to
be protected, use the Bcc (Blind carbon copy) field. This ensures that the
recipients do not know who else received the message.
It is good practice to use the addresses of all colleagues and seniors in the Cc field
when sending an official email to keep everyone informed.
It is advisable to use the Bcc when you are sending email to people of diverse
group where you do not want to disclose the recipient list. Also note that while
forwarding a message it is ethical to use bcc unless the forwarded message is
being sent to a related group.
9. Remove unsolicited content when forwarding emails: While sending forwarded
messages it is strongly recommended to
remove all the email address listed above
the content to avoid spam mails. This
Unnecessary
addresses of
will help the recipient to directly read
all forwardees
the content rather than scrolling through
undesirable email addresses list and
repetitive subject matters. Also place
any comments you have before or after
the forwarded message with suitable
line/paragraph breaks. Figure 1.31 (a)
and (b) demonstrates this etiquette.

Figure 1.31(a) Inappropriate way of forwarding message

-43-

NVEQ Level I

ITCC-103

All unwanted material has
been manually cleared to
protect the privacy

Figure 1.31 (b) Appropriate
way of forwarding message

10. Use a good signature: To save time and effort and to give your emails a personal
touch, it is recommended to create a default signature. A signature is text that
will appear at the end of each mail you send. Sometimes we are in a hurry and
might forget to include our name or a closing statement. Moreover in situations
where we have an official email on the company domain, every time adding the
name, professional title and contact information is a waste of time and effort. In
such cases a default signature is a good option. A valid signature might include
your name, title and contact information. In case of official emails addresses, in
addition to the key information, it is good idea to include short and significant
advertising information like the company’s website address or the product your
company specializes in. Nowadays most of the people have started utilizing the
signature feature effectively to include short inspirational quotes or messages like
Keep City Clean, Clean Delhi Green Delhi and so on. Such inspirational quotes
usually reflect on the sender’s persona and so should be carefully selected. Figure
1.32 shows some examples of good signatures.
11. Limit attachments: Don’t add attachments unless it is really necessary. If you
have to use attachments then follow the given best practices:
Ø Keep the attachment name meaningful and small. Sending an attachment
named CVManpreet is better and professional than an attachment named 123
or even Curriculum Vitae
Ø Wherever u have to send non-editable files use pdf format to send the
attachments. PDF format is better than normal documents as they make sure
that the receiver cannot tamper with your documents. Some of the situations
where PDF format is best suited are sending bio- data while applying for a
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job, sending company information to a client, sending invitation cards for
conferences.
Ø Most email providers set a size limit on the attachments sent with an email so
it is wise to choose appropriate formats for sending the attachments. One way
around this limitation is to use a link directly to an HTML file loaded on the
company’s website.
Ø While sending pictures as attachments avoid using TIFF and BMP formats as
they are not compact and can make your email heavy and cumbersome to
download. On the other hand formats like JPG and PNG are compressed and
hence much smaller and so can be downloaded quickly and easily. Moreover if
u want to view the pictures in the mail without downloading it, it is advisable
to use PNG, JPG and GIF formats.
Note that Gmail uses two
hyphens as a separator to
distinguish between the
signature and the message

Figure 1.32 Good Signatures
12. Test the message: While sending an important official message that has bulleted
points, table or other formatted content, it is always advisable to test it by
sending it to yourself first to view how it will be displayed. With email , once the
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SEND key is hit, it is impossible to retrieve the mail from the mailbox of the
recipients to rectify the errors. Testing the email message is also important
because the software and hardware that is used by the sender for composing,
sending, storing, downloading, and reading may be completely different from
what the receiver uses. Therefore you should be careful while using formatted
content. Use features like bold, font colour and bullets carefully.
13. Quote Content: When referring to previous email, one should explicitly quote
that email content to provide context. The greater-than sign (>) is the most
conventional way to quote someone else's email words, but different email
software may use a different convention.
Imagine a situation where your colleague has sent you a mail on Tuesday
requesting some information while you were away on a leave due to ill health.
You see the mail on Thursday and send a reply. Look at the Figures 1.33 (a) and
(b) and decide which of the reply do you think is more appropriate (a) or (b)?

Providing
Providing
context
context

Figure 1.33 (a) Inappropriate reply

Figure1.33 (b) Appropriate reply

Obviously reply (b) is better as it is not necessary that your colleague will
remember what the exact query sent to you two days ago was.
Another point that is worth mentioning here is that most email providers these
days automatically quote emails by including the entire email content when you
choose the Reply option. In such situations it is good practice to delete the
irrelevant part and only keep the relevant portion so as to keep the mail content
short and crisp. Figure 1.34 demonstrates this etiquette.
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Note that Gmail includes
the entire message
along with the sender
and message details

Note that Gmail
quotes messages
with a grey line

Gmail automatically
adds suitable prefix
to provide context

Message has been
manually truncated
to provide relevant
context

Figure 1.34 Providing Relevant Context
14. Answer your email at appropriate time interval: Emails to be sent to business
associates and customers should be sent timely and as soon as possible because
they do not carry a good impression if their emails remain unanswered. On the
other hand, it is not proper to respond to an email which has infuriated you as
soon as you read it. Doing this may lead to further complications and straining of
relations and might convey a wrong impression about you. So it is wise to answer
such emails with a calm mind. So it is good practice to understand the situation
and decide on an appropriate time interval for sending the response.
15. Use Autoresponders: Use Autoresponders to handle the most frequently
requested information people ask from you. This is a great way to automate and
saves time and effort. This feature is also very useful when one is out for long
vacation in a remote area where it is difficult to access email or in case of
medical urgencies when you do not wish to be disturbed.
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16. Do not reveal passwords: There is an old saying that “Prevention is better than
cure”, so it is wise be careful about the following issues while using public
computers in office or cyber cafes:
Ø Always sign out of your email account before leaving the cubicle.
Ø Never use the save password option provided by most email providers.
Ø Make sure that no unwanted people are around you while typing passwords
Ø Do not reveal your passwords to any of your colleagues or close friends as they
might misuse your account to send unsolicited mails.
Ø Never send personal information like credit card numbers, ATM PIN numbers
etc.
Ø Always use reliable internet cafes and avoid logging on through unsecured
WiFi networks.
17. Every email is a legal document: Be very careful while writing to a stranger as
every email you send can be tracked and identified and can be used as a legal
proof. So it is advisable not to create anonymous accounts and send mail using
that account. Moreover it is not ethical too.

Summary
·
·
·
·
·

·
·
·
·
·

Use meaningful subject lines with 25-30 characters
Be sure to keep your e-mails short, conversational and meaningful.
Always greet your recipient
Use proper grammar and spelling and also avoid fancy formatting
Be sure to include information that you are responding to by quoting relevant
portions of previous emails
Be careful using abbreviations and emoticons
Keep attachments as small as possible
If you need to send large files as attachments then always compress or zip it
before attaching it.
End your email politely and use a signature file
Use autoresponders to reply to emails when you are away on vacations and are
unable to access email.

Self Assessment
S.No. I am able to…

Yes

1

Convey messages effectively in minimum words?

2

Write short subject lines for emails?
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3

State the difference between cc and bcc features?

4

Decide when to use cc and bcc features

5

Create a digital signature?

6

Understand the importance of proper intonations

7

Appreciate the importance of quoting documents?

_________________________________________Now I can answer …
1.
2.
3.
4.
5.

What information should never be emailed?
How many characters are generally viewable in the subject line of an email?
What is the best way to avoid typing your name at the end of every email you send?
Which word in an email subject line might make your email look like spam?
Astha is sending a mail to her colleague regarding the approaching project deadline.
Which of the recipient field: to, cc: or bcc: should she use to send the mail for
keeping her bosses and other colleagues informed about the same.
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You can rise upto…

Explore contributions of "Tim Burner Lee", "Larry Page" &
"Sabeer Bhatia"
Assessment
Multiple Choice Questions
1. Which of the following is a valid e-mail address?
A. India.user.com
B. India@user.com
C. India.user.co.in
D. None of the above
2. What do we call the files that we send along with the messages?
A. Pop-ups
B. Signature
C. Attachments
D. Trash
3. Generally, an email that you compose should include __________
A. Recipients
B. A subject
C. A message in the body field
D. All of the above
4. When you are organizing your mails, you can apply one or more ________ to
categorize them
A. Filters
B. Groups
C. Address Book
D. Labels
5. A filter can automatically ____________ incoming emails.
A. Label
B. Archive
C. Forward
D. All of the above
6. Which of the following are key features of Google Calendar?
A. You can manage your calendar anywhere, even offline
B. You can set your calendar to sync with your smartphone
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C. Google calendar is free
D. All of the above
7. The default time for an event added to a Google calendar is
A. 30 minutes
B. 1 hour
C. 2 hours
D. All day
8. How do you enter an event?
A. Click on the Calendar at the correct date and time
B. Click the Create button at the upper left side
C. Either A or B
D. Neither A nor B
9. We usually create ___________ to store one type of contacts in our e-mail
account
A. Signatures
B. Groups
C. Blind Carbon Copy
D. None of these
10. Which symbol is used to separate user name and domain name?
A. @
B. *
C. $
D. #
11. We need the recipient’s ____________ to send him an e-card over the internet.
A. Postal address
B. E-mail address
C. Website address
D. None of the above
12. Where do we find the information about all the mails that we receive?
A. Trash
B. Drafts
C. Sent Mail
D. Inbox
13. To get to your mail Settings, you will first need to click
A. Your email address
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B. Contacts
C. The gear icon
D. Inbox
14. Why is it not always a good idea to include italics, colors, and special fonts in
email?
A. Some people don’t like them
B. Some email programs won’t support them and your recipient might not see
them as you intend
C. It is unethical
D. None of the above
15. When sending forwarded messages it is advisable to
A. Remove all the email addresses listed above the content
B. Use BCC feature when the mail is to be forwarded to diverse people
C. Place any comments you have before or after the forwarded message
D. All of the above

Fill in the blanks
1. The ____________ is used to send mails over the Internet.
2. When you sign up for ________, you automatically have access to Google Docs,
Calendar and other services.
3. Email addresses _________ contain any spaces.
4. Sign Out is also called _____________
5. The ____________ special character is a must in the email address.
6. Emails containing unsolicited advertising messages to a wide audience are
marked as _____________.
7. ____________ feature tries to identify the most important emails and puts
them at the top of your inbox.
8. The AutoSave feature prevents ________ of data in case of power failures and
broken connections.
9. Microsoft Word documents can be converted by Gmail to ________ format so
that you can read these online without downloading.
10. The __________ let you automatically segregate email messages based on the criteria
you specify.

11. Online Calendars can be used to quickly add, move, delete _______ and
schedule __________.
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12. To help distinguish among your calendars and shared calendars, you can assign
a different _________ to each of them.
13. You should use the __________ when sending emails to undisclosed recipients.
14. Typing in all caps when writing an email is considered as ___________
15. When writing an email your paragraphs should be ___________

Questions with short answers
1. Rajitha has won the title of Miss Fresher in her college. She is writing an email
to her parents to inform them about the same and also wants to send 2 related
pictures. Which file format out of PNG, BMP and TIFF is the most suitable for
sending the image attachment?
2. Samitha has recently joined an online course on Web designing. The learning
material, exam schedules and assignment deadlines are all emailed to her
along with regular course information leading to lot of clutter in the inbox. She
decided to create separate labels for each of the four categories. But now she
wants to automatically apply labels to all incoming emails. Which feature do
you think will help her in achieving this?
3. Shyama is preparing for her engineering entrance exams. Her father wants to
store all the information about her entrance exams and also wants a reminder
for each exam to be sent to her. Which feature will you suggest him to use?
4. Sanjum is out on a long adventure vacation with his family where he will not be
able to access the internet. He forgot to tell his friends about it and does not
wish to ignore mails sent by them. Which feature should he use so that his
friends get an instant reply even in his absence?
5. Write a useful subject line for the following message:

6.
7.
8.
9.

Tini - I need three letter heads for printing the appointment
letters for the new recruits. I also need the company stamp
latest by Tuesday night.

Now compose a reply to the above email.
Which icon represents an attachment?
Which is a fast, free & a convenient way to communicate with each other?
Which folder in our Gmail e-mail account contains the mails that have been
deleted?

10. Where will you click to sign out of Gmail?
11. Which option do we click to write a mail to someone?
12. Which symbol separates the email addresses if we are sending the same mail to
many people?
13. What do we call the text which is automatically added to our outgoing mail?
14. How many parts does an E-mail address consist of? Name them.
15. Explain the difference between:
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CC and BCC features
Reply and Reply to all options
Drafts and Sent Mail folders
Labels and Filters

Case based problems
1. Create a group of 3-4 friends who have accounts with different email service
providers. Tell each of your friends to log into their email accounts and
compare the various interface elements provided by each email service
provider.
2. Log into your email account and compose a simple invitation for your birthday
party, which you are going to organize in a farmhouse to be sent to your
relatives and friends. Attach a map with the directions for the venue. Also
attach a document with a detailed program of the party. Make sure that the
message conforms to all email etiquettes and best practices you have learnt in
this Unit.
3. Log into your email account and store relevant contact information of all your
close friends and relatives. Now create two separate labels namely Friends and
Family. Next create a filter to automatically apply the appropriate labels to all
incoming mails.
4. Log into your email account and one-by-one search for all friends using their
first names/ email ids from the contacts list to make sure that you have the
birthday dates of all your friends.
5. Create a Google calendar to store all your friends’ birthdays. Share it with all
your friends and give them permission to edit and add events.
6. Create an online Google calendar about your exam schedule. Create email
reminders for each exam event. Add an event about meditation classes that
repeats every week on Saturday. Share this calendar with your father and
mother but keep all the rights of editing with yourself.

Suggested Reading
Reference books
·
·
·

Business Email Etiquette | THE MANUAL, Judith Kallos, Lulu.com
Gmail Unlocked, Scott Lasak, Epubbud.com
Sams Teach Yourself Gmail in 10 Minutes, Steven E. Holzner, Sams

Websites
·

http://www.gcflearnfree.org/email101
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http://www.gcflearnfree.org/gmail
http://gmailblog.blogspot.com/
http://g04.com/misc/GmailTipsComplete.html
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Digital Data Tabulation
Pre-requisite:Unit ITCC-101 Introduction to Information Technology
Unit Code

ITDC-104

Unit Title (Skills)

Hours
Th

Pr

Data Tabulation Skill using Spreadsheet

6

24

Basics of spreadsheet

1

4

Modifying cells

1

2

Formatting Spreadsheet

2

4

Types of Cell References

1

8

Using Functions and Obtaining charts

1

6

Total
Hours
30

Ignite Mind
"All which is beautiful and noble is the result of reason and calculation”

Charles Baudelaire

Learning Objectives
After studying this unit the students will be able to:
·

Work on basics of spreadsheets

·

Move Cell Contents, Insert and Delete Cells

·

Format contents of spreadsheet

·

Use formulae for simple calculations in spreadsheet

·

Use functions and obtain charts
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Introduction

Before the invention of personal computers and spreadsheet programs, accountants and bankers
generally wrote their accounts by creating tables of numbers and text. These tables were called
spreadsheets as the accountant would spread information like costs, payments, taxes, income,
etc on a single, big, oversized sheet of paper to get a complete financial overview.
The disadvantage of these manual spreadsheets was that if one number changed, it affected all
others down the line. So, a lot of erasing and rewriting was required. Spreadsheet programs on
computers solved this problem. Using a Spreadsheet program, you can enter the data that you
want on your spreadsheet and key in the types of calculations needed. The program does all the
calculations and produces the results. In case there is any change in data, the Spreadsheet
program recalculates and displays the new result. These programs have made the tasks of
building and modifying spreadsheets much easier.

Resource Requirements
Hardware
·

A Computer system

Software
·

A Spreadsheet program (Preferably OpenOfficeCalc).

Suggestions for Effective Teaching
·
·
·
·
·
·
·
·
·

Encourage students to use Spreadsheets Program for simplifying their real life day to day
tasks like personal budget planning, creating marks sheet, time management etc.
Encourage peer learning in Computer Lab
Ensure that students follow standard procedures to logon/logoff a computer.
Ensure the proper connectivity of I/O devices
Encourage students to explore opportunities as IT Professionals
Introduce how to integrate IT Tools with traditional practices at various work places
Encourage students to follow best practices such as taking backup of files, turning off
devices when not in use
Educate students to keep storage media virus free
Sensitize students on ethical and health related issues

Element 1: Basics of Spreadsheets
Arranging data systematically in columns and rows is called tabulation. Spreadsheet applications
(also referred to as Spreadsheets) are computer programs that let you create and maintain data
tabulated in Rows and Columns.
Calc is an example of electronic spreadsheet program that is used to create worksheets, charts,
etc. It is an Open Source Software.It is a component of a large package called OpenOffice.org,
the other components include Writer for Word processing and Base for Database Management
System. MS Excel, IBM Lotus Symphony and KSpread are some other examples of spreadsheet
programs.
Starting Spreadsheet Program
To open the Calc Program follow these steps:
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Fig 1.1 Starting Calc

The Spreadsheet Program Window
When you start a spreadsheet program like Calc, a window with an empty worksheet appears on
the screen.
Main Menu
Standard
Title Bar
Bar
Formatting
toolbar
toolbar

Name box

Formula
bar

Fig 1.2 Calc Window

Navigation buttons
and Sheet tabs

Horizontal scroll bar

Here is a brief explanation of the Calc window.
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Parts of Spreadsheet Program Window
Title bar
The Title bar shows the name of the workbook along with the name of Spreadsheet program.
Here the name of the workbook is cafe.ods and the spreadsheet program being used is
OpenOffice.org Calc.

Fig 1.3 Title bar

Main Menu bar
The Menu bar displays all the menus that are available in Calc i.e.
File,Edit,View,Insert,Format,Tools,Data,Window and Help. The contents of any menu can be
displayed by clicking on the menu name.

Fig 1.4 Main Menu bar

Standard Toolbar
The Standard Toolbar contains icons that provide quick access to commands like New, Open, Save, Print,
Cut, Copy, Paste, etc

Fig 1.5 Standard Toolbar

Formatting toolbar
Formatting toolbar consists of a set of tools that are specific to cell formatting and calculations
e.g., tools to set font , bold, italics, underline, text alignment, number formats, insert border
and changing background colors, font color etc.

Fig 1.6 Formatting toolbar

Formula bar
The Formula Bar contains information that you have entered or that you are currently entering
as you type in the current or active cell. The contents of a cell can also be edited in the
Formula bar.
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Sum Button

Fig 1.7 Formula bar

Name Box

When you enter new data into a cell that already contains something, the Sum and Equals
buttons change to Cancel

and Accept

buttons.

Fig 1.8 Cancel and Accept buttons

Navigation buttons and Sheet tabs
At the bottom, left area of the spreadsheet, you will find worksheet tabs. By default, three
worksheet tabs appear each time you create a new workbook. Worksheet tabs allow you to
move from one worksheet to another in the workbook. The navigation buttons help to display
the first, previous, next, or last worksheets in the workbook.
Fig 1.9 Navigation buttons and Sheet tabs

On the bottom, right area of the spreadsheet you will find the zoom tool and the horizontal
scrolling bar. The slider on the Zoom tool may be dragged to the left to zoom out and to the
right to zoom in.

Fig 1.10 Horizontal Scrollbar

Fig 1.11 Zoom tool

Terminology(related to Spreadsheets)
·

·

Workbook: A workbook consists of worksheets. A workbook automatically shows in the
workspace when you open a Calc spreadsheet. By default,each workbook contains three
worksheets. However, we may add more worksheets to a workbook. Each worksheet is
made up of columnsandrows.
Worksheet: A worksheet carries information arranged in a tabular form in columns and
rows.
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· Column:A column is a set of boxes arranged vertically one above the other. Columns are
labelled as A, B, C, ..., Z followed by AA, AB and so on .These alphabetical labels appear
at the top of each column.

Row

Fig: 1.12

Column

·

Row:A row is a horizontal line of boxes. Rows are labelled as 1, 2, 3, etc. These
numbered labels appear on the left of each row.

·

Cell: Each rectangular slot or box at the intersection of a column and a row is called a
cell, and is used to enter an individual piece of information.
Address:Each cell is identified by its address or reference. It consists of a column letter
followed by the row number. For example, A2 is the cell address of a cell that falls in
column A and row 2.
Active cell: The area that is currently selected for either data entry or editing is called
the Active cell. It is outlined by a dark border. All of the other cells have a light grey
border.
Range of Cells:A group of neighbouring cells is called a range of cells. A range must form
a rectangle or a square. A range is written by specifying the addresses of the first and the
last cells of the range with a colon in between e.g., A3:B13, to mean all cells between
and including A3 and B13.

·

·

·

Range: A3:B13

Figure:1.13 Range of cells

Creating a Workbook
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Step 1: Choose New > Spreadsheet option from File menu.

Fig 1.14 Creating a Workbook

The Calc window opens ,by default, on the first of the three worksheets .Until saved with SAVE
AS, the file continues to bear the default name Untitled1. The next file in sequence takes the
name Untitled2, and so on.
You can also use keyboard shortcut Ctrl+Nto open a new workbook .
Entering Data
Mainly, a cell can have three kinds of data: Numbers, Text, and Formulas. Text means words,
titles, comments, etc., like ‘school’, ‘9B’. To enter data in a cell, check that the cell is active,
if not, click inside it. As you type, you can see the data in the cell and also on the Formula bar.
Enter
button

Fig 1.15 Entering data

You can complete the entry by clicking the Enter button
Enter key on the keyboard.

on the Formula bar, or by pressing

Entering Formulas
A formula can be a combination of values (numbers or cell references) and math operators (+, -,
/, *) . Formulas perform arithmetic operations and compute a result. All formulas must begin
with ‘=’ sign. The formula needs to be entered into the cell to make it work. For example, if
you want the total of cells A1 and B1 displayed in cell C1, enter =A1+B1 in cell C1 and press
Enter.

Fig 1.16 Formula shows in Formula bar but result in cell.
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For example, in the Calc sheet shown above, the formula bar displays the formula =A1+B1 but
the cell has what you want—the result of the formula.
Arithmetic Operators used in Formulas
Calc has several arithmetic operators. The order of mathematical operations done by operators
is very important. If you enter a formula that contains several operations, Calc knows to work
those operations in a specific order. The order of operations is:
1. Operations enclosed in parenthesis
2. Exponential calculations (to the power of)
3. Multiplication and division, whichever comes first
4. Addition and subtraction, whichever comes first
Using this order, let us see how the formula 16/(8-4)*8-2 is calculated :
1. Operations in parentheses is performed first : 8-4 = 4. Formula becomes 16/4*8-2
2. As division comes before multiplication, divide 16/4 = 4.Formula becomes 4* 8-2
3. Next, multiplication takes place before subtraction : 4*8 = 32.Formula becomes 32-2
32-2 = 30. Result is 30
Saving a Workbook
Every workbook created in Calc must be saved and assigned a name to distinguish it from other
workbooks. The first time you save a workbook, Calc will prompt you to assign a name through
the ‘Save As’ operation. Subsequently Save option of File menu can be used to save changes on
the workbook.
Page preview
Before printing the worksheet, it is a wise step to preview the document using the Page
Preview feature. To do this, select File, Page Preview from the Menu bar to switch to the Page
Preview mode. Click on the “Close Preview” button to close the Page Preview and return to the
main document.
Printing a Workbook
To print a workbook, follow these steps:
Step 1:Choose Print option from File menu.

-8-

NVEQ Level 1

ITCC-104

Fig 1.17 Printing a file

The Print dialog box appears.

Fig:1.18 Print dialog box

Step 2: Choose the printer's name.
Step 3: You can either print all the worksheets or selected sheets by choosing the appropriate
options.
Step 4: Enter the number of copies to print in Number of copies box.
Step 5: Click OK.
Closing a Workbook
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To close a workbook, you can choose Close option from the File menu. If you have made some
changes in the workbook after you last saved it, Calc alerts you to save your work by displaying
a dialog box.

Fig:1.19Calc Alert dialog box

Opening an existing Workbook
You can open any workbook that has previously been saved and given a name.To open an
existing workbook,
Choose File
Open from the menu bar. The Open dialog box opens. Locate the file, select it
and Click the Open button.
Exit Spreadsheet Program
You can exit Spreadsheet program by choosing File>Exit

Fig:1.20 Exiting Calc
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Summary
·
·
·
·
·

Spreadsheet applications (also referred to as Spreadsheets) are computer programs that let
us create and maintain data tabulated in Rows and Columns.
Lines divide the rows and columns up into boxes called cells. A cell can contain text, a
number or a formula.
Columns have a letter at the top and rows have a number at the side.
Individual cells are identified by their cell reference number which contains a column letter
and a row number e.g., A6.
The cell that is currently selected for either data entry or editing is called the Active cell.

Self Assessment
S.No. I am able to…
1
2
3
4
5

Yes

No

Define a Spreadsheet program.
Give 3 examples of popular Spreadsheet programs
Start Calc
Identify parts of Calc window
Define commonly used terms like workbook, worksheet related
with spreadsheets
Create a workbook
Save a workbook
Enter formulas and list priority of operators in a formula
Print a workbook
Exit Calc

6
7
8
9
10

_________________________________________Now I can answer …
1. What is the purpose of a Spreadsheet program? Give examples of any two commonly used
Spreadsheet programs.
2. Define the following terms:
a) Workbook b) Active cell c) Cell reference d)Range of cells

3.
4.
5.
6.

What
What
What
What

is the cell address of a cell that falls in column F and row 12?
will be displayed in the cell if you enter =45+76*2-3 in it?
happens if a formula contains two operators with the same priority?
is the advantage of previewing a worksheet before printing?
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Element 2: Modifying Cells
Moving Cell Contents
There are two ways of moving the contents of one cell to another:
a. cutting and pasting
b. dragging and dropping
a. Cutting and pasting: To move a cell by cutting and pasting, follow steps 1 to 4:
Step 1: Select cell(s) that need to be moved.
Step 2: Choose Cut option from Edit menu or press Ctrl+X, or click button
toolbar.

on the Standard

Figure: 1.21 Moving cell contents

Step 3: Select the cell(s) where the cut cell(s) are to be pasted. Select either the whole range
or only the first cell of the range of cells where the selected cells are to be pasted.
Step 4: Choose Paste option in Edit menu, or press Ctrl+V, or click the Paste button
Standard toolbar.

on the

b. Dragging and dropping:To move cell contents with drag and drop, follow steps 1 to 4:
Step 1: Select the cells to be moved.
Step 2: Place the mouse pointer on the border of the selected cells. It turns into an arrow.
Step 3: With the mouse pointer in the arrow form, drag it to the new location.
Step 4: Release the mouse button. The selected cells moves to the new location.
Copying Cell Contents
The copy and cut/paste operations in Calc are the same as in Writer. They can be picked up
from the Edit menu or from the Standard toolbar.
Inserting and Deleting Cells
New cells, rows and columns can be inserted and unwanted ones can be deleted with the help
of Insert and Delete commands of Calc. If on a sheet a new cell is added, it has to push the
existing ones to create room for itself.
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Inserting Cells
To insert cells follow steps 1 to 4:
Step 1: Select a cell or a range of cells.
Step 2: Choose Cells option from the Insert menu.

Figure:1.22 Select Insert cells

The Insert Cells dialog box appears:

Figure:1.23 Insert Cells dialog box

Step 3: Choose the appropriate option in the above dialog box for Calc to make room for the
inserted cells.
Step 4: Click OK.
Inserting Rows and Columns
To insert a row, click on the row before which a row is to be inserted and then choose Rows
from the Insert menu. A new row is inserted before the active cell.

Figure:1.24 Inserting Rows

To insert a column, follow steps 1 and 2.
Step 1: Click on the column to the left of which a new column is to be inserted.
Step 2: Choose Columns option from Insert menu and a blank column is inserted to the left of
active cell.
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Deleting Cells, Rows and Columns
To delete a cell, follow steps 1 to 3.
Step 1: Click the cell that is to be deleted.
Step 2: Choose Delete Cells from the Edit menu, or right click the cell and choose Delete option
from shortcut menu.

Figure: 1.25 Delete Cells option in Edit menu

Figure: 1.26Deleteoption in shortcut menu

The Delete Cells dialog box appears.

Figure: 1.27 DeleteCells dialog box.

Step 3: In the ‘Delete Cells’ dialog box, options are available for shifting cell left or up. Choose
the correct option and click OK.
Note: To delete an entire column or row, click in any cell in the row/column to be deleted and
choose Delete entire row(s) or Delete entire column(s) in the Delete Cells dialog box. Click
OK.
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The AutoFill feature of Calc fills a range of cells with a sequence of data. You may use it when
you want to have numbers sequentially or in regular multiples like 2,4,6,8 and so on in cells but
you do not want to enter numbers yourself. Completing a series like: consecutive numbers,
numbers that follow a specific pattern, days of week, or dates that follow a specific pattern is a
very simple task with AutoFill. Calc only needs a clue which it takes if you start it once. For
example, type in Monday, Tuesday in adjacent cells, select these two cells. A small black box at
the lower right corner called the Fill handle can be seen.Drag the fill handle to the next cells in
the same direction.

Figure: 1.28 Days of week entered.

Release the mouse button and see that Calc has automatically filled in the other members of
the series.
Note : You can drag the mouse vertically (up or down) and horizontally (left or right). Dragging
down or right counts forward while dragging up or to left counts backwards)

Figure: 1.29 Days of week automatically filled

Autofill is smart enough to generate a series of numbers, months, days, dates, time and
quarters. Some examples are shown below.

Figure: 1.30 Months automatically filled

Figure: 1.31 Dates automatically filled

Summary
·
·
·
·

New cells, rows and columns can be inserted with Insert>Cells option.
Cells, Rows, Columns can be deleted with Edit>Delete cells option.
The Fill handle is a small black box at the lower right corner of the active cell.
The AutoFill feature fills a range of cells with a sequence of data.
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Self Assessment
S.No. I am able to…
1
2
3
4
5
6
7

Yes

No

Move cell contents from one location to other
Copy cell contents to other cells
Insert cells
Delete cells
Insert rows
Delete rows
Use Autofill feature

_________________________________________Now I can answer …
1. Write steps to copy contents of a range of cells into another part of worksheet.
2. Which menu is used to insert a row in a spreadsheet
3. Which feature of Spreadsheets would you use if you want to have numbers sequentially or in
regular multiples in cells but you do not want to enter numbers yourself ?
4. What is a fill handle?
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ELEMENT 3: Formatting a Worksheet
Spreadsheet Programs like Calc have built-in formatting options which allow you to change the
way a spreadsheet looks. Formatting makes the data look more impressive. Some of the more
commonly used cell formatting options are:·
·
·
·
·

Changing font size and style
Making text bold, italic or underlined
Changing text alignment
Adding borders and lines
Adding or changing colour

The Formatting toolbar has buttons for frequently needed formatting options.
Indenting

Bold, Italic, Underline

Font

Font Size

Border

Alignment

Figure: 1.32 Formatting toolbar

For Numeric
Formatting

Fill Color

Font
Colour

Changing font
Font refers to the look of characters in the document.One of the commonly used tasks using the
Formatting toolbar is to change font name, font size, and font style. Calc lets you display text
as bold, italicized, or underlined. To do this, select a cell or range of cells and click on the
option(s) on the Formatting toolbar.

Bold Italics Underline
Figure: 1.33 Changing Font

The following shortcuts may also be applied:
·

Bold button (Ctrl + B).

·

Italics button (Ctrl + I).

·

Underline button (Ctrl + U).

The selected attributes (Bold, Italics, and/or Underline) are applied to the font.
Changing the Font/Font Size
Font style and font size of the text can be changed by choosing the font style and size from the
Menu
Step 1: Select the cell(s) you wish to change.
Step 2: On the toolbar, click the font drop-down arrow to change the font and the font size
drop down arrow to change the font size.
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Figure: 1.34 Changing Font and font size

Aligning Text and Numbers in Cells
By default, Calcleft-aligns text (labels) and right-aligns numbers (values) in a cell to make
data easier to read.

Right
Left Aligned
Figure: 1.35 Default Alignment in a cell

Calc allows you to change the default alignment. You may align text and numbers using the
left-align, center, right-align, and justify buttons on the Formatting toolbar:
Justify

Left align
Centre align

Right align

Figure 1.36: Alignment options on formatting toolbar

Applying Borders to Cells
To apply border to cell(s) follow the steps given below.
Step 1: Select a cell or range of cells.
Step 2: Click on the down arrow that is next to the Borders button.

Figure 1.37: Choosing the Border

Step 3: Choose a border style from the Borders drop-down menu. The chosen border is
applied to the selected cells.
Applying Background color to Cells
To apply background colour to cell(s) follow the steps given below.
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Step 1: Select a cell or range of cells.
Step 2: Click the down arrow that is located next to the Background Color button.

Figure 1.38: Choosing background colour

Step 3: Choose a color from the Background Color drop-down menu.
The selected cells display the color.
Applying Font colour to cells
To apply font colour follow these steps:
Step 1: Select a cell or range of cells.
Step 2: Click on the down arrow that is located to the right of the font color list box.
A drop-down list of available colors appear.

Figure 1.39: Choosing Font colour

Step 3: Click on the color of your choice.
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Note: If the Formatting toolbar is not visible on the screen, choose Toolbars > Formatting from
the View menu.
Formatting Cells using Format Cells dialog box
To apply formatting with Format cells dialog box, follow these steps:
Step 1: Select the cells.
Step 2: Choose Format and then Cells.

Figure 1.40: Choosing Format>Cells

The ‘Format Cells’ dialog box appears. You can see various tabs- Numbers, Font, Font
Effects etc to be chosen for the formatting required. Suppose you choose the Font tab.A
dialog box as shown below is displayed:

Figure 1.41 Format Cells dialog box with Font tab selected.

Choose required formatting and click OK.
Formatting Numbers
You can apply formatting on numbers in cells. For example:
a. the number of decimal places can be altered to one, two, or three, etc.
b. currency symbols can be put before monetary figures,
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Formatting Numbers Using Toolbar Buttons
To format numbers with toolbar buttons, select the cells containing the numbers that are to be
formatted and click the required Formatting toolbar button(s).

Figure 1.42 Numeric Formatting buttons on Format toolbar

The purpose of Numeric formatting buttons on the Formatting toolbar is shown below.
Button

Purpose
Suppose you store the following Numbers in 3 cells in a Calc
worksheet :
-134
560 180.5
See what happens when the following formatting (indicated in
left column shown below) is applied on above numbers.
Shows your numbers with dollar signs and two decimal places.

Currency

-$134.00 $560.00

$180.50

Places a percentage sign after your number,along with two
decimal places.
Percentage
-13400.00% 56000.00% 18050.00%

Default
Number
Format
Add
Decimal
Place icon

If you make mistakes using the other formats and want things to
look the way that they did from the start, use this icon to return
the cell to the standard format.
-134

560

180.5

Adds an additional decimal place for each click of the mouse
button.
After First click :
-134.00

560.00 180.50

After second click :
-134.000 560.000 180.500

Delete
Decimal
Place icon

Deletes a decimal place for each click of the mouse button.
Suppose two times “Add Decimal Place” icon has been clicked,
Now click “Delete Decimal Place” icon :
After First click :
-134.00

560.00 180.50

After second click :
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-134.0

560.0

180.5

You can do Number formatting using Format cells dialog box also. Choose Format > Cells and
then choose Numbers tab. Select how you want the contents of the selected cell(s) to be
displayed. The code for the selected option is displayed in the Format box.

Figure 1.43 Number Formatting

Summary
·

·
·
·
·

Formatting makes the data look more impressive.
The Formatting toolbar has buttons for frequently needed formatting options.
Font refers to the look of characters in the document
By default, Calcleft-aligns text (labels) and right-aligns numbers (values) in a cell to
make data easier to read.
To apply formatting with Format cells dialog box -select the cells and Choose Format
and then Cells.

Self Assessment
S.No. I am able to…
Use formatting toolbar to format data in cells
1.
Align data in a cell
2.
-22-
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Apply border to cell(s)
3.
Apply background color ro cell(s)
4.
Apply font color to cell(s)
5.
Display formatting toolbar(if not visible)on screen
6.
Use Format dialog box to format data.
7.
Format Numeric data.
8.
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_________________________________________Now I can answer …
1.
2.

Give examples of any three types of formatting applied on cells.
Which toolbar is used for frequently needed formatting options?

3.

How does Calc align text and numbers by default?

4.

In what ways can the data be aligned in a cell?

5.

Write the purpose of Currency button

on Formatting toolbar?
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ELEMENT 4 – Types of Cell References
You already know that Calc uses formulas to perform calculations in a spreadsheet.
A formula can be a combination of values (numbers or cell references) and math operators (+, -,
/, *, =) written into an algebraic expression. Calc requires every formula to begin with an
equal sign (=).
To create a simple formula that adds two numbers:
1. Click the cell where the formula will be defined.
2. Type the equal sign (=) to let Calc know that a formula is being defined.
3. Type the first number to be added (75, for example).
4. Type the addition sign (+) to let Calc know that an addition operation is to be performed.
5. Type the second number to be added (25, for example).
6. Press Enter or click the Accept button on the Formula bar to complete the formula.
Formulas can be copied to adjacent cells using the Fill handle. The Copy and Paste method can
also be used to copy formulas to other cells. The cell references in a formula are automatically
updated when the formula is copied to other cells in the spreadsheet. Also you can change the
formula already entered in a cell by double clicking in the cell that contains the formula you
want to revise.Press the Enter key or click the Accept button to let Calc accept the new
formula.
Cell Referencing
You have learnt that when a cell address is used or is referred to in a formula, it is called cell
referencing. Cell referencing can be of three different types:
(i) relative, (ii)absolute (iii) mixed
We shall study relative first because this one is used most in Calc.
Relative Cell Referencing
Three friends Sanya, Abhay and Rama are comparing their marks in three subjects namely
English, Mathematics and Science. Consider the formula =(B3+B4+B5) used by Sanya in Cell B6
for calculating the total marks secured in English ,Mathematics and Science. Now she needs a
similar formula in the cells C6 and D6 for the next two columns.

Figure 1.45 Formula in cell B6

If she simply copies the original formula from B6 to cells C6 and D6, Calc makes the relevant
changes in cell references automatically.
That is, formula is not copied verbatim. Calc interprets the original formula in B6 as: “Take
what is three cells above the formula, add it to what is two cells above the formula and add it
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to what is one cell above.” Calc interprets cell references in formulas as being relative to the
location of formula. This is called relative cell referencing.
Relative Reference : A cell reference is called a relative reference if a cell is referenced in
relation to the current cell.
When the formula in cell B6 is copied to cell C6, Calc shifts all the references one cell to the
right, so that the formula when copied automatically becomes =C3+C4+C5, and when it is
copied to D6, Calc shifts two cells to the right so that the formula in D6 becomes = D3+D4+D5.

Figure 1.46 Formula copied from cell B6 to cell C6 and cell D6

Absolute Cell Referencing
Unlike in relative cell referencing, there may be times when you do not want the automatic cell
address changes to happen in the formula. For instance, if you need to multiply unit price of a
NewsPaper stored in one cell to the total sales over a period in other cells, the cell address of
the unit price should not change. Take this example of a worksheet showing sales of M/s Avon
Newspaper agency at their different branches.
Unit price
stored in cell
B3 should
not change
when
formula
referring to it
is copied to
different
cells.

Figure 1.47 : Absolute referencing is needed to refer to fix cells

Cell B3 has the selling price per NewsPaper which has to remain fixed throughout. Its reference
in any formula must remain B3, not become B4, B5,C4 etc. Both its column and row references
should remain fixed. Any reference to this cell is absolute, and to prevent Calc to change it
automatically you prefix both column and row references with a $ sign. An absolute cell
reference for B3 shall thus be $B$3. The formula in the above example to be entered in F7 shall
be =E7*$B$3. After this, wherever you copy this formula the reference for B3 shall remain fixed.
When copied in cell F8, the formula will change to =E8*$B$3, and in F9 it will become =E9*$B$3
keeping the unit selling price figure same throughout.
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Figure 1.48 : Formula copied to other cells

Absolute cell reference : Absolute cell reference is a cell reference that does not change if you
copy the formula elsewhere in the spreadsheet.
Mixed Cell Referencing
In a mixed cell reference, one of the column or the row references is absolute while the other is
relative. So, $B3 is a mixed reference, because B is absolute while 3 is relative. It will always
point to the same column when the formula is moved or copied to another cell, but the row will
change.
Examples of absolute and Mixed referencing include:
$B$4

Absolute referencing- The column B and the
row 4 do not change when copied.

B$2

Mixed Referencing - The row 2 does not
change when copied.

$A2

Mixed Referencing- The column A does not
change when copied.

Summary
·

Calc uses formulas to perform calculations in a spreadsheet.

·
·

Calc requires every formula to begin with an equal sign (=).
Cell referencing can be of three different types:
(i) absolute, (ii) relative, and (iii) mixed.

· In a mixed cell reference, one of the column or the row references is absolute while the

other is relative
· Relative references (to cells) change when a formula is moved to another cell.
· Absolute references to cells will always refer to exactly the same cell, even if the entire
formula is moved or copied to another cell.
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Self Assessment
S.No.
1
2
3
4
5

I am able to…
Use formula to do calculations.
List the priority of operations when a formula is given
List the 3 types of cell referencing
Use Relative, Absolute, Mixed referencing
State the result of a formula in which different types of referencing Relative, Absolute, Mixed referencing are used

Yes

No

_________________________________________Now I can answer …
1. Name the cell referencing used in the cell references: $A$2 , A2, A$2.
2. Cell E4 contains the formula =E1+E2+E3. How does Calc interpret it?
3. Distinguish between relative cell referencing and absolute referencing.
4. If A1 contains 23, A2 contains 34. What will be result of the formula =A1+$A2 entered in
cell A3? If the formula in cell A3 is copied to B3, what will the formula become?
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ELEMENT 5 – Using Functions and Obtaining Charts
Functions
A function is a pre-defined formula that helps perform common mathematical functions.
Functions save you the time of writing lengthy formulas. For example,You could use a Calc
function called Average to quickly find the average of range of numbers. Or you could use
the Sum function to find the sum of a cell range. Calc allows you to perform many a
different functions. Each function has a specific order, called syntax, which you must follow
strictly for the function to work correctly.
Writing a Function
1. All functions begin with the = sign.
2. After the = sign, define the function name (e.g., Sum).
3. Enclose one or more arguments -- numbers, text or cell references -- with parentheses. If
there is more than one argument, separate each by a comma.
There are many different functions that can be applied to Calc spreadsheets. Some of the more
common functions include:
Function
SUM
AVERAGE
COUNT
MAX
MIN

Purpose
Returns the sum of a range of numbers in the list of arguments
Returns the average of a range of numbers in the list of arguments
Counts how many numbers are in the list of arguments
Returns the maximum value in a list of arguments
Returns the smallest value in a list of arguments (text is evaluated as zero)

SUM function
The SUM function calculates the sum of all the numbers in the list of arguments. The arguments
for SUM may be cell references, constants, or combination of the two. The SUM function ignores
text and blank cells.
Consider the worksheet given below. The SUM function is applied in different ways in cells of
Column F displaying Total Score. In all the rows (Except Row 8) it yields the same result. In row
8, SUM function ignores the text and blank cells and finds the sum of numeric data.
Example:
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=SUM(A3:E3)

=SUM(A4;B4;C4;D4;E4)

=SUM(17;15;10;12;19)

=SUM(A6;B6:E6)

=SUM(A8:E8)

Figure:1.49 : Using SUM function

AutoSum
The AutoSum feature of Calc is a convenient tool for summing the number of a column or a row
quickly.
Here is a column of values depicting Basic salary given to employees of an organization.

Click in empty cell beneath
the column >Then click on
Sum button on the Formula
bar.

Figure 1.50 : Using Autosum feature

To find the total basic salary given to all the employees, follow these steps:
Step 1: Click in the empty cell beneath the column of numbers.
(To add contents of a column, click under the last entry in the column,
whereas to add the contents of a row click in the cell to the right of the last entry in the row.)
Step 2: Click the Sum button

on the Formula bar .
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Step 3: Calc is smart enough to guess the range of cells you want to add. A border appears
around those cells included in the calculation.
A formula also appears automatically on the formula bar.

A Formula appears
automatically.

Figure 1.51 : Formula automatically appears

Step 4: If you are not satisfied with what Calc has guessed, you may select a different range. If
you want to accept the formula, click the formula bar Enterbutton (
), or press Enter key.
Calc shows the sum of values.Here the cell displays 104500. The cell actually stores the formula
=SUM(C4:C8)

Figure 1.52 : Result appears in cell

AutoSum: A tool on the Standard toolbar used to quickly add the contents of a row or a column.
AVERAGE function
The Averagefunction calculates the average, or arithmetic mean, of the arguments. The
formula used is very simple: =AVERAGE(arguments). The arguments can be cell references,
constants, or any combination of these.
The formula for finding averages of different numbers will depend on what arguments are
chosen. The AVERAGE function ignores text and blank cells but not zeroes.
Example:
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Figure 1.53 : Example data in worksheet

If you look at the above spreadsheet , you will notice that cell A6 is blank and A7 has a text
entry. The formula for finding averages of different numbers will depend on what arguments
are chosen. The AVERAGE function ignores text and blank cells but not zeroes.
The table shows in detail how Calc works to arrive at the result of average function for
different cells of worksheet shown above.
Formula

Cells and numbers
under reference

Result

=Average(A1:A5)

A1, A2,A3,A4,A5

5.4

=Average(A1:A7)

A1, A2,A3,A4,A5

5.4 (A6 being a
blank is ignored. A7
being a text entry is
also ignored)

=Average(8;7;A3:A5)

8,7,A3,A4,A5

5.4

=Average(A1:A7;0)

A1,A2,A3,A4,A5,A6,A7,0

4.5 (ZERO is not
ignored)

MAX Function
This function finds the maximum value in a list of arguments.
The MAX function may be used to find the highest marks in a column or row having marks of
students.
Consider the spreadsheet once again.

Figure: 1.54

The Table shows in detail how the different formulas of MAX function produce different results.
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Formula

Cells and numbers under
reference

Result

=Max(A1:A5)

A1, A2,A3,A4,A5

8

=Max(A1:A7)

A1, A2,A3,A4,A5

8 (A6 being a blank
is ignored. A7 being
a text entry is also
ignored)

=Max(8;7;A3:A5)

8,7,A3,A4,A5

8

=Max(A1:A7;10)

A1,A2,A3,A4,A5,A6,A7,10

10

MIN Function
Like the MAX function finds the maximum value in a list, the MIN function finds the minimum
value in the list of arguments. You can use the MIN function to find the lowest marks secured by
a student.
Example:
Considering tha spreadsheet given below and look at the Table that shows in detail which cell
ranges produce what results for the MIN function.

Figure:1.55

Formulas of the MIN function and their results
Formula

Cells and numbers under
reference

Result

=Min(A1:A5)

A1, A2,A3,A4,A5

2

=Min(A1:A7)

A1, A2,A3,A4,A5

2 (A6 being a
blank is ignored.
A7 being a text
entry is also
ignored)

=Min(8;7;A3:A5)

8,7,A3,A4,A5

2

=Min(A1:A7;-2)

A1,A2,A3,A4,A5,A6,A7, -2

-2

COUNT Function
This function counts how many cells contain numbers including formulae with numeric answers.
It ignores blank cells, cells containing text, logical or error values.
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Figure:1.56

Formula

Cells and numbers under
reference

Result

=Count(A1:A9)

A1, A2,A3,A4,A5,A6,A7,A8,A9

6 (A6 being a
blank, A7 being a
text, A9 being an
error are ignored).
Date is counted
as it is stored as a
Number.

=Count(A1:A5)

A1, A2,A3,A4,A5

5

=Count(A1:A7)

A1, A2,A3,A4,A5

5 (A6 and A7 are
ignored)

=Count(8;7;A3:A9)

8,7,A3,A4,A5

6

=Count(A1:A9;-2)

A1,A2,A3,A4,A5,A6,A7, -2

7 (A6 , A7 and A9
are ignored but
A8(Date entry)
and -2 are
counted.

Note : In the above example, date entry 10/16/1967 is counted as a numeric value, as Calc
stores dates as number.
COUNTIF Function
As its name suggests, COUNTIF function counts things. But it counts things if a condition is met.
For example, counting how many students have got an A1 Grade.

-33-

NVEQ Level 1

ITCC-104

Figure:1.57

Formula

Cells and numbers under reference

Result

=COUNTIF(C2:C8;">=75")

C2,C3,C4,C5,C6,C7,C8

5
(counts for
marks 75 and
above)

=COUNTIF(D2:D8;"A1")

D2,D3,D4,D5,D6,D7,D8

1
(counts for
grades as A1)

=COUNTIF(D2:D8;"A2")

D2,D3,D4,D5,D6,D7,D8

2

Accessing Calc Functions using Function Wizard
Till now you have been entering the functions (name and arguments) yourself in cells in a
spreadsheet. There is another way ,that is, using the Function Wizard. The Function Wizard is a
helpful tool that walks you through the steps of generating a Calc Function. Broadly the steps
are :
Select the cell where you want your new formula to appear.
Start the Function Wizard.
Follow the Function Wizard through its dialog boxes.
The above steps in detail are as follows :
Step 1: Select the cell where you would like to define a Calc formula.
Step 2: Click the Function button on the Standard toolbar or choose Insert >Function .
Function button on the
Formula toolbar
Figure 1.58 : Function button

The Function Wizard dialog box appears.
Step3 : Choose the Functions tab.
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Functions tab

Figure 1.59 : Function Wizard dialog box

Step 4 : Select the category from which you wish to have a function.

Choose
Category

Figure 1.60 : Choosing Category

Step 5 : Double Click the desired Function . The dialog box prompts you for the necessary data
and/or parameters to complete the formula.
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Click here to choose
the range of cells
whose average is to
be found.

Choose
Function

Figure 1.61 : Choosing range

Result is displayed
Notice the Function Result field displays the answer as the formula is developed.
here

Figure 1.62 : Result displayed

Step 6: Click the OK button to add the formula to the selected cell.
Error Results
If you have written a formula incorrectly, Calc displays errors. The following table lists some of
the common errors with their reasons.
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REASON

1

#VALUE

Occurs
when
formula
contains invalid data.

2

#DIV/0!

Occurs when a number is
divided by 0.

3

#NAME?

Occurs when a formula is not
recognized by Calc

4

######

Occurs when a column is not
wide
enough
to
accommodate a value

Obtaining Charts
Most spreadsheet packages include facilities for representing information in the form of a graph
or chart. The more common types of charts and graphs that are used are bar charts, pie charts
and line graphs.
A chart wizard is a useful tool that gives step-by-step help when drawing a graph or chart.
The first step in creating a graph or chart is to enter the data on the spreadsheet.

Figure 1.63 Data on spreadsheet
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The next step is to choose the type of chart or graph. A chart wizard can be used to help with
this. To use the chart wizard, Click the Chart Wizard button
via Chart optionon the Insert menu.

on the Standard toolbar, or go

Figure 1.64 Chart Wizard

Follow the instructions of Chart wizard.The graph is automatically drawn by the spreadsheet
software. It can then be copied and pasted into other applications if required.

Figure 1.65: The Chart is based on data

We will study how to draw different types of charts in detail in the next class.

Summary
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· A function is a ready-to-use formula. It requires data, or values, called arguments, which
it uses to calculate results.
· SUM function – Returns the sum of a range of numbers .AVERAGE function – Returns the
average of numbers in the list of arguments.COUNTfunction – Counts how many numbers
are in the list of arguments.MAX function – Returns the maximum value in a list of
arguments.MIN function - Returns the smallest value in a list of arguments (text is
evaluated as zero)
· A pictorial representation of data on a worksheet is called a Chart.

Self Assessment
S.No.
1
2
3
4
5
6
7
8

I am able to…
Yes
State what is a Function
List at least 6 functions used in Calc
Use SUM function in a worksheet
Use AVERAGE function in a worksheet
Use MAX function in a worksheet.
USE MIN function in a worksheet
USE COUNT function in a worksheet
Draw simple charts using Chart wizard based on data given a worksheet.

No

_________________________________________Now I can answer …
1. What is a Function?
2. What is the purpose of arguments in a function?
3. If the formula =MIN(A1:A5) was stored in cell A6. How will it change when copied to cell
B6?
4. What is the purpose of MAX function? Explain with an example.
5. Using the AVERAGE function to find the average of a range, are the blank cells present in
that range counted? Are the cells containing zeroes counted?
6. Anuradha has entered 6 in cell A5 and ‘school’ in cell B5. What will be displayed in cell
C5 if she entered the formula =A5+B5 in cell C5.

You can riseupto

Explore contributions of "Dan Bricklin and Bob Frankston"
Assessment
Multiple Choice Questions
1. Calc is a
A. Spreadsheet program
B. Word Processing program
C. Calculator program
D. Drawing and painting program
2. To edit an entry in Calc:

A. press the F2 key in cell.
B. left-click in the formula bar
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3. In Calc, all formulas begin with ______________sign

A.
B.
C.
D.

+
^
#
=

4. Suppose the formula =SUM(A1:A5) was entered in cell A6. What best describes this formula?

A.
B.
C.
D.

find the sum of cells A1 to A5
find the sum of cells A1 and A5
find the sum of five cells immediately above
none of the above

5. In the formula =SUM(A3:A7), A3:A7 is:

A.
B.
C.
D.

an argument
a formula
a constant
absolute address

6. _________________ references change when a formula is moved to another cell.

A.
B.
C.
D.

Dynamic
Absolute
Relative
Changing

7. _________________ error occurs when formula contains invalid data.

A.
B.
C.
D.

#REF
#INVALID
Relative
#VALUE

Fill in the blanks
1.
2.
3.
4.
5.
6.
7.
8.

Spreadsheets are programs that display data arranged in grids of cells in columns and
____________.
Individual cells are identified by their cell reference number which contains a
______________ and a row number.
By default, each workbook has ______ worksheets.
A group of neighbouring cells is called the __________________________ .
A _____________ entry is automatically aligned to the left side in a cell, and a
________________entry towards the right.
Formatting can be done using toolbar or ____________________ dialog box.
The _____________ is a small black box at the lower right corner of the active cell.
The _______________ feature fills a range of cells with a sequence of data.
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9.
A cell reference is called a ___________________ if a cell is referenced in relation to
the current cell.
10.
In a _____________cell reference, one of the column or the row references is
absolute while the other is relative.
11.
Pictorial representation of data on a worksheet is called a _______________.

Questions with short answers
1.
2.
3.
4.

What is a Spreadsheet program? Name 3 spreadsheet programs.
What is OpenOffice.org Calc?
Write three ways by which cells can be formatted
How can we get the Formatting toolbar if it is not visible on the screen?

5. Is there any difference between the formulas =a1+b1 and =A1+B1?
6. What will be the result of the formula =-21+4*(2+1)?
7. Given below is a worksheet with numbers entered in the first row. Different Number
formatting are applied to second, third and Fourth rows. Identify the formatting applied
to the data in three rows.

8. How can we insert cells and row(s) in a worksheet?
9. How can we delete cells in a worksheet?
10. Write the results of the following expressions entered in a cell.
a. =7 - 2 ^ 2 / 4 * 2
b. = (7 – 2) ^ 2 / 4 * 2
11. Name the cell referencing if the cell references are: $A$2 , A2, A$2.
12. Which type of cell reference changes when copied to other cells?
13. What is the difference between relative and absolute cell referencing?
14. What is a function?
15. What is the purpose of arguments in a function?
16. What is a Chart? How can you draw a chart quickly for a given data on a worksheet?

Case based problems
1.

Worksheet shown below shows Unit price of different items in a Computer Store. Write
commands for operations (i) to (v) based on the spreadsheet below. The sales tax is
levied at 5% of the total price.
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B

C

D

Company Unit Price of Unit
Unit
Code
MotherBoard Price of
Price of
Keyboard Monitor

2

C01

14000

1500

4000

3

C02

13000

2000

3000

4

C03

13500

1600

2500

5

C04

12000

1300

2000

6

C05

15000

1200

3600

E

F

G

Total
Price

Sales
Tax

Net
Price

(5% of
the
total
price)

i) Calculate and display the total price for each company.Total price is the sum of
Motherboard’s, Monitor’s,Keyboard’s price.
ii) Calculate the sales tax (5% of total price) for each company.
iii) Calculate the net price as the sum of total price and sales tax for each company.
iv) Calculate the average unit price of motherboard, keyboard and monitor and display
it in appropriate cells in Row 7.
v) Find out the highest price and the lowest price of motherboard, keyboard and
monitor and display it in appropriate cells in Row 8 and 9.

2. Given below is a spreadsheet showing sales achieved by M & M company that sells different
types of computers.

Do the following:
I. Calculate total sales of each type of computer and display in column F.
II. Calculate highest sale in each month and display it in 10th row.
III. Calculate lowest sale in each month and display it in 11th row.
IV.
Calculate total count of Sales figures in the above worksheet (Sales figures in B3:E5) and
display it in cell B12
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3. Create your personal budget for this month. A sample worksheet with partly filled data is
shown. Use formulas to find:
i) The total planned Expenditure thismonth.Display it in cell B12.
ii) The savings this month. Display it in cell B13

Suggested Reading
Reference books
·

Using OpenOfficeCalc 3 by Chris Deane

Websites
·
·
·

http://www.tutorialsforopenoffice.org/category_index/spreadsheet.html
http://www.learnopenoffice.org/CalcTutorial17.htm
http://www.learnopenoffice.org/calccontents.htm
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DIGITAL PRESENTATION
Pre-requisite: Unit II Level I
Element
No.

Element Name

Total
Hours

1

Basics of a Digital Presentation

30

2

Inserting, Duplicating and Deleting Slides

3

Formatting Slides

4

Inserting Pictures, Tables and Hyperlinks

5

Setting up Slide Show and Printing Slides

Ignite Mind
"The audience only pays attention as long as you know where you are going"

Philip Crosby

Learning Objectives
After studying this unit the students will competencies to:
·
·
·
·
·

Work on a digital presentation
Insert, duplicate and delete slides(s) in a presentation
Format a presentation
Insert picture, table and hyperlink
Setup a slide show and print slides of a presentation

Introduction
Consider you want to tell your grandparents about your school, if you simply speak
about it, it becomes boring. How will you make it interesting? If your narration is also
supported by a set of pictures and sound, it becomes more attractive. You can write
about your school along with colourful pictures of your school, your friends and the
various activities that you learn. You can even add some sounds to it! Let us see how
we can do this! This can be done using an application which will help you to present
information in the form of a slide show.
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The Impress component of the Open Office combines both visual and verbal elements
to make presentations easier to understand for the audience. The way we "present"
our message decides how effective and well received it will be. The most popular uses
of digital presentations are in modern day learning, corporate training sessions,
business and marketing meetings, and sales gatherings. Even the normal teaching or
training becomes interactive by just using presentations in lectures. These days
school, colleges and institutions are using this powerful tool to provide tailor made
presentations to students for different topics of the syllabi of study which makes
learning easier, interactive and effective for students. In this Unit we are going to
learn how to use a presentation application to create simple presentations.

Resource Requirements
Hardware
·

A working computer system

Software
·

A Presentation Application (Preferably OOo Impress)
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Suggestions for Effective Teaching
·
·
·
·
·
·
·
·

Encourage peer learning in Computer Lab
Ensure that students follow standard procedures to logon/logoff a computer.
Ensure the proper connectivity of I/O devices
Encourage students to explore opportunities as IT Professionals
Introduce how to integrate IT Tools with traditional practices at various work
places
Encourage students to follow best practices such as taking backup of files, turning
off devices when not in use
Educate students to keep storage media virus free
Sensitize students on ethical and health related issues
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Element 1: Basics of a Digital Presentation
Each page of a digital presentation is called a slide. A presentation is a collection of
slides or pages arranged in a sequential manner to convey information in an attractive
manner. Each page you create can contain text, images, tables, charts, pictures and
other items to help you express your facts, findings, ideas, etc. through visual
medium. OpenOffice.org Impress (abbreviated as OOo Impress) is a software package
which enables you to prepare a digital presentation on any topic.
The first step of creating a presentation is to organize your thoughts. Once you know
what to present, then you can decide how to use Impress as a tool to communicate
your ideas and put them in the form of slides or pages. Next, create an outline of the
presentation. The next step is to break your outline into slides. Now the planning
stage is over and you can launch Impress to start making the slides.
To launch OpenOffice.org Impress and create a new presentation, select Start -> All
Programs->OpenOffice.org->OpenOffice.org Impress as shown in Figure 1.1.

Figure 1.1 Launching OOo Impress
Alternatively, you can startup Open Office by clicking on its icon on the desktop. A
welcome screen of OpenOffice.org opens as shown in Figure 1.2. To open OOo
Impress, you can directly click on the Presentation icon or click the File menu item
and select New -> Presentation from its options as shown in the Figure 1.2.
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Figure 1.2 Welcome Screen of OOo
Creating a New Presentation
Once the Impress application is selected, an Autopilot window named “Presentation
Wizard” will be opened as shown in Figure 1.3. This Wizard will guide you step by
step in creating the Presentation. The autopilot is a series of screens that will allow
you to quickly set various options for your new presentation.
From here we have 3 choices as
illustrated in Figure 1.3
· Empty presentation – It
creates
a
new
empty
presentation from scratch
· From template – It uses an
inbuilt sample presentation
design as the base for
creating
the
new
presentation
· Open existing presentation –
It opens an already existing
presentation and allows you
to continue working on it.

Figure 1.3 Presentation Wizard
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Choose the option to create an empty/ new presentation. You should choose the
option “from template” when you do not have the time to decide on appropriate
backgrounds and colour schemes. Templates make the work faster as you can inherit
the look and feel for your new presentation from an existing presentation. You can
choose any predesigned template from the list of available templates.
Selecting design and output medium
The next window of the Presentation
Wizard allows you to select the
presentation background from a list of
existing
backgrounds.
Once
the
background is selected, you can select
an output medium. For example, if you
want to view the presentation on the
monitor, then select Screen (Figure
1.4). After selecting the output medium
click on Next.
Figure 1.4 Selecting slide design and output medium
Adding Transition Effect and Timing
Slide transition is the visual motion
when one slide changes to the next
during a presentation. Transitions range
from a simple Cover Down, where the
next slide covers the current one from
the top of the screen, to a Wheel
Clockwise where the new slide spins in
like spokes on a wheel to cover the
previous one. In the next screen of the
Presentation
Wizard,
choose
the
transition effect to be added between
two slides.
Figure 1.5:Selecting transition effect
You can also have slides dissolve into each other, push each other off the screen, or
open up like horizontal or vertical blinds. As soon as you select any transition from
the Effect drop down list, a preview will be shown if the Preview check box is
checked. Keep previewing the effects until you find a transition that you like. You can
select ‘No Effect’ if you do not want any transition effect (Figure 1.5). Transitions
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can be added and changed later. You can also select the speed of the transition effect
using the Speed drop down list.
The second part of this Wizard window allows you to select the presentation type.
Choose Default option to advance each slide manually on mouse click. Choose
automatic if you want the presentation to run automatically by setting the time
duration. Both these steps are optional so for now you can choose the default options.
Once you have made the necessary selections, click on “Create” button to end the
AutoPilot.
Impress Interface
OpenOffice-Impress has a Menu bar and Tool bar which will help you in creating the
presentation. Apart from the menu and tool bars, the Impress interface includes four
major areas, as shown in Figure 1.6.
Different View
Modes

Task Pane: View
different panels
to perform
various actions
on the current
slide

Main
Slide Pane:
View thumbnail
images of slides

Slide
Workarea

Figure 1.6 Elements of a OpenOffice Impress window
The Slide Pane in the left hand area shows the reduced image (thumbnail) of all the
slides in the opened presentation. The Task Pane in the right hand area contains tabs
for all styles, Layouts and tasks you can use for each slide in the presentation like
Slide Transition, Custom Animation. The central area shows the contents of the
selected slide and is used for designing one slide at a time. At the top of the central
area is the view tab which contains five different view options available in Impress for
viewing the presentation.
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Master Views
Impress provides five different views called Master views. These are Normal, Outline,
Notes, Handout and Slide Sorter views (Figure 1.7). Each view has a particular
purpose and advantage. A view can be accessed by clicking the corresponding tab
above the main workarea of the Impress window. Let us now try to understand the
purpose and advantages of different type of views.

Figure 1.7 Master views
1. Normal View: It is also known as the Slide view. It is the main working view
and is used to create and edit all the slides of a presentation. The slide area is
largest in this view.

Figure 1.8 Normal view of a slide
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2. Outline View: It shows the text of all
the slides in an outline form. This view
helps to develop and organize the
structure of a presentation. No graphics
are shown in this view. The titles and
the text can be added or changed by
clicking to the left of any text outline.

F
igure 1.9 Outline view
3. Notes View: It allows you to add notes about the slides. The notes will not be
shown in the presentation, but can be
printed out prior to the presentation for
the speaker to use as a reference. To
add notes to your presentation:
Step 1 Click on the Notes tab.
Step 2 A frame at the bottom of the
window labeled "Click to add
notes" appears.
Step 3 Click once in this window to add
text.

NOTES
AREA

Figure 1.10 Notes view of a slide
4. Handout View: It enables you to print a
number of consecutive slides on one
page. You can adjust the number of
slides that can fit in a single printed
page. A handout can have 1, 2, 3, 4, 6
or 9 slides per page. You can even add
headers and footers. Headers and
footers are used to add same
information on every slide of a
presentation without actually typing the
information on each slide. The
information to be shown at the top of
-9-
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each slide is included in the header area while information to be shown at the
bottom of each slide is included in the footer area. To choose a handout design:
Step 1 Click on the Handouts tab.
Step 2 Choose the Layout tab from the task pane to view the different available
handout layouts.
Step 3 Choose the desired layout.
5. Slide Sorter View: It shows the preview
of all the slides as thumbnails. In this
view you can insert, delete, copy and
rearrange the slides You can even
change the slide layout and transition
effect in this view. To rearrange the
slides in "Slide Sorter" view:
Step 1 Click on the Slide Sorter Tab.
Step 2 To rearrange slides, click on the
slide you wish to move, hold down the
mouse button, and move the object to a
new location in the presentation
(between slides, at the beginning or at the
Figure 1.12 Slidesorter view
end). Lift up the mouse button when you are satisfied with the new location. A
vertical line between the slides indicates the position to which you are moving the
slide.
You can also select a particular
view by choosing the appropriate
option from the View menu.
Saving a Presentation
In order to save a presentation in
the Impress format (.odp), follow
some simple steps.
Step 1 Select File->Save As (for first
time save. Consequently just
choose File->Save).
Step 2 A Save As dialog box opens
as shown in the Figure 1.13.
Step 3 Type in the name of the file
in the File Name text box.
Step 4 Click Save.

Step 3

Figure 1.13: Saving a file
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You can also save the presentation in other formats by selecting the desired format
from the Save as type drop down list. Impress also has an option of exporting the
presentation to a PDF (Portable Document Format). A PDF enables you to create a file
in a format which can be viewed by others with the help of Adobe Acrobat Reader but
cannot be edited.
You can save your presentation in pdf file by following the steps given below:
Step 1: Select File > Export as PDF.
Step 2: Select the directory in which you wish to save the file.
Step 3: Enter a file name.
Step 4: Click Save.
Opening an Existing Presentation
In order to open an existing
presentation, perform the following
steps:
Step 1 Select File->Open.
Step 2 The Open dialog box appears
as shown in Figure 1.14
Step 3 Select the file to be opened
from its appropriate folder.
Step 4 Click on Open.

Figure 1.14: Opening an existing file
Closing a Presentation
In order to close a presentation, follow the steps given below:
Step 1 Select File->Close. If the current file is not yet saved, Impress will display a
dialog box with Save and Discard options as
shown in Figure1.15.
Step 2 Select Save if the presentation has to
be saved and then follow the steps used to
save a presentation. Select Discard if the
presentation is to be discarded.
Figure 1.15: Saving a modified file
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Select Cancel to return to the file without closing the presentation.
Using Help functions
The Help function of OpenOffice.org provides a solutions to the problems that you
might face while using the Impress. You should use this facility as a guide and to find
solutions to your problems. Click on the Help button
on the toolbar. The Help
dialogue box will open. It has the Contents and Index sections which will help you in
accessing to the solutions (Figure 1.16). The Contents tab is the same as the table of
contents at the front of a book. It organizes entries by function. You just need to
Click on the Contents tab. Each book represents a major section. The Index tab
functions in the same way as the index at the back of the book. It provides an
alphabetic listing of topics. Just Click on the Index tab and type a term that you are
interested in into the Search term window.

Figure 1.16: Help function dialogue box
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Exiting Impress
To close all open presentations and exit Impress go to File >Exit (Figure
1.17). Impress will ask you if you wish to save the open presentations
before exiting. Save or discard the changes as desired. Alternatively you
can click on the cross button
window.

in the right hand corner of the Impress

Figure 1.17: Help function dialogue box

Summary
·
·
·
·
·
·
·
·
·
·

Impress is a presentation software of OOo suite.
A presentation is a collection of slides arranged in a sequential manner to
provide information on a topic
A slide is a single page of a presentation
Slide Pane, Task Pane, Slide Area, View Area are four most essential interface
elements of Impress screen
Impress provides five different Master views namely Normal, Outline, Notes,
Handout and Slide Sorter
Open Office Impress saves a file with an extension “.odp”.
The Presentation Wizard helps create new presentation, create a presentation
using a template or open an existing presentation.
Templates are the set of predesigned formats that include text, layouts, colour
schemes, etc.
The autopilot is a series of screens that will allow you to quickly set various
options for your new presentation
Headers contain text to be added at the top of every slide and footers contain
text to be added at the bottom of every slide in a presentation
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Self Assessment
S.No. I am able to…

Yes

1

Open and close a presentation

2

Identify and set values in various autopilot screens

3

Select slide design and output

4

Use a template to create a new presentation

5

Save a newly created presentation in the specified location

6

Save a presentation in .pdf format

7

Demonstrate the use of different types of views for specified
tasks
Start and Exit Impress Application

8

No

_________________________________________Now I can answer …
1.
2.
3.
4.
5.

Which component of Open Office is used to create simple and appealing presentations?
Name any two parameters that can be set using the Presentation Wizard.
What is the default view that allows you to create and edit slides?
What is the default extension of an Impress presentation?
Name the view that displays the slides of a presentation as miniature representations
of the actual slides.
6. Which file format will you choose to save a presentation which can only be viewed but
cannot be edited?
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Element 2: Inserting, Duplicating and Deleting Slides
After learning the basics, it is
now time to start adding
elements to the presentation.
Choose the title slide layout.
The title slide comprises of two
areas, one for the title and one
for additional text, for example
Name of the Presenter and
address. If you click on one of
the areas, the message in it will
disappear and you can begin
typing your text.

Figure 1.18: Title slide
Entering Text
Text can be entered and edited in the Normal View. If you choose the layout with a
text box placeholder, then you can straight away start typing in the text box.
Placeholder is a box with dotted or hatch marked borders that is part of most slide
layouts. Alternatively, it is possible to create a new text box by clicking on the Text
icon. Click on the icon, then drag to create a text box as shown in Figure 1.19.
Release the mouse button and then start typing. A text box can be inserted anywhere
on a slide.
Text Icon

Text Box
Figure 1.19 Adding a Text Box
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A text box can be treated as an object like a graphics image and can be dragged to
different positions on the slide. It can also be resized. The text can be formatted in
the same way as text in a writer document file.
Deleting Text
In order to delete text, highlight the text you want to delete by dragging the cursor
over the letters, and pressing the delete key. Alternatively, click on the selection
rectangle around the text so that its border changes from hatch marks to one with
handles, and then press the delete key.
Changing Case
You can change the case of the letters in a text by selecting Home>Change Case (Aa)
from the Font menu bar. The following options are available:
· Sentence case: Capitalizes the first letter of the first word in the sentence.
· Lowercase: Changes the letters to lowercase.
· UPPERCASE: Changes the letters to uppercase.
· Title case: Capitalizes the first letter of every word and the rest to lower case.
· Toggle case: Changes the first letter of every word to lowercase and
capitalizes the remaining letters.
Aligning text
You can align text within a text box along the margins in the same way that it can be
aligned in tables and pages of a document page. Click anywhere in the text and click
the appropriate icon on the Text formatting toolbar.
· Click anywhere inside the text box.
· Click on the icon of left, centre, right or justified alignment on the formatting
tool bar to align the text.
Inserting a new slide
To add a new slide to the presentation, choose the Insert > Slide option as shown in
Figure
1.20.
By
default the new slide
will have the same
layout as the previous
one. You may choose
any other layout for
the new slide from the
left hand pane.
Figure 1.20 Inserting a New Slide
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There are many alternate ways to insert a new slide as illustrated in Figure 1.21.
Method 1
Click on the Slide
button on the right
side of the toolbar
to add a new slide
to your presentation
Method 2

Method 3

Right-click on the Slides pane and select
New Slide from the pop-up menu (works in
Normal, Outline and Notes view) as shown
or Right-click on the main work area in Slide
Sorter view and select New Slide from the
pop-up menu.

In order to add a
slide in between
two slides, follow
these steps:
Step 1 Right Click
in
the
Blank Area between two slides in the
Slide pane towards left side of the
screen.
Step 2 Click on New Slide option as shown.
Step 3 A Blank Slide will be inserted between
the two slides as shown.

Figure 1.21 Alternative Methods of Inserting a New Slide
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Copying a Slide
While creating presentations, it is sometimes required to copy and paste certain slides
from a different presentation or from the same presentation to a different location.
In order to Copy a slide, follow the given steps:
Step 1 Select the slide which has to be copied.
Step 2 Right click the selected slide to be copied and
click on Copy from the popup menu.
Step 3 Right click the selected slide where the copied
slide is to be pasted and click on Paste from the popup
menu.
Step 4 A dialog box appears as shown in Figure 1.22
which prompts you to choose where you want to insert
the copied slide (i.e. before or after the selected slide)
Step 5 Choose the desired location and press OK.

Figure 1.22 Copying and Pasting a Slide
Duplicating a Slide
Duplicating a slide is another technique that you may require as you work on creating
presentations. For example, you may want to repeat a slide later in the presentation
with slight changes to make a different point to
the audience. When you duplicate a slide, you
make an exact copy of it. The quickest way to
add slides to an existing presentation is to
duplicate the slides. Duplicating a slide can be
done in Normal View.
Figure 1.23 Duplicating a Slide
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To duplicate a slide follow the given steps.
Step 1 Select the slide which has to be duplicated by clicking on it in the Slide pane
Step 2 Select Duplicate Slide option from the Insert menu as shown in Figure1.23
Step 3 Impress immediately inserts a duplicated slide just below the original slide and
is displayed in the work area.
Notice that the newly inserted slide would take the next sequential slide number in
the presentation.
Duplicating a slide is a good way to prevent having slides with too much information
crowded on them. Try duplicating the overcrowded slide and split the points over two
or more slides. All the formatting, backgrounds and so on will be preserved.
At this point it is important to understand that there is a major difference between
copying a slide and duplicating a slide. To add a slide that contains the content of an
existing slide in a presentation, you can duplicate the slide. The duplicated slide is
inserted directly below the slide that you selected and has the same theme and
content as the original slide. On the other hand, when you copy one or more slides
from a presentation, and then paste them to a location either within the same
presentation or to another presentation, you can specify the theme that you want the
new slides to adopt. When you paste a slide, it inherits the theme of the slide that
precedes it. However, if you copy the slide from another presentation that uses a
different theme, you can retain that theme when you paste the slide into a different
presentation.
Moreover, duplicate works on one slide and you do not need to paste the slide; it will
take paste action automatically. On the other hand while copying it is possible to
copy more than one slide in one shot and then the paste option is mandatory.
Changing the order of slides
To change the order of the slides, you need to go to the Slide Sorter view, which
shows thumbnail pictures of each of your slides. This view allows you to quickly view
your slides and rearrange them if necessary. To change the order, follow the steps
given below:
Step 1: Click on the slide you wish to move.
Step 2: Drag the slide to the new location.
Step 3: A black, vertical line appears as you drag the slide. When the vertical line is
in the correct location, release the mouse.
Step 4: The slide moves to this new location.
-19-

NVEQ Level I

ITDC-105

Deleting slides
You can delete the slides in two ways:
(i)

To delete a slide, select the slide to be deleted in the Slides pane on the left of
the screen. Press the Delete key on the keyboard. The remaining slides will
renumber themselves appropriately. Alternatively, you can use the Slide sorter
view to delete the slides.
(ii) Switch to Slider sorter view by clicking on the Slide Sorter tab just above the
slide or choose View>Slide Sorter from the menu. Click on the thumbnail version
of the slide you wish to remove and press the Delete key on the keyboard. The
remaining slides will renumber themselves appropriately.
It is also possible to delete slides that are not in sequential order. To do this first
select all the slides to be deleted keeping the CTRL key pressed. Then press the
delete key on the keyboard.

Summary
·
·
·
·
·
·
·

Placeholders are the boxes with dotted borders capable of containing different
content.
Sentence case, lowercase, uppercase, title case and toggle case are options
available for changing case in the Format menu
Various alignment options namely left, right, centered and justified are
available to align text in a textbox
You can insert new slides anywhere in a presentation
You can make any number of copies or duplicates of an already created slide
Copying a slide is different from duplicating a slide
You can change the order of the slides or delete slides from a presentation

Self Assessment
S.No. I am able to…

Yes

1

Insert new slide at the end in a presentation

2

Insert a new slide in between two slides in a presentation

3

Create a duplicate of a slide

4

Copy a group of slides and paste them in a new location within
the same presentation

5

State the difference between copying and duplicating a slide
-20-
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6

Delete selected slide(s) from the presentation

7

Rearrange the order of slides

_________________________________________Now I can answer …
1. Mention any two ways to add new slides in a presentation.
2. If you want to use 3-4 slides of Presentation A in Presentation B then which option will
you use – copying or duplicating?
3. If you duplicate slide number 7 then what will be the number of the new slide?
4. Which view is ideal to change the order of slides?
5. Is it possible to delete slides that are not in sequential order? Explain how?
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Element 3: Formatting Slides
Changing Slide Background

Step 2

To change the slide background
Step 1 Select "Page..." from the
Format menu
Step 2 Click on the Background
tab.
Step 3 Choose the type and style
of background desired.
Step 4 Click OK.
Step 5 A message box appears
asking: "Background settings for
all Pages?" Click Yes if you would
like the background to appear on
all the pages, or No if you would
like the background to only
appear on the selected slide.

Step 3

Step 4

Step 5

Figure 1.24 Changing Slide Background
Changing Slide Properties
To change the slide properties and margins
Step 1Select "Page..." from the Format menu
Step 2 Click on the Page tab.
Step 3 Choose the paper format according to the desired size of the slides.
Step 4 Choose the page orientation.
Step 5 Set the slide margins – left, right, top and bottom
Step 6 Choose the Slide name format (Slide 1, Slide 2… or Slide A, Slide B….)
Step 7 Click on OK
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Step 2
Step 3

Step 4
Step 6
Step 5

Step 7

Figure 1.25 Setting Slide Properties
Docked and Floating Toolbars
A docked toolbar is one which is fixed along an edge of the window while a floating
toolbar is one which is not fixed along any edge and can be moved from one place to
another. To convert a docked toolbar to a floating toolbar and vice-versa: Control +
double click a blank area of the toolbar. To dock a toolbar at a different edge,
Control+ drag the floating toolbar to the desired edge. To move a docked toolbar,
click on its handle and drag it to the new location.

Docked
Toolbars

Toolbar
Handle

Floating
Toolbar
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Drawing toolbar
Some of the icons on the Drawing toolbar are as follows:
1.
2.

Selection: It allows you to select objects in the current document.
Text: Long-click this icon to open the Text floating toolbar using which you can add
and place text anywhere on the current document and control it’s formatting.
Rectangles: To add rectangular shapes to the current slide.
Ellipses: To add ovals and circles to the current slide.
Curves: It contains icons for drawing lines.
Lines and arrows: It allows you to add straight lines, lines with arrows, and dimension
lines to the current slide.
Connectors: A connector is a line that joins objects, and remains attached when the
objects are moved. You can add connectors to objects in the current slide. If you copy
an object with a connector, the connector is also copied. There are four types of
connector lines:
• Standard (90-degree angle bends)
• Line (two bends)
• Straight
• Curved
Effects: It modifies the shape, orientation or fill of the selected object(s).

3.
4.
5.
6.
7.

8.

The icons on the drawing toolbar can be used to draw different types of shapes, block arrows,
stars and flowchart symbols.

Formatting Text
Using the text formatting toolbar, it is possible to change the
·

·

text attributes of the entered text like changing the font size, colour, making it
bold, italicized or underlined as learnt while working with Open Office Writer
documents.
character attributes (like character spacing, positioning, font effects and

·

position) by clicking on the character button
and
paragraph attributes (like indents and spacing, alignment and tabs) by clicking
on the Paragraph button

.
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All these options are available on the Text formatting toolbar as shown in the
following figure. If a toolbar is not visible choose View > Toolbars > Text Formatting.
Common Text
formatting features

Alignment Options

Bullets and
Numbering Options

Font Size Grow
and Shrink Options

Character
Button

Paragraph
Button

Figure 1.26 Text Formatting Toolbar
To add text of different styles for headings use the Fontwork Gallery tool
(Figure 1.27). This tool is present on the Drawing tool bar. To create text of different
styles using the Fontwork Gallery follow the given steps:
Step 1 Click on the fontwork tool to open
the fontwork gallery with a group of
predefined font styles.
Step 2 Choose the desired style. Editable
text in the desired style appears on
the slide.
Step 3 Double Click on the editable text and
type in the desired text.
Step 4 Click anywhere outside, your word
would appear in the chosen style on
the slide.

Figure 1.27 Text Formatting Toolbar
Insert Bullets and Numbering
The procedure to create a bulleted or numbered list varies depending on the type of
text box used, although the tools to manage the list and customize the appearance
are the same. In text boxes created automatically by Impress (called AutoLayout),
the outline styles available are by default bulleted lists, while for normal text boxes
an additional step is required to create a bulleted list.
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Every text box included in the available
layouts is already formatted as a bulleted
list, therefore to create a bulleted list in
AutoLayout text boxes simply perform:
Step 1 From the Layout pane select a
design with a text box.
Step 2 Click in the text box that reads
“Click to add an outline”.
Step 3 Type the text, then press Enter to
start a new bulleted line.
Figure 1.28 Bullets and numbering dialogue box
To create a list in a text box inserted using the Text icon, follow the given steps:
Step 1 Place the cursor in the text box.
Step 2 Click the Bullets On/Off button in the text formatting toolbar
Step 3 Type the text, then press Enter to start a new bulleted line.
To customize the appearance of a list, change the bullet type or numbering type
choose the Bullets and Numbering option from the Format menu. The Bullets and
Numbering dialogue box opens as shown in Figure 1.28.
Keep
·
·
·

the following points in mind while working with bullets and numbering:
Press Shift + Enter to start a new line without creating a new bullet or number.
Each time you press tab the line indents to the new outline level.
Pressing Enter creates a new line at the same level as the previous one.
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You can change the bullet
type for any of the list items
using
the
Bullets
and
Numbering
dialogue box.

Step 2

Slide Transitions
Slide transitions are
the effects that take
place when a slide
gives way to the next one in the
presentation. You can apply the
same transition effect to all slides
in the presentation or apply
different transition effects to
different slides. To add Slide
transition follow the given steps:

Step 3

Step 5

Step 1: Select "Slide Transition"
from the "Slide Show" menu to open
the Slide Transition task pane to
the right of the screen
Step 2: Scroll through the list of
available style transitions and
choose the most appropriate one.
You can view the preview of the
effect by selecting the Automatic
Preview checkbox.

Step 4

Figure 1.29 Slide Transition dialogue box

Step 3: Choose a speed for the transition. You can also select a sound that will
activate when the slide changes but this is optional.
Step 4: Click on Apply to all Slides button near the bottom of the task pane to apply
the same effect to all slides.
Step 5: To set slides to advance after a set time, click on the Automatically After box
and set the time using the up and down arrows. Alternatively click on the On mouse
click option to manually advance the slides.
Animation Effects
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Animations are similar to Transition effects, but they are applied to individual
elements within a single slide. Animation effects must be applied from Normal View.
To add an animation effect :
Step 1: Select the object and then choose "Custom Animation" from the "Slide Show"
menu or click on the Custom Animation tab in the Tasks pane.
Step 2: Click Add to open the Custom Animation dialog box. The Choices in the dialog
box may vary depending on the selected object; for example, pictures and text have
different Emphasis choices. The dialog box has various tabs.
Step 3: Choose the appropriate option as explained below:
· To choose the animation to be applied when the object is placed on the
screen, use an effect from the Entrance tab, for example Fly In or Dissolve In.
· Use the Emphasis tab to apply an effect that changes the font color or applies
special effects to the text such as blinking text.
· To choose the effect to be applied when the object is leaving the page, use the
Exit tab.
· If you want the object to move along a line or curve, select an animation from
the Motion Paths page.
Choose an effect from one of the pages of this dialog box and choose the speed and
duration of the effect
Step 4: Click OK to save the effect and return to the Custom Animation page.
Step 5: Choose how to start the animation effect. You have three choices for starting
an animation effect:
· On click—the animation stops at this effect until the next mouse click.
· With previous—the animation runs at the same time as the previous animation.
· After previous—the animation runs as soon as the previous animation ends.
Step 6: Choose the Speed
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Step 2

Step 3
Step 5

Step 6

Step 4

Figure 1.30 Custom Animation

Using Master Page
The slide master or a Master Page is a slide that contains elements that are common
to all slides to have a uniform look throughout the presentation. You can insert
pictures, images, draw objects onto a master page and the same will appear on each
page of the presentation that uses that master page. A presentation can have more
than one Master Page.

Summary
·
·
·

Slide Background and Properties can be changed using the Page Setup dialog
box
Textbox is a placeholder where you can insert and manipulate text
Fontgallery is used to add text in different styles
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Bulleted and numbered lists can be created using the Bullets and Numbering
option of the Format menu
A slide master is a slide that controls the basic formatting of all slides based on
it
Slide transitions are the effects that take place when a slide gives way to the
next one in the presentation.
Custom Animation effects can be added to individual slide elements

Self Assessment
S.No. I am able to…

Yes

1

Format text added on a slide using the Text formatting toolbar

2

Add stylish text using the font work gallery

3

Change the background of selected slides

4

Set slide properties

5

Create bulleted and numbered lists

6

Add transition effects to different slides of a presentation

7

Add custom animation effects to different elements of a slide

No

_________________________________________Now I can answer …
1. Name any three icons available on the text formatting toolbar.
2. Name the most appropriate way to display the names of all the items of a first aid kit
on a slide?
3. Is it possible to change the default placement of a toolbar?
4. What is the role of the slide master?
5. State the difference between transition and custom animation.
6. Create the following text using the text formatting toolbar
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Element 4: Inserting Pictures, Tables and Hyperlinks
Inserting a Picture
Graphics are used to enhance the presentation. To insert a picture follow the given
steps:
Step 1: Choose the Insert > Picture > From File option
Step 2: Select the file from which a picture is to be inserted
Step 3: Click "Insert". The picture will appear on the current slide.
Resizing & Rotating a picture
Once the picture is inserted onto the slide, you can click on it to select it. Once
selected, you can move it around the slide with your mouse, resize it (by dragging one
of the little green boxes along the sides),
or delete it by pressing the Delete key.
You can also rotate the picture using the
Rotate button available on the drawing
toolbar.
Adding 3D Effects
You can even convert a normal picture to
3D graphic and then add various 3D
effects. To do this, follow steps given
below:
Step 1: Right click on the Picture.
Step 2: From the pop-up menu choose
Convert -> To 3D. The graphic is
converted to a 3D object.
Step 3: Right Click on the object and
choose 3D effects from the popup menu. Choose the option from
the dialog box.
Figure 1.31 Converting a Picture to 3D
Adding table
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Tables are one of the most recent features added in version OpenOffice.org 3.0. It is
very easy to understand data presented in a tabular format and hence it is very
popular tool. You have two ways to add tables in Impress:
The easiest way to add a table to an Impress slide is to:
Step 1 Select Insert > Table
Step 2 Select the number of rows and columns to add.
The result is a table in the center of the page that you will almost certainly want to
resize before using. The table is colored in the currently selected table style, and, in
many cases, you will probably want to change that as well, so that the table matches
or contrasts with your slide design.
Alternatively, you can create a table by using the Table Design tab.
Step 1 Click the Table Design tab in the Task Pane on the right side of the editing
window.
Step 2 Choose the table design from the eleven basic designs.
To customize a table, click anywhere within it. If you want to adjust a particular cell,
click within it; if you want to adjust a group of cells, select them with the mouse.
When a table is selected, a border of backslashes with green handles displays around
it. Pass the mouse over the border until a cursor consisting of four arrows is visible,
and you can drag the mouse to reposition the table anywhere on the slide. Drag on
one of the handles, and you can resize the table in the same way as you do a window
on a desktop. In addition, whenever you select a table, the Table floating task bar
pops up. The options available on the Table toolbar help us to do all the possible
operations on a table as explained below:
2

1

6

7

4

3

8

9

5

10

11

12

Figure 1.32 Table Task Bar
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Table: To insert a table with specified rows and columns
Line Style: To set the border style
Line Color: To set the border colour of a single cell or the entire table
Borders: To set the borders around the cells or the whole table.
Area Style/Filling: To set the background colour or pattern of the current cell or
the entire table.
Merge Cells: To combine multiple consecutive cells into a single cell.
Split Cells: To split a cell into multiple cells.
Optimize:
Alignment options: To vertically align the contents of the cell to the top, center
or bottom of the cell
Insert row: To insert a new row below the current row
Insert Column: To insert a new column to the right of the current column
Delete Row: To delete the current row
Delete Column: To delete the current column
Table Design: To change the style of the table
Table Properties: To set the general properties of current table like font, border
and background.

Adding a hyperlink
Hyperlink feature is used to create a link from one
another document. Hyperlink can be created to:

slide

to

another slide or to

· A slide in the same presentation
· A slide in a different presentation
· An e-mail address.
· A page or file on the Web.
· A new file.
We will learn to create a hyperlink to a slide in the same
presentation.
To add a hyperlink to a slide in the same presentation,
follow the given steps:
Step 1: Select the text and click on the Hyperlink
button in the Standard toolbar or Choose Insert->
Hyperlink from the Menu bar.
Figure 1.33 Creating Hyperlink
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Step 2: A dialogue box appears with various options for giving the link as shown in the
following figure.
Step 3: Choose the option Document for giving the link in the same presentation.
Step 4: Click on the Target in Document button to open a dialog box that shows
various slides that you can link to
Step 5: Choose the Target from the dialog box
Step 6: Click on Apply
Step 7: Click on Close to return back to the Hyperlink dialog box
Step 8: Select the Frame as self to open the link in the same frame
Step 9: Click on Apply button
Step 10: Click on Close button.

Figure 1.34 Attaching the target document
The text would appear in different colour and a hand icon appears on it when you
place the cursor on that text indicating that the link has been created successfully.

Summary
·
·
·

Pictures can be added to a presentation to improve the visual appeal of a
presentation
Tables can be inserted in a presentation to display information in rows and
columns
A hyperlink is a link from one slide to another slide
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Self Assessment
S.No. I am able to…

Yes

1

Insert pictures from a file on a slide in the presentation

2

Insert a table with specified number of rows and columns

3

Merge different cells of a table

4

Apply different formatting to different cell elements of a table

5

Apply specified border settings for cells / table

6

Add rows /columns in a table

7

Delete rows /columns from a table

8

Add 3D effects to a picture inserted on a slide

9

Insert hyperlinks to different slides in the same presentation

No

_________________________________________Now I can answer …
1.
2.
3.
4.

Is it possible to convert a normal picture in to a 3D object and add 3D effects on it?
How will you increase the size of a table inserted on a slide?
Name the feature that will allow you to combine two cells of a table into one cell.
Which option will you choose from the Table toolbar to set the general properties of
current table like font, border and background?
5. You can only create a hyperlink to another slide in the same presentation(True/False).

-35-

NVEQ Level I

ITDC-105

Element 5: Setting up Slide Show and Printing Slides
To view the presentation click on the "Slide Show" button or go to the "Slide Show"
menu and select "Slide Show". The shortcut key for this feature is "F9". Use the arrow
keys on the keyboard to go to the next slide or to go back the previous one. You can
also click the mouse or press the spacebar on the keyboard to advance to the next
slide When the last slide appears, the message "Click to exit presentation" appears.
Click the mouse or press any key to exit the presentation.
You can press the escape key at any time to exit the slide show.
Before displaying your presentation, you can configure the basic slide show settings
using the Slide Show Settings option from the Slide Show menu. This dialog box helps
you define the basic settings for your slide show as shown in the figure. After
selecting the desired options click on OK.
The Range section allows
you to specify the slides to
be included in the
presentation

The Options section
allows you to define
various other settings
for the presentation

The Type section allows
you to specify how the
slides are to be displayed

Figure 1.35 Slide Show Options Dialog Box
Printing Selected Slides/Presentation
To print selected slides/presentation follow the given steps:
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Step 1 Click on File -> Print
Step 2 Click on the General Tab
Step 3 Choose the Printer on which the presentation is to be printed
Step 4 Set the option whether all slides or selected slides are to be printed. Choose
the option All slides if the entire presentation is to be printed. Choose the option
Slides to specify the numbers of the slides to be printed which can be a range or a
group of non-contiguous slides. Choose the option Selection if slides were selected
before opening the print dialog box.
Step 5 Choose the number of copies to be printed for each slide
Step 6 Choose the content to be printed – Slide, Handout, Notes or Outline and
specify the number of slides to be printed per page. You can also control the order of
the slides being printed from the Order list.
Step 7 Click on print to print the desired slides.
Step 2

Step 3
Step 5
Step 4

Step 6

Step 7

Figure 1.36 Printing Selected Slides
You can also customize how many slides are to be printed on a page using the Page
Layout tab of the Print dialog Box as shown in the figure
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Step 1 Click on File -> Print
Step 2 Click on the Page Layout Tab
Step 3 Choose the number of pages to be printed per sheet
Step 4 Choose the order in which the slides are to be printed
Step 5 Choose the brochure option to print the slides as a brochure and select the
slides to be printed.
Step 6 Click on the Print Button
Step 2
Step 3

Step 4

Step 5

Step 6

Figure 1.37 Customizing Slides for Printing
ELEMENTS OF A GOOD PRESENTATION
The following are common mistakes made by the students while creating a
presentation leading to an unimpressive presentation. Read the points carefully and
avoid all these to create effective presentations
·

T. M. I. (Too Much Information): While designing a presentation; stick to
three, or at the most, four points about your topic and elaborate on them.
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Develop your content first, and then add slides as necessary. Use Guy
Kawasaki’s 10-20-30 Rule for presentations as:
Ø 10 slides are the optimal number to use for a presentation.
Ø 20 minutes is the longest amount of time you should speak.
Ø 30 point font is the smallest font size you should use on your slides. This

·

·

·

·

·
·

rule will make your presentations better because it requires you to find
the most salient points and to know how to explain them well.
It’s a sound guideline which you should always consider, but make your choices
based on your audience, your message, and your own personal style.
Poorly Chosen Design Template or Design Theme: Choose a design that is
appropriate for the topic. A clean, straightforward layout is best for business
presentations. Young Students respond to presentations that are full of color
and contain a variety of shapes.
Electrifying Color Choices: Good contrast with the background is essential to
make your text easy to read.
Ø Dark text on a light background is best. Off white or light beige is easier on
the eyes than the typical white. Dark backgrounds are very effective, if the
text is light for easy reading.
Ø Patterned or textured backgrounds make text hard to read.
Ø Keep the color scheme consistent.
Poor Font Choices:
Ø The font size chosen should not be too small or too big. It should be easy to
read from a distance.
Ø The font style chosen should be simple and easy to read. It should not be
script type fonts which might not be legible from a distance. The best
presentation fonts are Arial, Tahoma and Verdana. If you use an unusual
font and email your presentation to someone else who does not have the
required font, then Impress uses it's default font and commonly will also use
the default formatting. This can make the text quite a mess
Inappropriate Photos and Graphs: Use photos, charts and diagrams only to
emphasize key points of your presentation. When used correctly, they would
enhance the presentation.
Too Many Slides: Ensure that the audience stays focused by keeping the
number of slides to a minimum.
Different Animations on Every Slide: Different animations might seem
interesting but could create confusion for the audience as to from which
direction the text would appear. Thus uniformity is preferred.
-39-

NVEQ Level I
·

ITDC-105

Determine the Order Of Slides: The information flow should be in proper
order and thus the slides. Though this can be changed later from the slide
sorter view.

Summary
·
·
·

A slide show is the display of all slides of a presentation shown one after the
other on the screen
A slide show can be customized to display nonconsecutive selected slides or
consecutive slides starting from a particular slide
Selected slides / Entire presentation can be printed in different formats

Self Assessment
S.No. I am able to…

Yes

1

Run a slide show using the menu option

2

Run a slide show using the shortcut key

3

Exit from the slide show as and when desired

4

Prepare the settings for the slide show

5

Print selected slides

6

Print the entire presentation with 2 slides per page as handouts

7

Create a presentation that follows the best practices outlined in
the Element

No

_________________________________________Now I can answer …
1. Name the shortcut key to run a slideshow and to exit from a slideshow.
2. Which option in the Slide show dialog box allows you to select nonconsecutive slides to
be displayed as a slide show?
3. What is the usage of the Auto option of the Type subsection in the Slide Show dialog
box?
4. It is possible to change the order of slides while printing a presentation(True/False).
5. Which option out of Handouts, Notes or Outline is best suited if you want to print
thumbnails of all slides in a presentation.
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You can rise upto…

Explore contributions of "Dale Carnegie"
Assessment
Multiple Choice Questions
1. ____________ are the boxes with dotted or hatch marked borders that are part of
most slide layouts.
A. Slides
B. Placeholders
C. Task Pane
D. None of the above

2. A page of the Impress presentation that displays some information about a topic is
called
A. Textbox
B. Placeholder
C. Slide
D. Text Box
3. To start a new presentation, click on ___________ key combination.
A. Ctrl + S
B. Ctrl + F
C. Ctrl + N
D. Ctrl + M
4. To take one slide from a presentation and put it to another presentation you will
choose:
A. Duplicate slide option
B. Copy Slide option
C. Insert New slide option
D. None of the above

5. The shortcut key to open a file is _________.
A. Ctrl
B. Ctrl
C. Ctrl
D. Ctrl

+O
+T
+F
+S
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6. After inserting a picture in Impress it is possible to
A. Add 3D effects to the picture
B. Rotate the picture
C. Resize the picture
D. All of the above
7. To create a table from the task pane, use the
A. New Table tab
B. Table Design tab
C. Layouts tab
D. None of the above
8. We can press ___________ key to view the slide show.
A. F5
B. F9
C. Both A and B
D. None of the above

Fill in the blanks
1. The _______________ is the presentation software in the open office suite.
2. The _______________ view helps to develop and organize the structure of a
presentation.
3. The _______________ pane contains tabs for master pages styles, layouts,
custom animation, slide transition and Table designs.
4. Each page of a digital presentation is called a ____________.
5. The _______________ is a series of screens that will allow you to quickly set
various options for your new presentation.
6. The _________________ capitalizes the first letter of every word and the rest
to lower case.
7. To delete slides that are not in sequential order, select slides by pressing
__________ key.
8. A _______________ toolbar is fixed along an edge of the window while a
______________ toolbar that can be moved from one place to another.
9. Animation effects can be applied to ________________ elements in the
_______________ view.
10. ________________ is a slide that contains elements that are common to all
slides to give a uniform look to the presentation.
11. Various operations which can be performed on tables are available through
_______________ toolbar.
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Questions with short answers
1. Daanish Jayant is not able to understand the difference between Normal View
and Outline View in Presentation Tool, write one major difference between
them.
2. Puneeta has created a presentation that works on mouse click which she finds time
consuming. She wants to make the presentation run automatically and also set the
speed of each slide transition. Explain which features should she use for the same.

3. Slide Transition and Custom animations are two options available in
Presentation Tools, which option helps you to include special effects on various
text boxes and images during designing a slide?
4. Which feature will you use to display slide numbers at the bottom on every
slide?
5. Out of the following list pick out the option(s) that is not a type of View in
Impress:
Handout, Outline, Bulleted, Slide Sorter, Slide Notes
6. Is it possible to view selected slides only in the slide show? If yes, then enumerate the
steps for achieving this.
7. Ms. Meeramani has recently joined a construction company as Marketing Executive.
She saw a presentation about the company. She however is not satisfied with it and
wants to make some changes in it. Using your presentation skills, suggest the features
to accomplish the following changes:
i)
ii)
iii)
iv)
v)

Add the company’s logo (stored as a file on her computer) on the first slide.
Add an effect while shifting from one slide to another during a slide show.
Connect Slide 4 to Slide 9 directly.
Add slide numbers automatically at the bottom of each page.
Display the new projects of the company year wise in a formatted manner.

Case based problems

1. Create a presentation on Global Warming keeping in mind all the elements of a
good presentation discussed in E5.
2. Use the instructions given below to create a presentation on Festivals of India
i) The first slide should contain a picture with an appropriate title.
ii) Each slide should contain a picture of an Indian festival and related text
describing the festival.
iii) Insert the copyright statement and page number at the bottom of each slide
using footer.
iv) Save the presentation with the name IndianFestivals in the My Documents
folder.
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v) Apply slide transition effects to the slides in the presentation.
vi) Customize the Slide Show to set up automatic timing for each slide.
3. Create a presentation on Robots using the guidelines given below:
Introduction slide with an
image and an appropriate
background

Contents slide should have
hyperlinks to relevant slides

Slides should be a mix of
pictures
and
text
with
animation and transition effects

Use lists and tables wherever
possible
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Suggested Reading
Reference books
·
·
·

Open Office.Org 3.3 Impress Guide
by ODFAuthors Team (Creative Commons Attribution 2.5)
Friends of OpenDocument Inc
Beginning OpenOffice 3: From Novice to Professional
by Andy Channelle
Apress
It’s Not What You Say, It’s How You Say It
by Joan Detz
St. Martin’s Griffin

Websites
·
·
·
·

http://inpics.net/impress.html
http://www.learnopenoffice.org/ui.html
http://www.zisman.ca/Impress/index.html
http://wiki.services.openoffice.org/wiki/Documentation/OOo3_User_Guides/O
Oo3.3_User_Guide_Chapters
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ETHICS AND SOFT SKILLS
Pre-requisite: ITCC-101 Basics of IT
Unit Code

ITOC-106

Unit Title (Skills)

Hours
Th

Pr

12

6

Right to Privacy

4

1

Netiquettes

4

1

Soft Skills in work environment

4

2

Ethics & Soft Skills

Total
Hours
18

Ignite Mind
"Simplicity is not the goal; it is the byproduct of good idea and modest expectation"

Paul Rand

Learning objectives
After studying this unit the students will be able to:

·
·
·

Explain the importance of Right to Privacy.
Demonstrate expected etiquettes while working on Internet.
Demonstrate expected soft skills

Introduction
We have now learnt how to use a computer for various purposes. We have also learnt how to use
Internet and emails. This is the right time to understand various ethical, social, and health
issues related to the use of technology and electronic equipment. We should also know what
soft skills are and how to develop these. Our IT education remains incomplete without this
knowledge.

Resource requirement
Hardware
·

A working computer system

·

A web browser

Software

Suggestions for Effective Teaching
·
·
·
·
·

Encourage peer learning in Computer Lab
Ensure that students follow standard procedures to logon/logoff a computer.
Ensure the proper connectivity of I/O devices
Encourage students to explore opportunities as IT Professionals
Demonstrate and cite examples to tell students the importance of soft skills in life in
general and for employability in particular.
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ELEMENT 1-RIGHT TO PRIVACY
Consider the following situations:

1. "Anita goes to a Dance class institute for learning Kathak. Her instructor asks her to fill in
Admission form in which she has to enter details like Name, Address, Phone number, Father's
name etc. After a few days Anita starts getting numerous telephone calls from a few
coaching institutes asking her to join their coaching courses. On investigation, Anita came to
know that the Dance class institute had given her phone number to these coaching institutes
without her permission.”
Was the Dance Class institute’s management right in passing her phone number to other
institutes without her permission?
2. "Sujata teaches IT course to class 9. She was entering marks while processing results of
students when she had to leave her computer for meeting the Principal. Amit, a student goes
and peeps at the teacher's computer screen and notes down some students’ result. He also
changes the marks of a few students.”
Is Amit doing anything wrong?
There may be many such situations where people try to steal someone’s data or pass on the
information about someone without his/her permission. Suppose this happens to you. You may
have some specific information about yourself, which you don’t want to share with anyone. Will
you like someone to disclose that information about you? Definitely not. What will happen if
someday you find that personal and private information about you is made available publicly on
facebook? You definitely do not want this to happen ever. This is because you want people to
respect your privacy.
In this age of information technology the issue of privacy is a major concern. All the information
(photos, email-ids, status updates, religion, bank account details, credit card pin, date of birth,
passwords, mailing addresses, mobile numbers, confidential data of a company or individual
etc., or any other information) that is once uploaded can be stored permanently on web
servers. There are millions of registered users on each social networking site. What will happen if
this information may be sold to companies wanting the details of potential customers?
It is not only the information that people upload themselves. There are many unwanted
software like spyware that record every keystroke or mouse click that we use. They send this
information to their parent organizations. This way the information about our user name, visited
sites and used applications etc. is constantly transmitted to some web server without our
knowledge.
Privacy concerns exist wherever uniquely identifiable data relating to a person or persons are
collected and stored. Various types of personal information are often associated with privacy
concerns. For various reasons, individuals may object to personal information such as their
religion, political orientation, or personal activities etc. being revealed. This is because people
want to avoid discrimination, personal embarrassment, or damage to their professional
reputations. Such are the cases where right to privacy comes into action.

Protecting privacy on the internet
In recent days, Internet has become a very significant and important part of every field be it
education, business, socializing, shopping, travel or simply sharing information. And trends
indicate a bigger and bigger role internet will play in how each of these domains collect
information, analyze and put to advantageous use as we move into future.
But internet usage comes with a mixed package. While it provides data as and when we need it,
allows us to collaborate with distant and remote friends, family and co-workers yet it requires
the data to be stored on the web servers and accessed from different locations. This data may
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include sensitive information too. While life without Internet is simply unimaginable, we need
to be aware of the significant dangers that come along. We face a great risk while we put our
information/data on a public domain or on the net. So, we need to be very careful and must
know the risks involved and methods to save us from any loss – tangible or intangible.
Given below are some areas where risk is involved and some precautions to avoid these risks:
a) Risk: Getting trapped by fake websites
Precautions:
1. Always use the latest versions of the browsers as these will come with updated inbuilt
filters that can spot many fake websites. Using outdated version of browser may have
serious security flaws that allow malicious websites to read/damage your files, steal
your passwords and much more.
2. Identify potential harmful sites and avoid visiting them. Some search results may show
a warning next to them << This website may be harmful to your computer>>. You
should not visit such websites as they may result in activation of some malicious code
on your computer. This may lead to usage of your computer by someone else without
your knowledge and you may lose valuable data (stolen or corrupted). Some browsers
give visual cues on whether a site is safe or not. Green tells you it is safe and the site
is legitimate. Red tells you to stop, usually because the site isn’t secure.
b) Risk: Greed to get something for free
Precautions:
1. Many websites claim to have the best tools for removing spyware and malware. Often,
these are used as a payload to launch spyware and malware. Avoid using such fake
spyware/malware removal tools. Avoid downloading games/free software from
unofficial websites. They may contain virus or spyware.
2. Do not download & install cracked/pirated software. It is illegal. Also, the websites
that provide serials/keys & cracks may install malicious software on your computer.
c) Risk: Sale and misuse of personal information
Precautions:
1. Read the end user license before joining any social networking site.
2. Never share personal information like your name, address, phone number and pictures
on such sites. Profile pictures are more vulnerable to misuse.
3. Be careful while logging on the social sites from a public computer such as cyber café
where someone might have installed a key logger & would later access your account.
4. Do not use the same password that you use at work on a social networking site. Use
different passwords for different accounts.
5. Be careful while clicking on links posted by people on such sites as some links may
include malware.
6. Be careful in accepting the friend requests coming your way.
7. Set the privacy of account carefully. Do not make everything public.

Figure 1.1: Social Networking Websites
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d) Risk: Theft of confidential information
Precautions:
1. Do not share your login data (password and pin number) with anyone.
2. Your password should be complex and difficult for others to guess. Use letters,
numbers and special characters [such as !,@, #,$, %, ^, &,* (, )] in your passwords.
3. Change your password in regular intervals
4. While banking through the Internet, make sure that the banking session is secure. The
URL should have an ‘https://’ in the beginning. Sometimes, a digital certificate can
be viewed if you click on a certain key displayed in the window.
5. Always remember to completely log off, after completing the banking session.
6. Never store your passwords in a file on your or any public computer.
e) Risk: Getting malware through email
Precautions:
1. Never click on an attachment that you don’t know. Delete the unsolicited mails
immediately.
2. If something says “pass this on to all else bad luck will follow” then DON’T!
3. Avoid opening files that appear appealing for example, a nice animation. These files
can be very harmful to your computer. BAT and EXE and PIF are extensions of
programs that are almost always deadly.

Respecting privacy of others
It is not only legal but also ethical and moral to respect other’s privacy. Just as we do not want
to see our personal details out in public without our wish, others would naturally expect same.
Revealing others’ private information on the net may give us a sense of fun or revenge (if we
are too angry), but it may land us into big trouble. Morally, we may repent later for such acts,
but the damage done once cannot be undone. Legally, we may be taken to court for such an
act. Like most of the countries, we also have well defined laws, which protect citizens’ privacy.
If we breach into one’s privacy, we may be fined or jailed or get both.
Social sites that allow one to post pictures and information about us and anyone else too offer
great flexibility but opportunities to young minds to be carried away easily. We should not let
momentary pleasure get us in trouble.
“Information Technology Act, 2000” suggests penalty for breach of confidentiality and privacy
through section 43 and section 72.
[www.mit.gov.in/sites/upload.../itact2000/it_amendment_act2008.pdf]
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Summary
·
·
·

We must protect our privacy and respect privacy of others while working on internet.
We must know and follow the best practices to protect our privacy while we are
connected to Internet for any purpose - just for surfing, social networking, on-line
banking, or chatting or for any other purpose.
“Information Technology Act, 2000” suggests penalty for breach of confidentiality and privacy
through section 43 and section 72.

Self-Assessment
S.No.
1.
2.
3.
4.
5.

I am able to…
Protect my privacy while working on internet.
Identify the areas where privacy can be intruded while working on the
internet.
Be safe while social networking.
Be safe while using e-mails.
Be safe while chatting

_________________________________________Now I can answer …
1.
2.
3.
4.

What is meant by privacy protection on the internet?
List any 3 precautions to be taken to avoid the risk of getting trapped by fake web sites.
List any 3 precautions to be taken to avoid the risk of getting malware through email.
List any 3 precautions to be taken to avoid the risk of theft of confidential information.
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ELEMENT 2 – NETIQUETTES
The word Netiquettes is formed by combining two words: Net and Etiquettes. Here Net refers to
Internet and Etiquettes refers to good manners. Therefore, Netiquettes refers to good manners
which we must follow while using the Internet for any purpose. These manners make
the Internet experience pleasant for everyone. Like other forms of etiquettes, netiquettes are
concerned with matters of courtesy in communications. Following are some of the Netiquettes
which we all must follow:
General Netiquettes
· Respect Privacy of others
Don't distribute other people's emailaddresses to strangers by emailor by posting
messages to the online social networking sites unless the email is on a public work and
obviously intended for distribution. Otherwise, you may be responsible for someone
getting spam email from commercial sites, and strange email from unwanted strangers.
· Be ethical user
If you use software/service/product, pay for it. Getting free movies or software from
inauthentic sites is similar to stealing.
· Respect rules – cyber rules and copyright rules
It is easy to copy something from the Internet and fake it as your original work. But if the
material is copy-righted and we use it for commercial purpose, then we may be punished
legally for copyright violation. Always get permission from the author for any use of such
material and clearly identify the author of work.
· Be polite online
Do not be harsh or abusive online. Cyber world also has rules of conduct. You should not
use the privilege of not being face to face.
Netiquettes of eMailing (these areas are also covered under NVEQ Level 1 Unit 3)
· Useful Subject Lines
Make the subject line catch the eye of the reader. The subject line should be brief, does not

·

need to be a complete sentence, and should give a clue to the contents of the message. It may
be:
Re: or RE: If the message is in response to another piece of email.
URGENT: for time-critical messages.
REQ: For requests
FYI: for non-urgent information that requires no response from the other person.

Quote Documents
When referring to previous email, one should explicitly quote that document to provide context.
Keep the messages short
People online are busy; don't waste their time. It is always possible to follow up with those that
need more information.

·
·
·
·

Use line breaks

Limit the line length to 65 to 70 characters and use line breaks.

Watch the spelling
It's easy to let it go, but sending out messages with misspelled words is a bad sign to the
recipient.

Use proper Intonations

Use both upper and lower case letters. It is considered rude to write in all caps as it will convey
the emotion of shouting.

Test the message
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While sending an important message, test it by sending it to yourself first. This will give a chance
to see how it looks before sending it for real.

Use the bcc feature

When sending a message to multiple recipients, use the bcc (blind carbon copy) function in the
email program, to make sure that the recipients do not know who else received the message.

Keep the attachments small

AOL, among others, sets a size limit on the attachments sent with an email. One way around this
limitation is to use a link directly to an HTML file loaded on the company’s website.

Use Autoresponders

Using Autoresponders to handle the most frequently requested information people ask from you is
a great way to more fully automate the online efforts. This feature is also very useful when the
one is out for long vacation or in case of medical urgencies.

Netiquettes of Social Networking
Most of us are members of one or the other social networking site. We may be on Facebook,
Twitter, Myspace, Orkut, Linked in or any other such site. Many of us are available on more than
one sites also. Therefore, it becomes very important to know the etiquettes of social
networking. Following is a brief list:
·

·

·
·
·

·

Friend Request or Invitation
We should not send blind friend requests to people whom we don’t know. We may find
persons with very attractive pictures or interesting profiles and we may get interested in
such persons. But we never know whether these pictures / profiles are genuine or fake.
We may sometimes need to send a friend request to someone whom we know but he/she
does not know us. In such a case we should send a friend request with a brief introduction
of who we are. After sending the friend request, we should not poke unnecessarily.
Status
Before posting a status we must think of the kind of friends in our friend list. We must
not post any status which may offend any of our friends. We must also avoid posting
status which is derogatory to anyone irrespective of whether that person is in our friend
list or not.
Commenting on others’ posts
We must not comment on our friends’ posts that would embarrass them. We should be
careful in choice of words while commenting on any post.
No pictures of others
We must not post pictures of others without their consent.
Help
Always go through the help available on such sites. Such helps really have some points
which help us to remain safe and avoid unnecessary embarrassment while on these sites.
Report Abuse
In case you find something objectionable you can take help of report abuse feature.

Summary
·
·
·

Netiquettes are the etiquettes to be followed while using internet.
Netiquettes include General Netiquettes, Netiquettes of emailing, and Netiquettes of
social networking.
Netiquettes are concerned with matters of courtesy in communications on the internet.
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Self-Assessment
S.No.
1.
2.
3.

I am able to…
Yes No
Follow general netiquettes.
Follow netiquettes of eMailing.
Follow netiquettes of social networking.

_________________________________________Now I can answer …
1.
2.
3.

State the importance of Netiquettes.
Explain the Netiquettes which one must follow while using shareware.
Describe any 4 Netiquettes which must be followed while using a Social Networking site.
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ELEMENT 3 – SOFT SKILLS IN WORK ENVIRONMENT
You can rise up to……Explore

the contributions of "Swami Vivekanand"

Assessment
Multiple Choice Questions
1.

It is illegal to
A. Use someone else’s computer.
B. Play Computer games.
C. Make someone’s private information public.
D. Get calls from some coaching centers

2.

Free software available on the internet
A. Always contain spyware
B. Sometimes contain spyware
C. Never contain spyware
D. Are spyware

3.

Laws to protect someone’s privacy
A. Do not exist in India
B. Exist in India
C. Do not protect anyone’s privacy
D. None of the above

4.

On the Internet
A. We should help others
B. We should not help others
C. We are not helped by others
D. We should not be helped by others

5.

Mohan wanted to email a motivating story to 20 of his friends. He does not want these
friends about to whom else has he sent the mail. Therefore he should put their email
addresses in:
A. To: box of email
B. Cc: box of email
C. Bcc: box of email
D. It is not possible.

6.

Netiquettes are applicable
A. While surfing only
B. While emailing only
C. While working on social networking sites only
D. All of the above

Fill in the blanks
1.

2.
3.

We must protect our ______ and respect _______ of others while working on internet.
We should avoid downloading games/free software from unofficial websites. They may
contain ______ or _________.
Our password should be ___________ for others to guess.
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We should always remember to completely ________, after completing the banking
session.
5.
We should always use routers one that have a __________ installed on them.
6.
The word Netiquettes is a combination of the words ___________ and ________.
7.
When referring to previous email, one should explicitly quote that document to provide _____.
8.
We should answer our emails ___________.
9.
We should not send ________ friend requests to people whom we don’t know.
10.
We must not post any status which may _________ others.
11.
We must not post pictures of others without their ________.

Questions with short answers
1. Anuradha, a student of class IX, gets a number of unsolicited emails from unknown
senders. What should she do to these emails?
2. Mohit, an engineering student, has clicked photographs of his friends while on a picnic. Is
there anything wrong if he uploads these pictures on facebook without asking his friends?
3. Name the Act and the sections of that Act which provide protection against breach of
privacy in India.
4. List any 3 Netiquettes of sending emails.
5. List any three Netiquettes to be followed while using social networking sites.

Case based problems

Suggested Reading
Websites
·

http://www.klis.com/computers+health/

· http://www.stanford.edu/dept/EHS/prod/general/ergo/compwork.html
· http://ergonomics.about.com/od/office/ss/computer_setup.htm
· http://mit.gov.in/content/cyber-laws
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WORK INTEGRATED LEARNING IT
Pre-requisite: Unit 102,103,104,105
Element
No.

Element Name

Hours

1

Identify operations at workplace and the tools being used

2

State organizational structure and identify IT development
team

Th

Pr

1

1

Total
Hours
12

Ignite Mind
"It is from still mind that many wondrous discoveries and inventions have taken birth.
In such a mind, all the secrets of the universe spontaneously manifest like images
upon a screen"

Amrita Anandamayi Ma

Learning Objectives
After studying this unit the students will be able to:
·
·

Identify various operations performed using IT tools
State organizational structure and identify IT development team

Introduction
After gaining the basic knowledge related to Information Technology in the previous
units, it becomes important for you to visit an office environment.
The Work Integrated Learning (WIL) opportunities offered in RMIT Business programs
equip students to meet this demand. WIL is the term given to an activity or program
that integrates academic learning with its application in the workplace, that is, it
combines theory with practice. There is a range of WIL opportunities offered in
Business programs including:

Resource Requirements
Hardware
-1-

NVEQ Level 1

·
·

ITWC-107

Computer System with Internet Connectivity
Printer

Software
·
·
·

GUI Operating System
Office Tools (Preferably Open Office, downloadable from openoffice.org)
Internet Browser

Suggestions for Effective Teaching
·
·
·
·
·
·
·
·

Encourage peer learning in Computer Lab
Ensure that students follow standard procedures to logon/logoff a computer.
Ensure the proper connectivity of I/O devices
Encourage students to explore opportunities as IT Professionals
Introduce how to integrate IT Tools with traditional practices at various work
places
Encourage students to follow best practices such as taking backup of files, turning
off devices when not in use
Educate students to keep storage media virus free
Sensitize students on ethical and health related issues

Element 1: Identify operations at workplace and the tools being
used
Work integrated learning activities provide learners with the opportunity to apply
knowledge and skills that they developed through their education and training to
workplace requirements. The contextualization of learning to the workplace
requirements makes learning relevant and enhances student’s engagement.
The learning outcomes are broader than those generally found in a classroom
environment. It will enable students to develop competencies that allow them to play
an effective and efficient role as employees in an organization. The unit includes
activities that would stimulate critical thinking and creativity among the students as
part of a team. Role play, group work, video clip shows, online discussions and blogs,
etc. are also to be used as methods for imparting the necessary competencies. It will
enable an environment for exploring employment opportunities, increased disciplined
thinking, positive work values and ethics, motivation to learn and improve
performance, teamwork and co-operation.
When you will visit any office premises of an organization, you will find most of them
working on some or the other office tools or specific application tools. The most
commonly used of such applications is the documentation tool i.e. Word (or Word
Processor). Other such common applications are as follows:
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Spreadsheet
Presentation
Internet (For communicating and searching for information from Internet)

Now, let us go to one of such office setup, and see how they are using these tools,
and what specific tasks are being accomplished using such tools in the office.
Use of documentation tool in workplace
As documentation tool is one of the most commonly used tool used on a daily basis in
all such offices for typing, saving and printing official/personal letters, internal
circulars and notices.
(i)
1.
2.
3.
4.
5.
6.
7.
8.
9.

Official letter: An official letter is normally composed of the following parts:
Letter Head bearing the company logo, name of the office and its address
File Reference Number of the communication (on left hand side)
Date of the communication (on left hand side)
Name, Designation and address of the Addressee
Subject of the letter
Salutation (e.g. Sir/Madam, Dear Sir/Madam, Dear Mr./Mrs./Dr./Prof.______)
Main content of the letter
Closing line
Signature, name & designation of the sender

Example 1: Let us take an example, where an appointment letter is typed for an
applicant, who is selected to join the company as Marketing Executive. This letter is
typed by the Manager of the Human Resource Department and has to be printed and
handed over/couriered to the applicant.

Learn N Fun Pvt. Ltd.
456-G, New City, Maurya Nagar, India
Ref: LNF-HR-2012-OPQ-1
Date: 31-March-2012
Dear Mr. O.P.Quick,
Congratulations! We here by inform you that you have been appointed as Senior Executive –
Marketing in our company with a yearly package of 3,40,000.00. Your job profile will
involve Delhi-NCR Travel. In addition to your salary, company will cover your transport and
telephone expenses as per actual expenditure incurred by you.
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You will directly report to Mr. V.S. Patnaik, GM (Marketing) and you will be bound to follow
the company rules and policies.
You are requested to report on 06-July-2012 at 10:00 am.
Sincerely Yours
Neel Kidwai
Sr.Manager (HR)

Scenario 2: Let us take another example, where the Finance Manager is typing a
letter to Branch Manager of a Bank requesting for a loan to start a new project of
constructing a branch office of the company in an Industrial area. The Finance
Manager has already submitted the project papers to the bank.

Khas Baat Media Inc.

X-4691, Hari Sriniwas Nagar, India
Ref: KBM-FIN-2012-MOMBW-05
Date: June-01-2012
Brach Manager
Money Over Money Bank of World
Hari Sriniwas Nagar
India
Sub: Request for sanction of Loan of priority
Dear Sir,

This is in continuation of our application no. 12/KB-23910 dated May-12-2012 with regard to
request to sanction of 3.5 Crore loan for the new project “Get-Connect” of our company. I
would like to inform you that the government has approved the construction plans and
approved the architectural drawings for the same. Now, the company is planning to start the
construction of the buildings within a month time.
Keeping in view of the above, I would like to request you to sanction the loan before June
15, 2012 so that we start hiring Construction Company and procure the building materials.
An early decision awaited.
Sincerely Yours
Abdul John Sinha
Manager - Finance
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Scenario 3: Now, let us go to purchase department and see how the purchase
manager places order for some items using documentation tool.

Ting Sing Joy Electronics Corporation

93, High Hill View Appartment, Old City, India

TSJEC-PO-PTA-2012-001
Date: 31-May-2012
Mr. Ritwik Azad
Manager
Pinto Sam Electronic Tools
India
Sub: Order for electronic tools
Dear Mr. Azad,
With reference to your quotation no PSET/12/ET/10009 dated 25-April-2012, we are pleased
to place order for the electronic tools as per the following details:
Sno
Item Details
Unit Price
Qty
1
5800
25
Digital Multimeter
2
1500
100
Logic Probe
3
69500
2
Digital Oscilloscope
Terms and conditions:
1. Taxes will be paid extra as applicable
2. On-site Delivery before 07-June-2012
3. Payment: 90% on delivery, 10% after successful installation of Oscilloscope
Sincerely Yours
Rnajan Sanjay Abraham

For Ting Sing Joy Electronics Corporation

(ii)
1.
2.
3.
4.
5.

Personal letter: A personal letter is normally composed of the following parts:
Date of the communication (on left hand side)
Salutation (e.g. Dear _____/Respected _______)
Main content of the letter
Closing line
Signature, name
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Scenario 1: A letter written by a son to his mother informing about outstanding
performance in examination.
Date: 30-May-2012
Dear Mom,
I am so glad to inform you that I got the result of first semester exams just an hour ago and I
got the highest marks in all the subjects. I just received a congratulation email from Prof.
Verma. I am very happy and excited. Please share this news with dad and tell him that I kept
my promise.
Looking forward to meet you on 12th June.
With regards,
Yours
Priyam

Use of Spreadsheet tools in workplace
Drawing and maintaining budgets is one of the important task that needs to be done
either at home or in office. Similarly, maintaining details around petty cash expenses,
time cards etc that many small and large organizations need to maintain. Try
maintaining such data in simple text files with no calculation abilities of spreadsheets
or on paper and you will easily figure out the problems and repetitive tasks you have
to perform. Many businesses use spreadsheets to calculate balance sheets, profit and
loss accounts and cash books. You can prepare a cash flow analysis for monitoring and
predicting likely income and expenditure to keep in track with financial affairs.
You can easily prepare a detailed budget with spreadsheets. The calculations can
easily be done by entering appropriate formulas and getting the totals and
differences.
Similarly you may easily predict changes in values such as effects of a price change on
costs, discounts and profit. A fixed table can be prepared to show these changes but
more significantly the figures could be changed from time to time to reflect new
situations with same formulas in place.
You can perform bank reconciliation; calculate jobs costs, taxes, schedule payments,
forecast profits and control stocks. In all these tasks the spreadsheet proves to be a
very important tool in simplifying the computation process and production of the
results.
In data collection and analysis, spreadsheets can be used to record, present and
analyses the results of polls, surveys and research.
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The following are samples of tabulated data compiled in a electronic spreadsheet.
Scenario 1: The following example of spreadsheet will help to simply enter the actual
expense details and find the balance after each expenditure. The user will be able to
do all the required calculations easily using some formulae and functions of the
spreadsheet.
Petty Cash Expenses Details of ABC Printers Ltd.

User Entry

=G2

=(D2*E2)

=SUM(E2:E6)
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Scenario 2: In the following example of spreadsheet, record of overtime paid to
employees is calculated. The standard number of working hours is 8 hours and the
extra hour(s) worked by the employee is/are paid extra. The driver is paid @Rs. 50
per extra hour and gardener is paid @Rs. 40 per extra hour.
=(D3-8)

User Entry

=sum(E3:E7)

=(E3*$C$1)

Use of Presentation Tool in work place
In most of the organizations, presentation tool is used for various purposes such as:
· Company Introduction
· Project Plan
· Product Promotions
· Corporate Training
Company introduction presentation is generally used by the senior officials of
company to present the company profile in front of the investors and clients. It
usually contains the details of origin of the company, last year’s turnover, brief
introduction of board of directors, strengths and future plans.
Project plan presentations can be made by the project managers for two different
purposes –(i) to be shown to seniors to get approvals and (ii) to help project members
to understand the project and implement the project as per the plan. This
presentation contains all the steps required to be implemented/followed to achieve
the desired goal of the project.
Product promotion presentation can be developed by the marketing department to be
presented to various clients/customers. This presentation contains the complete
details of specifications/characteristics/feature of newly launched/existing product.
In such presentation, pictures/videos of the product can also be included. In case of
other equivalent products available in the market, these presentations may also
contain a comparative chart to enhance the product.
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Corporate training presentations are similar to the presentations, which are used by a
teacher to teach a concept in classrooms. It contains the information points, pictures
and illustrations to train employees on a particular topic. Most of the companies are
making use of these presentations for training employees on various IT
tools/applications and work enhancement skills.
Use of Internet in Workplace
(For communicating and searching for information from Internet)
Internet is the most important and significant in comparison to all the above in the
modern office environment. Most of the modern offices prefer their office to be paper
less to save environment. The employees of the company communicate through
emails, chats and video conferencing; it saves time and enhances the productivity.
Emails help archiving the complete communication between two or more people,
which can be referenced at any point of time or as and when required. Searching for
information from internet is another important area, which helps in getting
information from vast resources available on internet. Internet also helps in online
banking, online travel booking, online hotel reservations and online shopping among
others.
Practice Time
In this example of spreadsheet, you have to help Ms Ruhi, who is working as Academic
Coordinator in “Gyan Shiksha” School in Delhi, India. She has entered grades obtained
by students in the Board examination in a spreadsheet similar to the one shown
below. Help her to enter, functions & formulae to calculate various values such as
Total Number of A1s,A2s, … etc in each subject and subject name with Max. Number
A1s & E grade.
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She is expected to send the following to the principal of the school through e-mail as
the principal is abroad for a conference. Help her to:
a) Analyse the result in different subjects. The result analysis should display the
total number of individual grades obtained in different subjects and maximum
no. of A1 grades and E grades.
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b) Using word-processing software, create a report of result in the following
format:

Logo of the school
Name of the school
Address

E-mail :

Phone No.

CLASS X BOARD RESULTS - 2011
Dear Sir/Madam,
Sending the results obtained by the students in Class X Board Examinations 2011.
Students have shown the best results in _________________ Subject. Improvement is needed in
_______________________ Subject as there are maximum no. of E grades in it.
A brief summary of the result is as follows:
Grade
A1s
A2s
B1s
B2s
C1s
C2
E

Subject

Number of Students securing this grade

Regards
Ruhi Singh
(Academic Coordinator)

c) Create a presentation using Impress showing reflecting the results and a
comparison between the results obtained in different subjects.
d) Send the above files giving an appropriate subject to the Principal whose email
id is: principal@gyanshiksha.com attaching the following documents with the email:
i)
Report
ii)
Subject performance comparison presentation
iii)
Results Spreadsheet
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Summary
·
·
·
·
·
·

Documentation tool helps in official/personal letter writing
Presentation tool helps in making and presenting Company Introduction,
Project Plan, Product Promotions, and Corporate Training etc.
Spreadsheet tool helps in making tabulated calculations such as computation of
petty cash expenses, overtime of employees etc.
Internet is ultimate need of the modern offices – it enhances productivity and
saves time.
Paperless office saves environment
Emails, Chat, Video-Conferencing help in effective communication between
two or many people.

Self Assessment
S.No. I am able to…

Yes

1

identify various kinds of tasks accomplished with different
Office Tools.

2

decide the most appropriate tool for a specific task

3

name three internet services, which will enhance productivity
in an office environment.

No

_________________________________________Now I can answer …
1. Which office tool will be used to create a job application?
2. Which office tool do you think will be most appropriate for showcasing the advantages
of using a particular product?
3. Mr. Jacwin Malberb is finding it difficult to manage calculations of his day to day
expenses on paper, which office tool, will you suggest to him for this purpose?
4. Name any two scenario, where spreadsheet can be used other than the ones discussed
in this chapter.
5. Which internet service will be most appropriate for online training of employees with
the help of an instructor at a faraway location?
6. Mention one application each where the three main office tools can be used in a
school scenario.
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Element 2: State organizational structure and identify IT
development team
Every organization follows an organizational structure as organizational structures are
used to depict the structural hierarchy of an organization and depict the relationship
among the different members. Given below are a few sample organizational
structures.

Sample Organizational Structures
Organizational Chart for the IT Department

Commonly used positions as members of IT Development team
· System Analyst
· Project Manager
· Team Lead
· Application Programmer
· Web Developer
· Web Designer
· Database Administrator
· Data Entry Operator
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Information Technology job requires following knowledge units:
· Hardware trouble shooting
· Programming
· Systems analysis and design
· Testing and quality assurance
· Network design and administration
· Digital media
· Technical support
· Web development and administration
· Database design, development and administration
Organizational structure for a School

Typically, in schools, there is a management committee at the top level, who appoints a principal to run
the school on day-to-day basis on the policies, rules and regulations led down by the management. Vice
Principal and Headmistress/Headmasters come at the third level, who directly report to Principal on
day-to-day basis and take directions. Middle School and Primary School Teachers report to Headmistress
on day-to-day basis, whereas in senior school, teachers may take directions from head of the
department of various subjects.
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Organizational structure of a big organization
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Career exploration and planning
Career planning is all about choosing an occupation, getting a job, earning for
livelihood, growing in a job, changing job and eventually retiring.
· Always assess your strengths and weaknesses before choosing a career.
· Try to collect as much information as possible on the vocation that you would
like to pursue
· Always seek guidance from an Expert/Counsellor before deciding about your
career.
· Take periodic note of the vacancies and apply promptly.
· Look for employment advertisements in Career websites, Newspapers,
Employment News.
· Visit Employment Exchange, Organizations/Academic Institutions/Companies
(Notice Board) and Library for employment related information.
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Other Job Opportunities in sectors using IT as a tool
(a) Banking, Financial Services and Insurance
·

Net banking/phone banking: It is an online banking facility available for
savings account holders as well as current account holders.

·

Credit/Debit Cards: Banks provide Credit or Debit Card to facilitate transaction
and e-commerce.
(b) Office Environment
·
·
·

Personal Assistant
Data Entry Operator
Office Assistant

Preparing your Curriculum Vitae/Bio-data
Curriculum Vitae or CV in short is an outline of a person's educational and professional
history, usually prepared for job applications. It serves as an instrument in conveying
your personal details and qualifications, including knowledge, skills and abilities that
you possess.
Personal details: Usually contains name, address, date of birth, telephone number,
email address.
Educational and professional qualifications: Usually contains information about your
certificates, diplomas and degrees that you acquired during your career.
Work experience: Usually contains information about your work experience
(duration, targets achieved, etc.) in various jobs. It includes the skills such as
languages known to you, computing skills, driving skills, leadership skills, etc.
(identify the skills that you have gained through courses, internships, work
experience, sport activities, National Cadet Corps, etc.).

Summary
·

Organizational structures are used to depict the structural hierarchy of an
organization
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Organizational structures are also used to depict the professional relationship
of employees in the organization
Organizational structure help in understanding, who reports whom.
In organizational chart, positions – which involve policy making and strategy
planning are placed on the top and positions – which involve execution and
implementation of these policies are at the bottom level.
Most of the jobs in the organizations involve jobs requiring working of
knowledge of IT Tools.

Self Assessment
S.No. I am able to…

Yes

1

Identify various levels in a given organizational structure

2

Identify common designations/positions in IT development team

3

Prepare bio-data for jobs

4

Know various sources to know availability of jobs

No

_________________________________________Now I can answer …
1. What is Organizational structure of a company?
2. Name three different designations/positions commonly used in IT development team.
3. Name four different sources to get the information about the vacancies in various
organizations.
4. Name four different knowledge domains, which are required in Information Technology
related jobs

You can rise upto…
Explore contributions of "E. Sridharan", "N.R. Narayana Murthy"

Assessment
Multiple Choice Questions
1. Tabulated calculations can be done using
A. Documentation tool
B. Presentation tool
C. Spreadsheet tool
D. None of the above
2. A letter to procure new leased line connection can be created using
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A. Spreadsheet tool
B. Documentation tool
C. Presentation tool
D. Video Conferencing
3. We can maintain electronic record of complete communication between two or
more people using
A. Email
B. Paper mail
C. Presentation tool
D. All of the above
4. Organizational chart helps to understand the ___________ of an organization
A. Structural Hierarchy
B. Turnover
C. Product Promotion Plan
D. All of the above

Fill in the blanks
1. ____________is the most popular way of instant textual communication over
the Internet.
2. ____________office tool is most appropriate to make an invitation card to be
printed and sent to clients for a conference.
3. The best office tool which can be used to present the Annual budget to the
management of the company by the Finance Head is _______________.
4. In a school scenario, the Vice Principal will be directly reporting to the
_____________.

Case based problems
1. Visit your school office and create an organizational chart after discussion with the
school officials.
2. Visit the Accounts department of your school and make a list of various tasks
performed by the accountants using the office tools covered in the Unit.
3. Take a feedback from your teacher regarding how effectively she uses office tools to
manage her day-to-day school related activities. Now prepare a list of tasks which are
almost similar between the accountant and your teacher.
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Suggested Reading
Reference books
·
·
·

Beginning OpenOffice 3: From Novice to Professional by Andy Channelle
Walt Disney’s Creative Organization Chart by Delphine Hirasuna
The Boundaryless Organization: Breaking the Chains of Organizational Structure

Websites
·
·

http://www.Openoffice.org
http://www.website-writing.com
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